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1 Introduction
This guide applies to both the PC and Mac versions of Viz World Classic 
(previously known as Viz Curious Maps), and provides reference information 
about the program’s more advanced features. These include selecting map 
details, working with style sheets, importing and working with street data, adding 
text and graphics, creating drawings from vector shapes, adding effects with 
lighting and effects, and controlling animation.

This section contains information on the following topics:

• Learning the System
• Document Structure
• Related Documents
• Conventions
• Customer Feedback and Suggestions

1.1 Learning the System
The most efficient way to learn our systems is to go through our user’s 
documentation. This guide is designed to help people with little or no experience 
in using the WoS and the WoC. The purpose of this document is to help new users 
become familiar with the client; to illustrate the client’s editor, and to show the 
available options.

1.2 Document Structure
Quick Tour provides a complete introduction to using Viz World Classic on the PC 
(and Mac), and is the recommended starting point for anyone learning to use the 
program. It provides a series of short worked examples, each of which will take 
you on a quick guided tour of the program’s key features, to show you what it can 
achieve and help you become familiar with the user interface.

Working with Maps explains the options for creating and working with map layers, 
including using the Properties panel to define the projection, and using the 
Contents panel to select countries and places for incorporation into the map. 

Working with styles explains how to use the style sheets to make it easy to set up 
a series of house styles, and convert projects between house styles with a single 
click. It also explains how style sheets help to establish consistency across 
projects, or between designers. 

Reusing design elements explains how you can easily reuse styles, layers, and 
colors created in earlier projects, and gives recommended techniques for setting 
up and sharing style sheets, templates, and projects between users. 

Working with street maps explains how to import street data and draw it on your 
maps to create maps from the whole world, down to a single street corner or 
building. 
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Adding text to a project explains how to incorporate text into projects, and 
describes how to control the appearance of the text and the way it is animated. 

Importing images and movies explains how to incorporate bitmap images and 
movies into animations, and describes the controls available for altering their 
appearance, and controlling the way they are animated. 

Working with shapes explains how to add drawings to a map by creating vector 
shapes, either using separate shape layers or by adding shape details to map 
layers. It also explains how you can create and edit shapes, and change their 
appearance to achieve exactly the effect you want.

Working with ESRI Shape Files describes how to import map data in ESRI Shape File 
Format, and configure it for use with Viz World Classic.

Lighting and effects explains how to use the lighting and effects features, to 
enable you to add shading and depth to your map animations, and give them a 
unique and distinctive appearance. 

Controlling animation explains how to use the time slider to control the progress 
of an animation. It also describes how to use the  tool to set up impressive 
animations with a few simple clicks, and the Keybars panel to provide individual 
control over each component of a project.

Finally Rendering a project explains how to render your animation as a preview, or 
as a finished movie. It also describes the options for exporting an image or a 3D 
model from a project. 

1.3 Related Documents
For complementary information, see the following documents:
1. Viz Artist User’s Guide: Information on how to create graphics scenes in Viz 

Artist.
2. Viz World User’s Guide: Information on how to setup a map server solution 

and build map template graphics for newsroom and control room systems.

1.4 Conventions
The following assumptions and typographic conventions are used in this 
document:

• Bold Text: Bold is used to indicate emphasized text such as a name or label 
that appears on the computer screen.

• Italic Text: Italic is used to indicate text that should be typed, or variables that 
should be entered. Italic is also used to refer to related documents. 

• Underlined Text: Underline is used to indicate cross-references.
• Numbered Paragraphs: Numbered paragraphs are used to indicate tasks that 

need to be carried out. Text in paragraphs without numbering represents 
ordinary information.

• Comman, Alt, Ctrl, Shift, Return: Represents an appropriate value that you 
would enter from the keyboard. For example: Type filename and press 
Return.
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Note: Numbering in front of headings does not indicate if the text refers to tasks.

1.5 Customer Feedback and Suggestions
We encourage your suggestions and feedback regarding the products and this 
documentation. To give feedback and, or suggestions, please identify your local 
Vizrt customer support team at www.vizrt.com.

1.6 Customer Support Request
Support Requests are supported by Vizrt if Customers have a valid Service 
Agreement in operation. Customers who do not have a Service Agreement and 
would like to set up a Service Agreement should contact their regional sales 
representative.

When submitting a Support Request relevant and correct information should be 
given to Vizrt Support, to make sure that Vizrt Support can give the quickest and 
best solution to your Support Request.

This section contains information on the following topics:

• Before Submitting a Support Request
• Submitting a Support Request
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1.6.1 Before Submitting a Support Request
Before a Support Request is submitted make sure that you:

Read:
• The relevant User Guide or Guides
• The release notes

and Check:
• That the system is configured correctly
• That you have the specified hardware, tested and recommended versions

Always refer to your Vizrt Service Level Agreement document.

1.6.2 Submitting a Support Request

When completing a Support Request, add as much information as possible. 

Content of a Support Request

The report should contain information about these topics:

• Problem description: Include a good description of what the problem is and 
how to reproduce it. Remember to use simple English.

• Screen shots and illustrations: Use to simplify the message, and/or
• Project files: Use the project files to demonstrate the issue.
• System log files: Send the system log files.
• System dump files: Send the system dump files from the crash.

Note: Check: If the operating system is Windows 7 and up, dump files can be stored 
at: <userdir>\AppData\Local\VirtualStore\<install_directory> (check user rights).

• System Config file: Send the system config file.

Note: If the operating system is Windows 7 and up, the config file can be stored at: 
<userdir>\AppData\Local\VirtualStore\<install_directory> (check user rights).

• Software configuration: Add exact versions of software (-build) used.
• Hardware configuration: Add exact versions of hardware (-build) used.
• System setup: Describe differences in the installation, if any, from the 

recommended setup.
• System Network: Add a description of how the network, bandwidth, routers, 

and switches are configured.

Always refer to your Vizrt Service Level Agreement document.
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To submit the Support Request:

• Go to the Customer & Partner Portal at: www.vizrt.com/support/report_case/.
Login to the Customer Portal (1) and complete the online form with as much 
detail as possible. Refer to the Vizrt Customer Portal Guide.

or

• Go to www.vizrt.com/contact/. Click on ‘VIZRT ALL OFFICES’ in the Support 
Offices screen (1) to find the email address of your local Service Team. On 
recite of a Support Request email your local Service Team will enter it into the 
Support System.
To track the status of open support tickets login to the Customer & Partner 
Portal. Add information or communicate about the cases directly with the 
support team.
When reporting an error by Email make sure that the Email contains all the 
information detailed in Content of a Support Request.

 Figure 1: Customer Portal
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 Figure 2: Support Offices
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2 About Viz World Classic
Viz World Classic, a part of Viz World, is ideal for designers, program researchers, 
and producers who need to create high-quality map animations for news, 
documentary, promotional videos, and the World Wide Web.

It is designed to be simple and intuitive to use, so that users with no specific 
training in computer graphics or video editing can create professional maps on 
demand and at short notice.

This section contains information on the following topics:

• Comprehensive Map Database
• Street Data Configured Ready for Use
• Projects, Layers and Other Elements
• Establish House Styles for Consistency Across Projects
• Shapes
• Rotoscoping with Shapes
• Animation
• Compositing and Animation
• Painting and Effects
• Sophisticated Lighting and Filtering Effects
• High-quality Output
• 32-bit versus 64-bit

Comprehensive Map Database
At the heart of Viz World is the comprehensive Collins Bartholomew database of 
the world, defining countries, towns, and other features such as lakes, rivers, 
roads and railways. You can choose between a range of alternative projections for 
each map, with control over the scale and viewpoint. 

Individual items can be selected from the database and incorporated into the 
project with complete control over their appearance. 

You can also combine maps at different scales, such as to include an inset 
showing an enlarged view of one region from another map.

The Viz World database also include height information, from satellite images, 
giving you the option of displaying mountain ranges in relief to give physical 
information about the area being displayed, or simply for an impressive visual 
effect.

Street Data Configured Ready for Use
In addition to the database, Viz World Classic can also import street data in its 
own street data format. This provides a wide range of roads, railways, rivers and 
lakes, parks, buildings, and other municipal features, labeled and configured 
ready for immediate use, so you can create maps and animations that take you 
down to the level of towns, street corners, and single buildings.
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Projects, Layers and Other Elements
Viz World Classic offers an integrated paint, rotoscoping, effects, compositing, 
and animation system. Designed around a powerful multi-layer approach, Viz 
World Classic is equally applicable to the creation of still images and movies.

When working in Viz World Classic, you are always working on a project. The 
resolution, bit depth, frame rate, and duration of the output movie are all settings 
of the project. These are set at the start, but may be changed at any time.

A project can be built up from an unlimited number of layers. There are five 
different types of layer: image layers (still images), movie layers, text layers, 
rotoshape layers, and map layers. All layer types have two components: the RGB 
image itself, and an alpha channel which determines how the layer is composited. 

Image layers and movie layers also have an associated mask. The mask is 
essentially an additional single-channel image which can be painted and 
processed using the same tools as for the main image. Image layers have a single 
mask, while movies have a mask for each frame of the movie.

Masks can be used in several different ways: to protect portions of the image from 
change during painting or image processing operations, to define the arbitrary 
shape of an element to be cut from a layer (a cutout), to control the way in which 
the layer is composited, or to protect portions of the layer from change by other 
layers composited above.

Various other types of elements can be created and used within Viz World Classic. 
These are collectively referred to as overlays. There are three types of overlay: 
text, shapes, and cutouts (from an image, often using the mask to define the 
form). Overlays are not associated with any particular layer. They are retained as 
floating objects and may be stuck down at any time onto any image or movie 
layer. Alternatively any overlay can be converted to a layer for animation, and 
cutouts can also be converted into brushes for painting.

Establish House Styles for Consistency Across Projects 
The Viz World Classic style sheets make it a simple matter to create map 
animations to a specific house style, and once you have created an animation 
changing it to a different house style is simply a matter of loading in the 
appropriate style sheet. Style sheets control all the important aspects of a map 
animation, including the color schemes, typefaces, line weights, and lighting or 
relief effects. The style sheets also maintain consistency across projects or 
between designers. 

You can also create template files containing predefined elements, such as 
background maps, standard graphics, logos, and titles for reuse in a range of 
related animation projects.

Shapes
Viz World Classic includes a complete range of drawing tools to allow you to 
create and edit drawings directly within the program. You can create drawings by 
combining shapes in one or more shape layers, with complete control over the 
animation and appearance of each shape in the drawings. You can also add shape 
overlays to map layers, to allow you to highlight or annotate any features of the 
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map, with a powerful tracing tool to allow you to construct shapes by tracing map 
features.

Rotoscoping with Shapes
Viz World Classic allows you to create, edit, and animate vector shapes. These 
may be polygons, B-Spline or Bezier curves, or freehand shapes. They can be used 
to create masks, rendered directly into images, or exported for use at a later time.

Shapes can be animated using a combination of key-framing of individual points 
and the movement, rotation, and scaling of complete shapes. This gives great 
flexibility when using shapes to create rotoscoped mattes for moving elements. 
The underlying movement of a feature can be captured by setting a few key-
frames for complete shapes and then the shapes can be refined at any frame by 
editing individual points.

You can also soften specified edges of each shape, which is invaluable when 
making mattes to match something that is moving quickly and has motion blur on 
each frame.

Animation
Viz World Classic provides an Auto Animate feature that lets you add animation to 
your project by selecting a few simple options. You can fade objects in or out of 
view, and slide objects in or out of frame, with acceleration or deceleration to give 
a natural appearance.

For more sophisticated effects Viz World Classic gives you complete control over 
each component of your animation, allowing you to animate objects along an 
arbitrary animation path with complete control over their shape and position.

Compositing and Animation
Straightforward compositing is simply at matter of arranging the layers in the 
order in which they are to be composited, by dragging and dropping. 
Sophisticated composites can also be created very easily by using masks and 
alpha channels, and their associated controls, to determine how layers interact.

All layers remain separate and editable right up to the point of generating the 
final artwork. Layers can be moved, scaled, rotated, and filtered independently, 
can have any number of animated effects applied. They can also have 
independent transparency settings, drop shadows, and lighting. 

Every image and movie layer has a selection of built-in keyers available for direct 
compositing using either luminance, chroma, or color keying. The quality of the 
edges can be carefully controlled to achieve the most convincing 
results possible.

Every image and movie layer also has an integrated Roto Matte which allows you 
to add rotoshapes directly to the layer to cut out selected features. The results are 
displayed dynamically as you adjust the shapes, and the same flexible range of 
editing and animation options as for shape layers is available.

You can change the source material or content of any layer in a single operation at 
any time, without losing any of the animation or other control settings. This 
makes it easy to set up templates and then generate a series of images or movies 
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based on the same underlying design, but with varying content.

Painting and Effects
Viz World Classic provides a large range of painting, graphic, and image 
processing tools for use on image and movie layers. These are ideal for the 
freehand origination of artwork, or for retouching and editing existing material.

In contrast to the animatable transformations, lighting, and effects which can be 
applied to all layers, painting work explicitly changes the actual content of an 
image or movie layer.

A wide range of built-in and user-definable brushes are provided for work on 
images or masks, including color, offset merge, clone, drag, blur, and other 
effects. The brushes are pressure sensitive with user-definable profiles, and 
optional onion skinning facilitates accurate cloning, merging, and wire or rig 
removal.

Many tools are provided for creating, editing, and applying text, shape, and 
cutout overlays, and a very large number of different filters and effects can be 
applied. Any operations can be repeated over multiple frames using macros.

The changed material created by painting operations is stored independently, 
leaving your original materials unaffected. At any stage you can render a finished 
version, incorporating all your edits, or revert to your original material if you want 
to discard changes.

Sophisticated Lighting and Filtering Effects
Viz World Classic allows you to add lighting effects to each layer in your project to 
add realistic shading and highlighting to the images, or to emphasize specific 
features. You can also add one of a range of effects to the animation to blur 
images, or adjust the brightness or contrast. 

High-quality Output
As you create your animation the frame you are working on is rendered complete 
with anti-aliasing to show you the quality of the finished result. At any time you 
have the option of previewing the complete animation, or rendering it at high 
quality as single frames or as a movie file to create a finished broadcast-quality 
video. 

With suitable video output hardware the animations can be played out as 
broadcast-quality PAL or NTSC sequences. The following video hardware is 
supported: DPS Reality Studio Digital Disk Recorder, and video output boards 
capable of playing QuickTime™ or AVI movies, or accepting single-frame-per-file 
output. Contact your local Vizrt representative for updated information about 
supported hardware configurations.

32-bit versus 64-bit
The following features are different depending on which version of Viz World 
Classic you install.

The 64-bit version has a new clip record library with more options than the 32-bit 
version.
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• 32-bit: QuickTime Movie, AVI Movie, and Image Sequence, one frame per 
numbered file.

• 64-bit: AVI Movie, MPG Movie, QuickTime Movie, FLV Movie, TS Movie, and 
Image Sequence, one frame per numbered file.

The 64-bit version has a new image export library with different options than the 
32-bit version.
• 32-bit: sgi, psd, bmp, gif, jpg, pct, png, tif, tga, jp2, and qtif.
• 64-bit: jpg, tga, tif, bmp, png, pnm, ppm, psd, ico, rgb, and pdf.

The 64-bit version currently does not support adding movie clips as layers.
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3 Installing Viz World Classic
Viz World Classic is installed in two steps; first the database and then the actual 
design application. Viz World Classic itself comes in two flavors, a 32-bit and a 
64-bit version that are (more or less) identical (see 32-bit versus 64-bit). If you 
are already using the older 32-bit version you can easily migrate to the 64-bit 
version.

This section contains information on the following procedures:

• To download the software
• To install the Viz World Data
• To install Viz World Classic
• To migrate from Viz World Classic 32-bit to 64-bit version
• To add the license file
• To add the license file using Viz World Classic

To download the software

Whilst you have an active map support contract, you have a personal login to the 
Vizrt FTP server.

• Download the software from the Vizrt FTP at http://download.vizrt.com/ or 
ftp://download.vizrt.com/ under the Viz World folder.

Please use the FTP server to find the latest Vizrt software releases, 
documentation, help files, drivers and more. You can also use the FTP to upload 
and exchange files with Vizrt.

To install the Viz World Data
1. Start the Viz World Data installer
2. Click Next
3. Click Install to begin the installation
4. Click Finish

To install Viz World Classic
Before Viz World Classic is installed, you have To install the Viz World Data.

If you are using the old green Sentinel dongles, please update your Sentinel Super 
Pro drivers to the latest version. If you are using the Aladdin dongles (usually 
blue), please install the Aladdin Hard Lock driver.

For drivers, see the Installers directory (e.g. C:\Program Files\Curious 
Software\Curious World Maps\Installers).

Note: Exit all Windows programs before running the Setup Program.

1. Start the Viz World Classic installer
2. Click Next
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3. Click Yes to accept the license agreement
4. Select destination directory, and click Next

• C:\Program Files\Curious Software\Curious World Maps

5. Choose the components to install, and click Next
6. Select a start menu group, and click Next
7. Click Next to start the installation
8. Click Finish
9. Install the dongle driver in the following location:

• Option 1: For customer that use the Viz dongle install the Alladin hardlock 
dongle driver.

• Option 2: For customers that still use the Sentinel dongle install the Sentinel 
SuperPro dongle driver.

• Dongle drivers are located at ..\Program Files\Curious 
Software\Curious World Maps\Installers\

10.Download and install QuickTime if it is not previously installed.

Tip: QucikTime can be downloaded from the Apple website.

11.Start Viz World Classic.

To migrate from Viz World Classic 32-bit to 64-bit version
When migrating from 32-bit to 64-bit you basically have two options; manually 
copy files from the 32-bit installation directory to the 64-bit installation 
directory, and manually set all paths using the server configuration tool, or run 
the migration tool which will import all old settings to the 64-bit version.

When manually copying files you have the following advantages and 
disadvantages:

Advantages:
• All files will reside in the same installation directory
• Old installation directory can be removed

Disadvantages:
• More work
• The old version can no longer be used as the data is no longer shared

When running the migration tool you have the following advantages and 
disadvantages:

Advantages:
• Less work
• The old version can still be used as the data is shared

Disadvantages:
• Files will reside in more than one installation directory
• Old installation directory cannot be removed
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To add the license file
• Once Viz World Classic is installed, drop the supplied license into your license 

folder:
..\Program Files\Curious Software\Curious World 
Maps\Licenses\curiousmaps.lic

To add the license file using Viz World Classic
When starting Viz World Classic without a license, a window appears telling that 
no license can be found.

1. Start the Viz World Classic application
2. Click the License button to open the Software License window
3. Click the Edit License File ... button to open the Edit License window
4. Click the Add License from a File ... button to browse for the License file (*.lic)
5. Select the License file and click Open

• The license becomes visible in the Edit License window
6. Click OK to save the License. The license is saved to the License folder
7. Exit the application and run Viz World Classic.

Note: If the license is not valid, the server will not start, and the server console will 
exit.

To add map data
• Place Natural Earth files in the following location:

..\Program Files\Curious Software\Curious World 
Maps\MapData\NaturalEarth

• Place shape and KML files in any directoryPlace street data in the following 
location:

..\Program Files\Curious Software\Curious World 
Maps\MapData\StreetData

• Place DEM data in the following location: 
• Data received from Vizrt: ..\Program Files\Curious Software\Curious 
World Maps\MapData\CuriousDEM

• Data received from other providers: ..\Program Files\Curious 
Software\Curious World Maps\MapData\UserDEM

• Once Viz World Classic is up and running point the application to the data 
via:
View > Options > Map Data > Locations > CDEM Data

To add CMRs to the base map
1. From the View menu select Options ...
2. Select Locations under Map Data
3. In the Locations panel click Installed Imagery...
4. Click the + button to add the CMR files
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See Also
• Viz World User’s Guide for complete integration information on the broadcast 

graphics workflow
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4 Quick Tour
This section will give you a quick tour of the key features of Viz World Classic, 
including the components of the Viz World Classic window, and an explanation of 
how they are used in the creation of map animations.

This section contains information about the following topics:

• Getting Started
• Toolbar
• View Options
• Viewer
• User Interface Font
• Layers List
• Using the Content Manager
• Controlling Layer Compositing
• Animation Controls
• Move/Pan Tool
• Path Tool
• Text tool
• Zoom Tool
• Map Rectangle Tool
• Browse Map Tool
• Browse Street/Shape Data Tool
• Ruler Tool
• Pick Color Tool
• Navigator
• Panels

4.1 Getting Started
This section contains information about the following topics:

• Running Viz World Classic
• Creating a New Project
• Changing the Project Settings

4.1.1 Running Viz World Classic

• Double-click the Viz World Classic icon on your desktop
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4.1.2 Creating a New Project
When you run Viz World Classic the following Welcome dialog box is displayed to 
allow you to open an existing project, create a new default project, or use a 
project template:

• Select Create map project and click the OK button to continue.

4.1.3 Changing the Project Settings
When you create a new project it is created with the frame size, frame rate, and 
map database you last used; initially these default to:
• Frame size: PAL 768 x 576
• Rate: 25 frames per second
• Database: World Database.

To change the project settings
1. On the File menu, click Project Settings... .

• The Project Settings dialog box allows you to specify the frame size, frame 
rate, and duration for the animation, in addition to several other more 
advanced settings associated with the project:
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2. Choose the settings as required and click the OK button to save the changes.
• The first time you create or open a project there is a short delay while the 

map database you have selected is loaded. The Viz World Classic window 
will then be displayed, initially showing a map layer containing the world in 
a default globe projection, scaled to fit in the project area.

The following image shows the key features of the Viz World Classic window:
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Each component is described in greater detail in the following sections.

See Also
• Toolbar
• View Options
• Viewer
• User Interface Font
• Layers List
• Animation Controls
• Move/Pan Tool
• Path Tool
• Text tool
• Zoom Tool
• Map Rectangle Tool
• Browse Map Tool
• Browse Street/Shape Data Tool
• Ruler Tool
• Pick Color Tool
• Navigator
• Panels
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4.2 Toolbar

The toolbar provides toolbar button equivalents to the most frequently used 
menu commands.

The toolbar options, from right to left, are:

•  New, open, and save project

•  Cut, copy, paste and delete selection

•  Refresh, load image, load movie, add map, and add 
text layers.

•  Auto animate

•  Styles editor and project Settings

•  Street data and import map data

•  Symbols

•  Render project and render preview

•  Movie player, Windows media player, video player and 3D 
viewer.

4.3 View Options
Viz World Classic allows you to choose whether or not to display the Layers list, 
Panels, Navigator, and Animation controls. You can also turn the Layers list, 
panels, or Navigator into floating palettes, so you can position them where you 
like on the screen. These options are particularly useful if you are working on a 
screen with a resolution of less than 1280 x 1024 pixels.

To turn the Layers list, Panels, or Navigator into a floating palette
• On the View menu, point to Layers, Panels, or Navigator as appropriate, and 

then click Floating.

To hide the Layers list, Panels, or Navigator
• On the View menu, point to Layers, Panels, or Navigator as appropriate, and 

then click Hidden.

You can also hide a floating palette by clicking its close box.
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4.4 Viewer
Displays the currently selected frame of the animation. You can display Viewer 
controls to allow you to scale or scroll the image displayed in the Viewer.

This section contains information on the following topics:

• Keyboard shortcuts

4.4.1 Keyboard shortcuts
The following keyboard shortcuts can be used in the Viewer:

• Pan: Hold down Space and drag with mouse.
• Zoom In: Press Ctrl + Arrow Up, or hold down Alt + Space or Ctrl + Space and 

click or drag with the mouse.
• Zoom Out: Press Ctrl + Arrow Down, or hold down Shift + Space and click or 

drag with the mouse.
• Zoom 1:1: Press Ctrl + Enter.
• Next Frame: Press Ctrl + Arrow Right.
• Previous Frame: Press Ctrl + Arrow Left.

To show or hide Viewer controls
• Click the Viewer controls button to the left of the Viewer.

The following Viewer controls are provided:

• Viewer Controls: Enables and disables the viewer controls bar and scroll bars.
• RGB and Gray: Enables and disables the RGB values and grayscale value.
• Scale: Scales the map according to the viewer.
• Fit: Fits the map according to the viewer’s available space.
• 1:1: Fits the map according to the project’s frame size settings (i.e. the 

defined aspect ratio).

To scale the image in the Viewer
• Edit the value in the scale box, or choose a predefined scale from the drop-

down menu.

To fit the image to the Viewer
• Click the Fit button.

To restore the scale to 100%
• Click the 1:1 button.

• The scale is also restored to 100% if you hide the Viewer controls.
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4.5 User Interface Font
Viz World Classic allows you to select the font used throughout the user interface. 
You should only need to do this if you are using international characters, such as 
accented characters, and they are not displayed correctly.

To change the user interface font

1. On the View menu, click Options...
2. In the Display section select International Font
3. Select the font and size you want to use

4.6 Layers List
Each of the layers in the project is shown in the Layers list to the right of the 
Viewer. For each layer this shows whether the layer is visible, the name of the 
layer, an icon representing the composite mask options, and a thumbnail image 
of the layer. For map and image/movie layers, a thumbnail image of the contents 
of the layer is shown.

A selected layer is highlighted, and the panels, controls, and tools all operate on 
the currently selected layer.

The order of the layers in the Layers list determines the order in which they are 
composited in the Viewer.

The displayed names for layers are as follows:

• Layer type: Name displayed
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• Map: Map layer
• Image/Movie: The filename of the image
• Text: The text on the layer
• Shape: Shape

For text, image, or shape layers a pin icon to the left of the name shows whether 
the layer is pinned to the map layer below it.

For map layers, a lock icon is displayed if the layer is locked to another map layer 
below it.

This section contains information about the following procedures:

• To display the composite of all the layers
• To display an individual layer
• To hide or show a layer
• To create a new layer
• To select a layer
• To rearrange the order of the layers
• To cut or copy a layer
• To paste a layer
• To delete a layer
• To duplicate a layer
• To pin a layer to a map
• To lock two map layers together
• To rename a layer

To display the composite of all the layers

• Select the Composite display option above the Layers list

This displays the result of compositing all the layers in the project, taking into 
account the layer mask options for each layer.

To display an individual layer

• Select the Single Layer option above the Layers list

The Viewer then shows only the currently selected layer. This is convenient if you 
want to work on a single layer without seeing the effect of other layers within the 
project.
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In single-layer mode the Layers list shows an eye-dropper icon to indicate which 
layer is used as the background layer, for operations such as onion skinning and 
the merge brush:

Click the eye-dropper icon to change the background layer.

To hide or show a layer
• Click the eye icon to the left of the layer name

To create a new layer
• On the Layer menu, point to Add Layer, and then click the appropriate option

See the appropriate chapter Working with Maps, Adding Text to a Project, or 
Working with Images and Movies, or Working with Shapes for information about 
adding a map, text, image, or shape layer respectively.

To select a layer

• Click the layer in the Layers list.

The currently selected layer is shown highlighted in the Layers list.

To rearrange the order of the layers

• Drag the layer to the new position in the Layers list.

To cut or copy a layer
Either:
1. Select the layer.
2. On the Edit menu, click Cut or Copy, or click the Cut Selection or Copy 

Selection button on the toolbar.

Or:
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• Right-click the layer and from the appearing context menu select Cut Layer or 
Copy Layer.

To paste a layer
Either:
1. Select the layer.
2. On the Edit menu, click Paste or Paste Insert, or click the Paste button in the 

toolbar.

Or:
• Click the layer with the right mouse button, and click Paste Layer or Paste 

Insert Layer on the pop-up menu.
• Paste Layer: Adds the layer to the top of the Layers list.
• Paste Insert Layer: Adds the layer above the currently selected layer.

To delete a layer
Either:
1. Select the layer.
2. On the Edit menu, click Delete Selection, or click the Delete Selection button in 

the toolbar.
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Or:
• Click the layer with the right mouse button, and click Delete Layer on the pop-

up menu.

To duplicate a layer
• Hold down Ctrl and drag the layer you want to duplicate to the appropriate 

position in the Layers list.

To pin a layer to a map

• Click the pin icon to the left of the layer name.

The text or image will then move, and optionally scale, with the map layer below 
it. To unpin the layer click the pin icon again.

To lock two map layers together

• Click the lock icon to the left of the layer in the Layers list.

Locking a map layer fixes it at the same size, scale, and projection as the base 
map. This is useful for drawing selected regions of a map using a different style 
sheet from the main map. For more information see the chapter Working with 
Maps.

To rename a layer
Either:
1. Select the layer.
2. On the Layer menu, click Rename.

Or:
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• Right-click the layer and from the appearing context menu click Rename 
Layer.
• The above dialog box allows you to enter a new name for the layer.

3. Enter the name and click OK.

4.7 Using the Content Manager
The Content Manager displays an entry for each layer in the project, showing the 
image associated with the layer, the alpha channel, and the paint mask:

The Animation controls in the lower right corner of the Content Manager allow 
you to select which frame is displayed.

To display the Content Manager
Either:
• On the Tools menu, click Content Manager.

Or:
• Click the Content... button above the Layers list.

To copy content
You can copy any image, alpha channel, or mask within a layer or to another layer, 
by dragging and dropping it within the Content Manager.

1. Select Current Frame to affect only the current movie frame, or Multiple 
Frames to copy multiple frames. 

2. Select the appropriate Destination option to determine how the dragged cell is 
combined with the destination cell. 

3. Drag the required cell and drop it onto the required destination cell:
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If you selected Multiple Frames the Copy Content dialog box is displayed to allow 
you to specify which frames to change. 

4. Specify the range you want to change and click the OK button.
5. Click the Close button to close the Content Manager.

You can perform a range of useful functions within the Content Manager simply 
by dragging a cell and dropping it onto another cell. The following sections 
describe some typical operations:

To create a luminance mask
1. Set the Destination option to Replace. 
2. Drag an Image cell and drop it onto a Mask cell.

To key an image using a mask
• Drag a Mask cell onto the Alpha Channel cell for the image you want to key.

To create a composite
1. Set the Destination option to Composite.
2. Drag an Image cell and drop it onto another Image cell.

The image you dragged will be superimposed on the destination image, using the 
dragged image’s alpha channel as a key.

4.8 Controlling Layer Compositing
By default, layers are simply composited one over the other using only their own 
alpha channel to determine which parts are visible in the finished composite, and 
which are not.

More sophisticated levels of compositing can be achieved using the blend mode, 
opacity, and composite mask.
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To specify the compositing options
Each layer provides compositing options to allow you to specify how the layer is 
combined with the other layers in the project, and its opacity.

1. Select the layer in the Layers list, and click the Properties tab to display the 
Properties panel for the layer.

2. Click the right arrow button to the left of the Compositing Options heading to 
display the compositing options for the layer:

Blend Mode specifies how the layer is combined with the other layers, and can be 
one of: 

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, 
Screen, Lighten Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, 
Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

Use Paint Mask as a Key (image layers only) and Obey Composite Mask are 
equivalent to the same options in the Composite Mask dialog box; see below.

To specify the composite mask options
The composite mask allows you to make one layer appear to pass in front of some 
parts of a layer below, but behind other parts.

For example, if you want to insert a character into a forest scene, you can make it 
appear behind some trees, but in front of others.

The composite mask is generated layer by layer as a composite image is built up, 
and can be used to protect parts of a layer from change by layers above in much 
the same way as the paint mask is used to protect images from paint operations.

For each layer, you can specify:

• Whether the layer’s paint mask is used as a key for the layer. 
• Whether the layer makes any changes to the composite mask which is passed 

on for use by layers above.
• Whether the layer obeys the composite mask (ie whether the composite mask 

is used to protect the layers below from change by this layer).

You set options for each layer using the Composite Mask dialog box which is 
displayed by clicking the mask icon to the right of the layer name in the Layers 
list. This will then allow you to set the compositing options for the layer.
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To use the layer’s paint mask as a key
This provides a quick way of cutting out a feature in an image.

1. Use the paint tools to create the mask:

2. In the When Compositing this Layer section select Use the paint mask as a key.

The layer’s paint mask is added to the alpha channel, and used to key the image:

To specify whether the current layer obeys the composite mask
In the When Compositing this Layer section:

• Select Obey the Composite Mask

To use the composite mask at least one layer should have this option selected.

This option is irrelevant for the lowest layer in the Layers list.

To specify whether the current layer affects the composite mask
In the After Compositing this Layer section:

• Select Create new Composite mask to update the composite mask with the 
new composite mask.

To use the composite mask at least one layer should have this option selected. 
The default action is for the layer’s paint mask to replace the existing composite 
mask, making those elements of the layer that are covered by the mask appear in 
front of layers above that obey the mask.

Alternatively you can specify that the paint mask is combined with the composite 
mask as described below.

This option is irrelevant for the highest layer in the Layers list.
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To specify how the current layer affects the composite mask
• Click the right arrow button to the left of the Advanced Options to show the 

advanced options.

Once a layer has been composited, you can use either its alpha channel or, in the 
case of an image or movie layer, its paint mask to modify the composite mask. 
You can also choose to invert the mask or alpha channel before use:

In the Use this layer’s... section:
• Select Paint Mask or Alpha channel.
• Select Inverted to invert the paint mask or alpha channel before using it.

The composite mask can also be affected in different ways. You can either replace 
the existing composite mask, or combine the composite mask with the mask or 
alpha channel of the current layer.

In the To... section:
• Select Replace the existing mask to create a new composite mask which is a 

copy or inverted copy of the layer’s paint mask or alpha channel.
• Select Add to the existing mask to add the layer’s paint mask to the existing 

composite mask.
• Select Intersect with the existing mask to create a new composite mask which 

is an intersection of the existing mask and the layer’s paint mask or alpha 
channel If you do not select Create new Composite mask, the existing mask is 
left unchanged and may be used to protect the composite image from change 
by any number of layers above.

To make an image go behind selected features in a scene
The following example illustrates one of the most powerful uses of layer 
compositing to control how one image interacts with components of another 
image. In this example we will use composite masks to make a butterfly go 
behind the frontmost poppy in an image of several poppies.

In this example both the images have alpha channels, to allow a background 
image to show through. 

The first step is to create a mask defining the foreground image; in this case the 
frontmost poppy:

This can be done using the mask extract tools on the Mask panel, followed by 
painting on the mask using the brushes on the Brushes panel.

1. Load the butterfly image, and create a mask for the butterfly.
2. Position the butterfly layer above the poppies image. 
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3. Load the clouds image, and move it to the bottom of the Layers list.

The composite image will reflect the order of the individual images in the Layers 
list:

You can view the components of the project in the Content Manager:

4. Click the mask icon, to the right of the layer name on the poppies image layer 
in the Layers list, and select Create new Composite mask:

5. Likewise, click the mask icon for the butterfly layer and select Obey the Com-
posite Mask:

The composite mask will be a copy of the mask on the poppies layer. This can 
then be used to protect the frontmost poppy from change by layers above. Since 
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the butterfly is composited obeying the composite mask, the effect is that the 
area of the butterfly corresponding to the frontmost poppy is masked out, so the 
butterfly appears to go behind the poppy:

The Composite Mask options can be animated, so a butterfly could be made to fly 
behind the poppy in one part of the movie, and in front of the poppy in another 
part of the movie.

4.9 Animation Controls

The Animation controls allow you to select which frame of the animation you are 
working on in the Viewer, and preview the animation.

The following animation controls are availble:

• Start, step back, play, step forward, and end
• Show full frame, lower/odd and upper/even fields
• Current time, duration, display formats (timecode or frames)
• Slider range
• Previous and next key
• Time slider and last frame

You can hide the Animation controls to give more space for the Viewer when 
working on a single frame of an animation.

This section contains information about the following procedures:

• To show or hide the Animation controls
• To specify the time display format
• To move to a specific frame
• To move to the next or previous key
• To expand the slider scale
• To show the whole project

To show or hide the Animation controls

• Click the Animation controls  button to the left of the Animation controls.
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To specify the time display format
• Choose the format as follows:

• Timecode: Hour:Minute:Second:Frame
• Frames: Frame number.

To move to a specific frame
Either:
• Edit the Current frame field.

Or:
• Drag the time slider.

To move to the next or previous key
• Click the Next key or Previous key button in the Animation controls.

A key is a frame in which one or more properties have been edited; for more 
information see the chapter Controlling Animation.

To expand the slider scale

1. Click the Slider Range button.

Either:
• Select Part of project, and specify the Start time, and the End time or Duration, 

of the section of the project you want to work on.

Or:
• Click the Match Movie... button to match the slider range and/or project 

settings to the movie in the currently selected layer.

2. Click the OK button.

To show the whole project
1. Click the Slider Range button.
2. Select Whole project and click the OK button.
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See Also
• Controlling Animation

4.10 Move/Pan Tool

• Map layers: Allows you to drag the map layer.
• Image, text, and shape layers: Allows you to move, resize, or rotate the image, 

text, or drawing.

In a map layer clicking the right mouse button displays a pop-up menu that 
allows you to add a country or region to the map, fit the map to a country or 
region, center the map on a country or region, add a new label to the map, or 
clear the selection:

In an image/movie, text, or shape layer clicking the right mouse button displays a 
pop-up menu:

This section contains information about the following procedures:

• To resize an object
• To rotate an image, text item, or drawing
• To temporarily select the Zoom tool
• To move the pin position

To resize an object
1. Drag one of the yellow handles at the corners or midpoints of the image or 

text item. 
• The image or text item is resized about the pin position specified in the 

Transformation dialog box for the image or text layer.

2. To keep the aspect ratio fixed hold down Ctrl while resizing.
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To rotate an image, text item, or drawing
1. Point to the rotation handle, which is a yellow square to the right of the pin 

position.
• The cursor changes to a rotation symbol.

2. Drag the handle to rotate the image, text item, or drawing about its pin posi-
tion.

To temporarily select the Zoom tool
• Hold down Ctrl until the cursor changes to the Zoom cursor to zoom in, or 

hold down Shift until the cursor changes to the Zoom cursor, and click to 
zoom out.

To move the pin position 
• Hold down Shift + Ctrl and drag the mouse pointer.

See Also
• Working with Maps
• Working with Street Maps

4.11 Path Tool

Allows you to edit the animation path along which a map layer, image, text item, 
or drawing will be animated.

To change the animation path
1. Point to a point on the animation path.

• The cursor changes to a triangle.

2. Drag the point with the mouse pointer.

To change the curvature of the animation path
• Hold down Ctrl and drag from a point on the animation path to extend tangent 

handles from that point.

To move the tangent handles independently
• Hold down Ctrl and drag one tangent handle. 

To move the tangent handles symmetrically
• Drag one tangent handle.

See Also
• Controlling Animation
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4.12 Text tool

• Map layers: Allows you to move, resize, or rotate the label of a map detail.
• Text layers: Allows you to edit the text in a text item, or resize the box. 

Right-clicking the layer displays a context menu that allows you to add a country 
or region to the map, fit the map to a country or region, center the map on a 
country or region, add a new label to the map, or clear the selection.

See Also
• Working with Maps

4.13 Zoom Tool

• Map layers: Allows you to change the scale of a map layer. 

Right-clicking the layer displays a context menu that allows you to add a country 
or region to the map, fit the map to a country or region, center the map on a 
country or region, add a new label to the map, or clear the selection.

To zoom in
Either:
• Click with the Zoom tool to zoom in by a factor of 2.
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Or:
• Drag with the Zoom tool to select an area which will be zoomed to fill the map 

rectangle.

To zoom out
• Hold down Shift and click with the Zoom tool to zoom out by a factor of 2.

To temporarily select the Move/Pan tool
•Hold down Ctrl and drag the mouse pointer.

To move the pin position
• Hold down Shift + Ctrl and drag the mouse pointer.

See Also
• Working with Maps

4.14 Map Rectangle Tool

• Map layers: Allows you to move or resize the map rectangle.

Right-clicking a map layer displays a context menu that allows you to move the 
center of the layer to the position of the mouse pointer:

See Also
• Move/Pan Tool

4.15 Browse Map Tool

• Map layers: Allows you to display the names of countries and regions in the 
map layer by pointing at them, and optionally add them to the Details list. 
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Right-clicking the layer displays a context menu that allows you to add a country 
or region to the map, fit the map to a country or region, center the map on a 
country or region, add a new label to the map, or clear the selection.

See Also
• Working with Maps

4.16 Browse Street/Shape Data Tool

• Map layers: Allows you to display the names of features in imported data by 
pointing at them, and optionally label them or add them to the Details list.

As you move this over the map the tool tip shows you the name of each imported 
data feature.

Left-clicking the map layer displays the Street Highlight tool for adding streets in 
the area you clicked. You can add whole streets, sections of streets and show 
direction.
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Right-clicking the map layer displays a context menu that allows you to filter the 
data, add a new label to the map, add the feature to the Details list, or label the 
feature:

If you are labeling a street the label will be drawn aligned with the direction of the 
street. You can use the Text tool to move or rotate the label as desired.

To add a section of a street
1. Click the Browse Street/Shape Data button
2. Left-click the map layer to display the Street Highlight tool
3. Select the street and click the Add section button
4. Left-click the street on the map to set start and end points for your section

• The street section will be added to the Details list
5. Close the Street Hightlight tool

4.17 Ruler Tool

• Map layers: Allows you to measure distances on maps, and displays other 
useful information.

• Image and movie layers: Allows you to measure distances on images and 
movies.

To measure a distance
• Drag from the start point to the end point of the distance to be measured.

• The display shows the location and height above sea level of the end point, 
and the distance between points:
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To specify the distance units

• Right-click the map, point to Measure Distances in or Measure Height in on 
the contenxt menu, then click the appropriate units on the submenu.

4.18 Pick Color Tool

Displays a window showing the color of the layer, and composite project, under 
the mouse pointer:

Clicking the mouse pointer copies the current color to the palette.
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4.19 Navigator

Allows you to select which part of the map is displayed in the map rectangle. The 
view drop-list contains all defined preset views and the possibility to add Custom 
preset views.

See Also
• Working with Maps

4.20 Panels
Allow you to control the characteristics of the object on the currently selected 
layer. The following panels are provided.

This section contains information about the following topics:

• Properties
• Contents
• Lighting
• Layer Fx
• Keybars

Properties
Shows settings affecting the entire layer including compositing options, transform 
options, drop shadow, frame, and trail.

Contents
Shows information about the contents of the layer. On a map layer it allows you to 
locate and select features from the map database or from imported street data, or 
add shape overlays. On a text layer it allows you to add and edit text items. On a 
shape layer it allows you to draw and edit shapes.

Lighting
Allows you to add lighting effects to a layer. For more information see the chapter 
Lighting and Effects.
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Layer Fx
Allows you to add image effects to a layer. For more information see the chapter 
Lighting and Effects.

Keybars
Allows you to control the animation of each feature of the currently selected layer 
that can be animated. For more information see the chapter Controlling 
Animation.

See Also
•

Chapter 4: Quick Tour 43



5 Working with Maps
This section explains the options for creating and working with map layers. It 
describes how to use the Properties panel to define the projection, with advice on 
choosing the appropriate projection for specific applications.

It also explains how to use the Contents panel to select countries and places for 
incorporation into the map, and control their appearance using the style settings.

This section contains information on the following topics:

• Creating a Map Layer
• Map Rectangle
• Setting the Map Properties
• Locating Features by Country or Region
• Locating Features by Name
• Adding Map Details
• Adding Features to the Map Database
• Locating Features in Street Data
• Locating Features in Imported Data
• Adding Shape Overlays to Map Layers
• Adding Satellite Imagery
• Adding Symbols
• Defining the Style of Details
• Setting the Properties for Details
• Setting Map Features
• Displaying Disputed Regions
• Navigator
• Measuring Distances on the Map

5.1 Creating a Map Layer
Most Viz World Classic projects will contain at least one map layer, containing the 
regions, countries, and other details you want to feature in the animation.

You can include more than one map layer to show two areas of the world, or one 
area at two different scales, in the same animation.

You can add a map layer when you create a new project, or using the appropriate 
option on the Layer menu.

The map layer will show the region detailed by the map database using the Globe 
projection.

This section contains information on the following procedures:

• To create a new project with a map layer
• To add a map layer
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• To insert a map layer between existing layers

To create a new project with a map layer

When you start Viz World Classic, or create a new project by clicking New on the 
File menu, you can choose to include a map layer:

1. Select Create map project.
2. Choose the map database you want to use from the drop-down menu.
3. Click the OK button to create the project.

• The first time you load a new map database there will be a delay while the 
data is loaded. All the map layers in one project use the same map 
database.

• Earlier versions of Viz World Classic (i.e. Viz Curious Maps) supported 
having access to databases of the World, Europe, and USA, and a 
Combination database which combines these into a single database. More 
recent versions of Viz World Classic are only installed with the combination 
database; however, you can change this under View > Options... > Map 
Data > Locations.

To add a map layer
• On the Layer menu, point to Add Layer, and then click Map.

• The new layer will be added above the existing layers.

To insert a map layer between existing layers
1. Select the layer in the Layers list above or below which you want to add the 

map layer.
2. On the Layer menu, point to Insert Above Selection or Insert Below Selection as 

appropriate, and then click Map.
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5.2 Map Rectangle
The map is drawn in a rectangular window called the map rectangle. You can 
change the size and position of the map rectangle to create inset maps in larger 
animations.

To display the map rectangle

• Select the Map Rectangle tool: Handles will be displayed on the edges of the 
map rectangle.

To resize the map rectangle
• Drag one of the handles.

To move the map rectangle

• Drag anywhere within the map rectangle. The above example uses a second 
map layer as an inset by resizing and moving the map rectangle to a corner of 
the main map.
46 Chapter 5: Working with Maps



5.3 Setting the Map Properties

The options in the Properties panel allow you to specify the position and scale of 
the map, choose the map projection, and specify the style sheet.

This section contains information on the following topics:

• Compositing Options
• Transform Options
• Drop Shadow Options
• Frame Options
• Trail Options

5.3.1 Compositing Options

Blend Mode specifies how the layer is combined with the other layers, and can be 
one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, 
Screen, Lighten Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, 
Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.
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5.3.2 Transform Options

Allows you to specify the position, scale, rotation, and origin numerically. The 
following fields are provided:

Longitude and latitude values can either be entered in decimal degrees, such as 
20.175, or in degrees, minutes and seconds, such as 20d10m30s.

This section contains information on the following procedures:

Option Description

Locked When selected, this map layer is locked to the position and zoom 
setting of the map layer below it; see To lock the map layer to 
the map layer below it.

Map Center The longitude and latitude at the pin position, in degrees.

Revolutions The number of globe revolutions in each direction, to create an 
animation that spins the globe.

Pin Position The point, relative to the map rectangle, about which the map is 
centered, where X=0%, Y=0% corresponds to the bottom left-
hand corner of the map rectangle.

Scale The zoom ratio, where 1.00 corresponds to showing the entire 
globe.

Position The position of the center of the map rectangle, where X=0, Y=0 
corresponds to the bottom left-hand corner of the project area.

Size The size of the map rectangle in pixels.

Curved 
Paths

When selected, moves the camera in a smooth curve between 
keys when panning the map.

Set Using 
GPS

Displays the GPS Position dialog box to allow you to center the 
map at a specific longitude and latitude; see To enter a GPS 
location.
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• To lock the map layer to the map layer below it
• To change the pin position

To lock the map layer to the map layer below it
• Select Locked in the Transform options.

Locking a map layer fixes it at the same size, scale, and projection as the base 
map. This is useful for drawing selected regions of a map using a different style 
from the main map.

In the above example the upper map layer has all styles other than Selected 
Region set to a Fill color of None, and no relief. The lower map layer has Relief 
and Ocean Contours selected.

To change the pin position
The map is centered on the pin position, which is drawn as a ‘+’ symbol on the 
map when you select one of the map manipulation tools. Initially, the pin position 
is centered in the map rectangle, but you can change it to create an 
off-center globe in the map rectangle.

Either:
1. Select the Move/Pan or Zoom tool.
2. Hold down Sc (PC) or SA (Mac) and drag in the Viewer.

Or:

• Edit the Pin Position values in the Transform options.
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The above example was created using two map layers, each with a different pin 
position.

5.3.3 Drop Shadow Options
Allows you to add a drop shadow which is cast by the map layer onto other layers.

The following parameters are provided:

5.3.4 Frame Options

The following options allow you to define the frame:

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the 
range 0-5 are recommended.

Color The color of the drop shadow.

Option Description

Fill Color The fill color, for areas outside the globe if the edges of the 
globe are visible.

Border and 
Border Color

The frame border color, and its shape: Rectangle or Circle.
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For example, the above inset map uses a circular frame with a white 5-pixel 
border.

5.3.5 Trail Options

• Use Trail Width and Trail Color to define the width and color of the trail.
• Choose Behind, Ahead, or Full from the Trail drop-down menu to leave a trail 

behind, ahead of, or on both sides of the path.
• Select Trail Above to display the trail above the layer.

Border Width The width of the frame border in pixels.
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5.3.6 Locator

The map locator enables you to create a map that can be used to highlight the 
location of your main map.

To create a locator map

1. From the main menu click Layer, and select Create Pre-rendered Map and then 
Locator...

2. From the Export Locator Map dialog box you can name the file, set format, 
image format/quality options, frame size and alpha options.

3. Click Render to render the locator image to disk
4. In the Locator options select the locator image from the Map drop-list
5. Set the parameters for the locator and save the map project

5.3.7 Map Legend
Map legend allows you to add a legend to the map, position and customize its 
design.
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• Master Opacity: Sets the opacity of the legend.
• Units: Defines the legend’s units in kilometres/meters, miles/yards and miles/

feets.
• Position: Defines the position of the legend. Available options are bottom and 

top left, right and center.
• BG Offset: Defines the offset of the legend’s background.
• BG Color: Defines the legend’s background color.
• BG Opacity: Defines the opacity of the legend’s background.
• Border Size: Defines the legend‘s border size (in pixels).
• Line Length: Defines the legend’s length (in pixels).

• Line Thickness: Defines the thickness of the legend’s line (in pixels).
• Line Color: Defines the legend’s line color.
• Type: Defines the type of line. Alternatives are line up/down, alternate filled 

and open and staggered open/filled.
• Font: Defines the font and the font parameters.
• Text Color: Defines the color of the text.
• Default text: Allows you to enable and define the default unit text (e.g. setting 

Km to km, kilometres, kilometros etc.).
• Units Title: Allows you to manually enter the units title text instead of using 

the default text.
• Sub-units Title: Same as for Units Title.
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• Title Alignment: Aligns the unit titles. Available options are Left, Center and 
Right.

• Halo Size: Defines the size of the legend’s halo. Note that the halo only has an 
affect on the legend itself and not the legend’s background (use shadow).

• Halo Color: Defines the color of the legend’s halo.
• Shadow On: Enables the legend’s shadow.
• Shadow Position: Defines the (X and Y) position of the legend’s shadow.
• Shadow Opacity: Defins the opacity of the legend’s shadow.
• Shadow Softness: Defines the softness of the legend’s shadow. The higher the 

softness the wider the shadow will spread.
• Shadow Color: Defines the color of the legend’s shadow.

To create a map legend

1. Open the Properties panel
2. Enable the Map Legend and set the parameters
3. Save the map project
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5.3.8 Projection

To choose the projection
• Choose the projection from the drop-down menu.

Selecting a projection previews it in the window below the drop-down menu.

• Click the Apply button to apply the projection to the map layer.

Which map projection you choose will depend on what you are using the map for, 
the part of the globe displayed, and the type of animation. 

In the majority of cases the Globe projection will be most suitable as it is ideal for 
‘zooming in’ animations, and land shapes look familiar when in the middle of the 
picture. Its chief disadvantages are that shapes get distorted near the horizon, 
and only half the world can be seen at any one time.

The other projections are divided into four main groups:
• Cylindrical projections have shapes that look familiar for certain latitudes, but 

will be much distorted at other parts.
• Equal Area projections show the relative size of countries more accurately but 

the shapes can look unusual.
• The Conical projection is really only useful for maps of the Continental USA.
• The Stereographic projections have familiar shapes at the center of the image, 

but will be very distorted at the edges. They can be useful for combining with 
satellite images. 
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5.3.9 Automation

To change the style sheet
• Choose a style sheet from the Style sheet drop-down menu.

To auto animate the map layer

• Click the Auto Animate button:

See Also
• Working with Styles
• Automatically Animating a Layer

5.4 Locating Features by Country or Region
The Explorer tab on the Contents panel allows you to explore the map database 
hierarchically, by country or region:

The left list displays an alphabetical list of countries, and regions within each 
country. The right list displays specified features within a selected country or 
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region, or a message explaining how to narrow the search to find an item of 
interest.

This section contains information on the following procedures:

• To scroll to any country in the list
• To list only countries visible in the current map view
• To show/hide regions
• To display a list of features contained in a country or region
• To display the currently listed features on the map
• To scroll directly to a feature

To scroll to any country in the list
• Type the first few letters of its name in the Find box above the list.

To list only countries visible in the current map view
• Select Visible regions.

To show/hide regions
Countries shown with a + to the left of their name in the list are divided into 
regions.

• Click the + to expand the list and show the regions.
• Click the - to collapse the list and hide the regions.

To display a list of features contained in a country or region
1. Select the country or region in the left list.
2. Select the type of features you want to list from the drop-down menu below 

the list.

By default Towns > 100k is selected, to show towns with a population greater 
than 100,000, but you can select from a range of alternative options.

3. Select Visible to show only features visible in the current map view.

To display the currently listed features on the map

1. Click the Locate Features button (see above).
• The currently selected features will be labeled on the map:
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2. Click a feature with the right mouse button (PC), or while holding down Ctrl 
(Mac), point to Add to map on the pop-up menu, and click the feature:
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To scroll directly to a feature

1. Select United Kingdom as the region.
2. Select Mountain and check the adjacent Visible check-box
3. Type the first few letters of a British mountain (e.g. Snowdon) in the Find box 

above the list.

Note: Searching for features in any country by selecting The World may give too 
many results. Try narrowing down the search by selecting a specific country or 
region, or by checking one or both of the Visible check-boxes.

5.5 Locating Features by Name
The Search tab in the Contents panel is used for searching the entire map 
database for a feature, using a string or sub string typed in the Named text box. 
Search results can be filtered by using the radio buttons and the drop down list.

Searching is instant (after the first three characters) and optimized according to 
relevance; hence, if you search for Paris your result will show all places named 
Paris, but if you search Paris TX you will get Paris, Lamar County which is in Texas, 
USA.
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1. Select All or Visible to search all of the features of specified type in the 
database, or only those visible in the current map view.

2. Choose the type of feature you want to search for from the Type drop-down 
menu.

3. Enter the text you want to search for in the Named field.

The text can include the wildcards ? or * to match any single character, or any 
sequence of characters, respectively. For example, typing *erest will find all 
features containing erest:

If you have street data (see Locating Features in Street Data) you can also search 
for crossroads using AND or & (e.g. E Tudor RD AND Lake Otis Pky):
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Search Parameters
• Find All: When selected it displays all matching entries in the database.
• Find Visible: When selected it only displays matching entries visible in the 

current map. 
• Addr and Cross st.: Enables the user to search for specific addresses.
• Type: Limits the result list according to the selected Type. For example region, 

capitals, tourist attraction, and so on.
• Named: Text box for entering search criteria. Can also use AND or & to search 

for crossroads/intersections.
• Intersection: Searches for an intersection of the street entered in the Named 

field. This is an alternative to the search option described for the Named field.
• Source: Searches a range of sources.

• Database: Searches the Viz World database.
• Web: Searches Yahoo for online point data.

Note: Searching for addresses requires licensed street data installed on the server.

To display the currently listed features

• Click the Locate Features button: The currently selected features will be 
labeled on the map, and you can click on one to select it in the Search list.

5.6 Adding Map Details
The Details list on the Contents panel shows a list of all the details currently 
selected for incorporation in the current project:
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Each entry shows an icon representing the type of feature, the name of the 
feature, and the name of the style applied to the feature. The icons are as follows:

The Details list also includes any area or line shapes drawn on the map layer:

This section contains information on the following procedures:

• To specify how labels scale with the map
• To reorder the map details
• To remove a map detail
• To add a feature from the Explorer or Search panel to the Details list
• To add a country or region from the map to the Details list

Icon Description

Country

Region

Town

Place

River

Mountain

Icon Description

Area shape

Line shape
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• To redraw the map to fit a feature
• To center the map on a map detail

To specify how labels scale with the map
• Select Scale labels with map below the Details list to cause the labels of map 

details to remain the same proportion relative to the map’s scale.
• If you deselect this option the labels will remain fixed size irrespective of 

the map scale.

Note: This option affects all labels on the map layer.

To reorder the map details
Entries in the Details list are drawn on the map from the bottom of the list 
upwards, and you can change the order to determine how features overlap.

Either:
1. Select the detail you want to move.
2. Click the arrow buttons to move it up or down in the list:

Or:
• Drag the detail to the required position in the list:

Or:
• Click the detail with the right mouse button (PC), or while holding down Ctrl 

(Mac), and click the appropriate Ordering option on the context menu.

To remove a map detail
Either:
1. Select the detail you want to remove.
2. Press d (PC) or b (Mac).

Or:
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• Click the detail with the right mouse button (PC), or while holding down Ctrl 
(Mac), and click Remove on the context menu.

To add a feature from the Explorer or Search panel to the Details list
Either:
1. Select the feature in the Explorer or Search lists.
2. Click the Add Feature to Details button:

Or:
• Click the detail with the right mouse button (PC), or while holding down Ctrl 

(Mac), and choose Add to map from the context menu.

To add a country or region from the map to the Details list
1. Click the Browse Map tool:

2. As you move the pointer over the map, the name of each country and region is 
displayed:

3. Click the map with the right mouse button (PC), or while holding down Ctrl 
(Mac), point to Add to map on the context menu, and click the feature you 
want to add:
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To redraw the map to fit a feature

• Click the feature in the Explorer, Search panel, or Details list with the right 
mouse button (PC), or while holding down Ctrl (Mac), and click Fit map on the 
appearing context menu.

To center the map on a map detail
• Click the feature in the Explorer, Search panel, or Details list with the right 

mouse button (PC), or while holding down Ctrl (Mac), and click Center map on 
the appearing context menu.

See Also
• Working with Shapes

5.7 Adding Features to the Map Database
Viz World Classic allows you to add user-defined features to the map database. 
You can share user map details with other users; see the Sharing Databases 
section.

This section contains information on the following procedures:

• To define a new feature on the map
• To define a new feature from the Explorer

To define a new feature on the map
You can define a new feature at a specified map position and add it to the map 
database, associated with the country and region you clicked on.

1. Select any tool except the Path tool or the Map Rectangle tool.
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2. Click the map where you want to add the feature with the right mouse button 
(PC), or while holding down Ctrl (Mac), and click New Label... on the context 
menu:.
• The following dialog box allows you to define the new feature:

3. Enter a name for the feature, and specify the style.
4. Click the OK button to add the new feature to the user map details database 

and Details list.

To define a new feature from the Explorer

You can define a new feature of any type and add it to the map database 
associated with a specific county and region.

1. Click the New Feature button in the top right corner of the Explorer panel.
• The following dialog box allows you to define the new feature:
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2. Enter a name for the feature, and specify a category and style.
3. Enter the latitude and longitude, if you know them, or use the Text tool to 

move the new feature to the correct position after you have defined it.
• The Region list is identical to the left list in the Explorer and you can use the 

Find box to scroll to an entry, and the Visible regions checkbox to show only 
regions visible in the image window.

4. Click the OK button to add the new feature.
• The feature will be added to the user map details database and to the 

Details list.

See Also
• Reusing Design Elements

5.8 Locating Features in Street Data
The Streets tab on the Contents panel allows you to explore imported street data, 
and add selected features to the Details list: 
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It works in a similar way to the Explorer.

See Also
• Working with Street Maps

5.9 Locating Features in Imported Data
The Imported Data tab on the Contents panel shows imported third-party map 
data in the widely-used ESRI Shape File Format, and allows you to explore it by 
data set, data layer, and subset:

It works in a similar way to the Explorer.

See Also
• Working with ESRI Shape Files

5.10 Adding Shape Overlays to Map Layers
The Overlays tab on the Contents panel allows you to add shape overlays to the 
map layer, either by drawing them, or by tracing map features:
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See Also
• Working with Shapes

5.11 Adding Satellite Imagery
You can add geo-referenced satellite imagery to your base map. Other features 
like street data will appear on top of it.

To add satellite imagery to the base map

1. From the View menu select Options...
2. Select Locations and click Installed Imagery...
3. Click the + button and open the CMR files
4. Click the Fit images to selected map button and close the window
5. From the Styles menu select Styles Editor...
6. Select the Topography tab
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7. Select your style sheet and set it to Natural Earth
• All satellite images will appear as part of your map; however, they will only 

appear if you use style sheets based on Natural Earth.

8. Optional: From the Contents tab select the Streets tab and load the street data 
for your region to see how streets are overlayed.

See Also
• Working with Images and Movies

5.12 Adding Symbols

Symbols can be added to map layers.
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To add symbols

 
1. Click the Symbols button on the toolbar, or click Symbols on the Tools menu.

2. In the Symbols dialog box select the symbol and click the Add to Layer button 
or Drop Symbols button.
• All symbols are visible in the Details list.

To manage symbols
1. Click the Symbols button on the toolbar, or click Symbols on the Tools menu.
2. Add a page to categorize symbols

• Pages can also be renamed

3. Click the Replace... button to replace the symbol
4. Add symbols to the page by clicking the + button
5. Delete symbols from the page by clicking the Delete button
6. Set properties by clicking the Properties button

• The Properties dialog box allows you to set the scale, fix the aspect ratio, 
set default text, set preferred style name, add and set drop shadow 
properties and set it to loop.

5.13 Defining the Style of Details
The Style, Properties and Shape panels on the Contents panel allow you to define 
the individual appearance of each of the map details and shape details you have 
added to your project.

Each detail is initially drawn using the style defined in the Styles Editor for the 
corresponding type of object. These include:

• Sea, Unselected Land, Selected Region, Place, and Latitude/Longitude.

You can redefine these styles in the Styles Editor, to change the appearance of all 
details of the corresponding type. You can also create your own named styles, and 
apply these to specific details to draw them in a specific style. 

Finally, you can override the style of any selected detail to modify its appearance 
from that specified in the Styles Editor.

This section contains information on the following procedures and topics:
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• To apply a predefined style to a detail
• To redefine the style applied to a map detail
• To override the style of a map detail
• Color panel
• Text panel
• Strap panel

To apply a predefined style to a detail
1. Select the detail in the Details list.
2. Click the Style tab and choose the style name from the Style list:

To redefine the style applied to a map detail
1. Click the Style tab and select the style in the Style list.
2. Click the Edit... button
• The Styles Editor will be displayed to allow you to edit the style. For more 

information about using the Styles Editor see Working with styles, page 27.

To override the style of a map detail
1. Select the detail in the Details list.
2. Click the Override Style (+)… button.
• The Settings dialog box will be displayed to allow you to override the style:

• If the style has been overridden a + will be displayed after the style name in 
the Details list.
72 Chapter 5: Working with Maps



3. After overriding a style you can click the Add to Style Sheet… button to add 
the new style to the current style sheet, so you can use it for other details.
• The following dialog box will be displayed to allow you to name the new 

style:

The options are described in the following sections.:

• Color panel
• Text panel
• Strap panel
• Texture CC panel

Color panel

Allows you to specify the fill, border and coastline colors for the object, the width 
and line width limits, and an optional texture.

For more information see the Color Panel when Working with Styles.

Text panel

Allows you to specify the color, font, size, style, alignment, and opacity of the 
feature’s label. For point styles it also allows you to choose the marker which is 
drawn at the location of the feature.

1. Select On to apply a default drop shadow.
2. Click the Drop Shadow… button to define the characteristics of the drop 

shadow:
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For more information see Text Panel when Working with Styles.

Strap panel

Allows you to draw a marker at the label position, and a background (strap) for 
the label with an optional frame and connector. You can also add a drop shadow 
to the strap in the same way as for the label.

After defining a strap with a connector you can move the end of the pointer using 
the Text tool. 

For more information see Strap Panel when Working with Styles.

Texture CC panel

Allows you to color correct textures.

See Also
• Texture CC panel when Working with Styles
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5.14 Setting the Properties for Details
The Properties panel on the Contents panel allows you to change individual 
properties of a detail not defined by its style:

This allows you to specify the color and text opacity for the detail, and edit its 
label.

If the label for the feature is outside the project area you can make it visible by 
clicking the Make Label Visible button:

• Set the size and angle of the label using the Scale and Label Rotation fields.

Alternatively you can scale and rotate a label using the Text tool.

• Click the Fit Map or Center Map buttons to fit or center the currently select 
feature to the map.

• Click the Auto Animate button to auto animate the feature.

To create multi-line detail labels
You can include a \ (backslash) character in the label for map details to split the 
label onto two or more lines:

This gives greater flexibility in labelling small features on the map:
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To select an alternative label
Some features provide alternative labels; e.g. Beijing (Peking).
• Select the alternative you want from the Label drop-down menu.

You can also add your own alternative names; these get saved in an alternate 
names database so they are always available.

To specify the order of alternative place names
You can specify the order in which alternative place and region names are shown.
1. On the View menu, click Options….
2. In the Display section click Map Labels:

The 1st Choice, 2nd Choice, and 3rd Choice drop-down menus can each be set to 
one of the following options:

Option Description
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s 
Map details are listed in the Explorer and Search panel as: 1st Choice (2nd choice). 
The 1st Choice is selected by default for new map details.

5.15 Setting Map Features
The style sheet selected for a map layer specifies a number of general settings. 
You can override these using the Map Features dialog box.

This section contains information on the following procedure and topics:

• To display the Map Features dialog box
• Global Map Data
• Local Street Data
• Scale roads/rail with map and Rivers Master Scale
• Physical Feature Animation

To display the Map Features dialog box
• Click the Map Features button in the top right corner of the map layer 

Contents panel.
• This provides the following sections:

Global Map Data

Allows you to specify the following settings for the selected map layer:

Standard The standard name provided in the map database.

Alternate The alternate name provided in the map database.

Abbreviation The abbreviated version of the name in the map database.

User The user-defined alternate name defined on the Details Propertie
panel. It will always use the last entered name.

Parameter Description 
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Local Street Data

Allows you to specify which lakes, rivers, roads, and railways are visible in street 
data, and the opacity of roads and railways. The options are the same as for 
Global Map Data opposite.

Enable allows you to choose whether or not street data is displayed in the map 
layer. 

The Street Data... button displays the Street Data Directory dialog box and is 
equivalent to the Street Data... command on the Import menu.

For more information see Working with Street Maps.

Scale roads/rail with map and Rivers Master Scale

Determines how roads, railways, and rivers are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and 
rivers. You can adjust the value to achieve particular effects; for example, reduce 
it below 1.00 to make all line features thinner. 

For line features, such as roads and rivers, a minimum and maximum line width is 
specified in the Styles Editor dialog box Styles Color panel to ensure that the 
features have an appropriate appearance at extreme zoom settings. However, it 
can look unnatural if a line feature reaches its maximum width before you get to 
the closest zoom point as you zoom in to a map. 

Lakes, Rivers Allows you to specify which lakes and rivers are visible. 

Roads Allows you to specify which roads are visible. 

Rail Allows you to specify which railways are visible. 
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To solve this problem, choose the closest zoom setting in your animation and 
click the appropriate Auto Fix… button. This will automatically set the 
corresponding scale value to scale the maximum line width so it only reaches its 
maximum width at the closest zoom point. 

Physical Feature Animation

Allows you to animate the relief height, relief DEM blend, ocean contour opacity, 
and land drop shadow.

• Relief Height: Typically used to reduce the amount of relief at close zoom 
settings, when full scale relief can appear distracting. 

• Relief DEM Blend: Imported DEM (Digital Elevation Model) relief data does not 
always match up exactly with the built-in relief. As a result, seams may be 
visible where they meet. This control allows you to hide imported relief data 
until you are zoomed in far enough for the seams to fall outside the display 
window. For more information about importing relief data see how To import 
relief data.

• Ocean Contour Opacity: Allows you to animate the intensity of ocean 
contours.

• Land Drop Shadow: Allows you to animate the land drop shadow over time. 

5.16 Displaying Disputed Regions
Viz World Classic allows you to choose how several disputed regions in the world 
are displayed and assigned to the appropriate countries. Any changes made to 
this setting apply to all projects. 
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To change the assignment of disputed regions

 Figure 3: Default (left) and divided (right) configuration

Note: You cannot make any changes to the disputed regions if your project contains 
map layers, so if necessary delete any map layers in your project. 

1. On the View menu, click Options….
2. Click Map Data, then the Database option, then click the Disputed Regions… 

button to display the Disputed Regions dialog box. 
3. Choose the region you want to configure from the Region drop-down menu. 
4. Choose one of the available configurations from the Configuration drop-down 

menu. 
• As you select a configuration the map shows how the regions will be 

displayed.

5.17 Navigator
The Navigator allows you to select which part of the map is displayed in the image 
area. 

This section contains information on the following procedures:

• To choose a view
• To change the view
• To define a preset view
• To edit the name of a preset
• To delete a preset
• To enter a GPS location
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To choose a view

• Drag across the Navigator to draw a rectangle enclosing the area of the world 
you want to display.

To change the view
1. Drag a corner of the rectangle to resize it.
2. Hold down Ctrl (PC) or Alt (Mac) and drag the rectangle to move it.
3. Move the scale control, to the right of the Navigator, to enlarge or reduce the 

size of the rectangle.

To choose a preset view

• Choose a preset view from the View context menu.
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To define a preset view
1. Define the view you want to save.
2. Click the … button to the right of the Navigator View menu.

• The Presets dialog box will be displayed:

3. Click the + button.
• A new preset will be created with a default name, such as Preset0.

To edit the name of a preset
1. Select the preset in the Presets list.
2. Click the Rename... button.

To delete a preset
1. Select the preset in the Presets list.
2. Click the X button.

To enter a GPS location

1. Click the GPS button below the Navigator.
• The GPS Position dialog box (depicted above) will be displayed to allow you 

to specify that the map should be centered at a particular longitude and 
latitude.

2. Enter the longitude and latitude in the Long. and Lat. fields.
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• Longitude and latitude values can either be entered in decimal degrees, 
such as 20.175, or in degrees, minutes and seconds, such as 20d10m30s.

3. Optionally enter the amount of the Earth’s surface you want to display in the 
Radius field.
• For creating animations of a revolving globe you can optionally enter a 

number of revolutions in the Revs fields.

5.18 Measuring Distances on the Map
The Ruler tool provides a convenient way of measuring distances on maps, and 
displaying other information.

To measure a distance

1. Select the Ruler tool.
2. Drag from the start point to the end point of the distance to be measured.

• The display shows the location and height above sea level of the end point, 
and the distance between points:
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To specify the distance units

• Click with the right mouse button (PC), or while holding Ctrl (Mac), point to 
Measure Distances in or Measure Heights in on the context menu, then click 
the appropriate units.
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6 Working with Styles
This section explains how to use style sheets to make it easy to set up a series of 
house styles, and convert projects between house styles with a single click. It also 
explains how style sheets help you establish consistency across projects, or 
between designers.

This section contains information on the following topics:

• How Style Sheets Work
• Creating, Saving, and Loading Style Sheets
• Styles Panel
• Topography
• Markers Panel
• Textures Panel
• Lighting Panel
• Map Features Panel
• Options Panel
• Using Imported Relief Data

6.1 How Style Sheets Work
A style sheet defines all the properties and design conventions used to draw a 
map. Each map layer has a style sheet associated with it which determines its 
appearance.

The style sheet defines:
• The predefined styles, and any additional user-defined styles.
• The markers used to identify map details.
• The textures available for use as textures for regions.
• One or more default lights for the map layer.
• Additional properties of the map including land shadow, relief, and line 

widths.

Once created, a finished project can be changed to a different set of design 
conventions simply by loading in a different style sheet.
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For example, the above project was created using the default style sheet.

The project can then be instantly converted to a totally different house style 
simply by loading in a different style sheet.

For example, one style sheet could include texturing and lighting effects.
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For another project loading a style sheet could create a much simpler appearance 
with flat lighting and thick line widths.

This section contains information on the following topic:

• Multiple Style Sheets

6.1.1 Multiple Style Sheets
If your project includes more than one map layer you can apply a different style 
sheet to each map layer. For example you might have one house style for the 
main map in a project and another house style for an inset map.

See Also
• How Style Sheets Work

6.2 Creating, Saving, and Loading Style Sheets

Styles are created and edited using the Styles Editor. You can leave the Styles 
Editor open while you work with the project and any changes you make in the 
Styles Editor are immediately reflected in the current map layer.
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This section contains information on the following procedures:

• To display the styles editor
• To create a new style sheet
• To rename a style sheet
• To delete a style sheet
• To copy style sheets from another project
• To export an individual style sheet
• To import a style sheet

To display the styles editor
• On the Styles menu, click Styles Editor... .

When you create a new map layer it initially uses the style sheet defined by the 
default project template. If there is no project template the style sheet called 
Political is used. For more information about creating a default project template 
containing your own choice of styles see Reusing Design Elements.

You can create any number of new style sheets, and modify the styles in those 
style sheets to establish the design conventions you want to use.

Style sheets are saved with the project, and you can import style sheets from 
another project. You can also save individual style sheets in separate files.

To create a new style sheet
1. Select the style sheet you want to base the new style sheet on in the Style 

Sheet list.
2. Click the + button.

Note: By default the style sheet is called StyleSheet, StyleSheet1, etc.

To rename a style sheet
1. Select the style sheet you want to rename.
2. Click the Rename... button. 

To delete a style sheet
1. Select the style sheet you want to delete.
2. Click the X button. 

To copy style sheets from another project
1. On the Import menu, click From Project... .
2. Select the project file you want to import from. 

• The following dialog box then allows you to specify the features of the 
project you want to import:
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3. Click the Styles tab.
4. Select the style sheets you want to import from the project, using Shift to 

select contiguous items, and Ctrl (PC) or Command (Mac) to select non-
contiguous items.

5. Click the Load button to proceed.
• The style sheets will be added to the list of style sheets, replacing any 

existing style sheets of the same name where appropriate.

To export an individual style sheet
1. In the Styles Editor click the Export... button.

• You will be prompted to give the style sheet a name.

2. Enter a suitable name and click the Save button.

To import a style sheet
1. In the Styles Editor click the Import... button.

• An Open dialog box will be displayed to allow you to select a style sheet to 
open.

2. Select the style sheet and click the Open button. 
• The style sheet will be added to the list of style sheets in the project. If there 

is already a style of the same name the style sheet will be renamed.
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6.3 Styles Panel

The Styles panel allows you to edit the styles in the currently selected style sheet.

This section contains information on the following sections:

• Predefined Styles
• Color Panel
• Text Panel
• Strap Panel
• Texture CC panel

6.3.1 Predefined Styles
Each style is identified by a name, such as Region, and specifies attributes such as 
fill color, border color, coastline color, marker color, text color, text typeface, and 
size. Applying a style to a map detail then sets its attributes to those defined by 
the style.

Viz World Classic provides a set of predefined styles for each of the different 
types of feature in the map database. These include: Sea, Unselected Land, 
Selected Region, Place, Latitude/Longitude, and a number of default styles for use 
with street data.

This section contains information on the following procedures:

• To edit the attributes of a built-in or user-defined style
• To create a new style
• To edit the name of a style
• To delete a style

To edit the attributes of a built-in or user-defined style
1. Select the style you want to edit in the Styles list.

• The attributes of the style are shown on the Color, Text, Strap and Texture 
CC (color correction) panels:

2. Edit any attributes you want to change.
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All objects in the selected style will be updated to reflect the changes you have 
made.

Each predefined style is of type Area, Line, or Point as appropriate, and this 
determines the attributes displayed in the Color, Text, and Strap panels.

When you create a user-defined style you specify whether it is an Area, Line, or 
Point style, and this determines which features you can apply it to.

To create a new style
1. Select the style you want to base the new style on in the Styles list.
2. Click the + button.

• A new style will be created with a default name; e.g. Style1.

3. Select Area, Line, or Point to specify what the style applies to.
• This determines which options are available in the Color, Text, and Strap 

panels.

4. Edit the attributes of the style as required.

To edit the name of a style
1. Select the style in the Styles list.
2. Click the Rename... button.

Note: You cannot edit the names of built-in styles.

To delete a style
1. Select the style in the Styles list.
2. Click the X button.

Note: You cannot delete the built-in styles.

6.3.2 Color Panel
The options available on the Color panel depend on the selected style.

This section contains information on the following topics and procedures:

• Area styles
• Line styles
• To use a texture
• To transform a texture
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Area styles

Provides some or all of the following options:

Line styles
Provides the following options:

Attribute Description

Fill The fill color for the object.

Four Color Cycles between four different colors for the fill color 
so that adjacent regions can easily be distinguished. 
The Auto button automatically sets the alternative fill 
colors based on the current Fill color.

Mix with Topography Moving the slider to the right adds a proportion of 
the style color to land colored with topography.

Texture An optional texture for the object; see Using textures 
below.

Border Specifies the border color.

Width Sets the line width for the borders of imported map 
features.

Internal Borders Displays the internal borders of the country in the 
specified color. 

Disputed Borders 
Dashed

Displays disputed borders dashed.

Coastline Specifies the coastline color.

Line Width Limits Restricts the range of line widths when zooming.

Attribute Description

Inner color and Width Color and width of the body of the line feature.

Outer color and Width Color and total width of the edges of the line feature.

Line Width Limits Restricts the range of line widths when zooming.
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To use a texture 
• To fill the area with a texture select an existing texture from the drop-down 

menu, or use the + button to load a new texture from a file.
• Any image can be used as a texture, including images in the CMR (Curious 

Multi-Res) format; this is ideal for using large files, such as satellite images, 
as textures. For more information see Working with Images and Movies.

• The buttons to the right of the Texture drop-down menu can be used to 
determine how the texture is displayed:

To transform a texture
1. Click the Position Texture (Arrows) button.
2. Drag the circles to indicate which points on the texture you want to use as the 

reference points. 

3. Drag the arrow heads to indicate where those points should be positioned on 
the map:

4. Click with the right mouse button (PC), or while holding down Ctrl (Mac), and 
click Apply transformation on the context menu to transform the texture.

Button Name Description

Add 
Texture 

Displays the Open dialog box to allow you to add a 
texture from a file.

Position 
Texture

Click to position the texture on the map. You can then 
move or scale the texture in the same way as for images. 

Position 
Texture 
(Arrows)

Allows you to move and scale the texture by specifying 
how two points on the texture should be aligned with the 
map; see below.

Tile Specifies whether the texture
should be tiled.
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5. Click the Position Texture (Arrows) button again to see the transformed 
texture.
• The Make Handles Visible option on the pop-up menu is useful if the 

handles are outside your current view.

See Also
• Working with Images and Movies

6.3.3 Text Panel

The text panel provides the following options:

Attribute Description

Marker Point styles only: The image file used 
for the point. Select an existing marker from the 
drop-down menu, or click the+button to load a new 
marker.

Text Specifies the text color, font, size, and style (bold, 
italic) for labels.

Extra spacing Varies the character spacing to compress or expand 
the text.

Extra line spacing Adds extra line spacing.

Alignment Specifies the position of the label relative to the 
marker.

Distance Sets the distance.

All Caps All letters are writtin in upper case.
94 Chapter 6: Working with Styles



Drop Shadow

Provides the following options:

6.3.4 Strap Panel

The Strap panel allows you to add a background, frame, and/or connector to the 
label of a feature.

Provides the following options:

On Adds a default drop shadow.

Drop Shadow… Displays the Drop Shadow dialog box to allow you to 
define the characteristics of the drop shadow; see 
opposite.

Attribute Description

On Turns the drop shadow on.

X,Y Defines the drop shadow displacement, in pixels.

Opacity Specifies the drop shadow opacity.

Softness Allows you to blur the drop shadow.

Color Specifies the drop shadow color.

Attribute Description

Marker The image file used for the marker. Select an existing 
marker from the drop-down list, or click the+button 
to load a new marker.
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After defining a strap you can move the end of the pointer with the Text tool.

The following illustrations below show some examples of straps:

 Figure 4: Fill white and frame black, connector set to pointed border, and marker to image.

6.3.5 Texture CC panel

Allows you to color correct textures.

See Also
• Texture CC panel when Working with Maps

Opacity The opacity of the body of the strap.

Fill, Margin, Margin 
Height

The fill color, margin and margin height of the strap.

Frame The type, color, width, and opacity of the frame of 
the strap.

Connector The type, color, width and gap (to the marker) of the 
connector.

Drop Shadow Adds a drop shadow to the strap.
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6.4 Topography

The Topography panel allows you to add relief shading to give a three-
dimensional appearance to the map, and color the land and/or sea using natural 
colors.

To specify the topography
1. Select Relief Shading to apply relief shading to the land.
2. In the Land section select Land Styles, Relief Color, or Natural Earth to specify 

how the land should be colored.
• If Relief Color or Natural Earth is selected, you can blend in a proportion of 

the land style color using the Mix with Topography slider on the Styles Color 
panel.

3. In the Oceans section select Natural Sea and/or Contours to specify how the 
sea should be colored.

The options are illustrated in the following examples:
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 Figure 5: Land Styles, no Relief Shading and Relief Shading

 Figure 6: Relief Color and Ocean Contours, and Natural Earth and Natural Sea

The following sections give more information about each of these options:

• Shading Panel
• Relief Color Panel
• Natural Earth Panel
• Natural Sea Panel
• Ocean Contours Panel

6.4.1 Shading Panel

The Shading panel allows you to define the scale of the relief effect and the light 
direction for the relief:
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 Figure 7: With and without maximum detail

Maximum Detail relief rendering is selected by default, and gives improved 
sharpness and detail, especially when zoomed in very close. However, in some 
situations the Maximum Detail option can produce images with a noticeable grid 
pattern, in which case you may prefer to deselect it.

The Highlight Size and Highlight Brightness settings allow you to control the 
appearance of the relief texturing on your maps. 

The following illustrations give examples of the effect of each setting:

 Figure 8: Minimum highlight size, normal settings, and maximum highlight brightness

The Disable Imported DEM checkbox allows you to choose whether to use any 
DEM Relief data you have loaded in place of the built-in relief data.

6.4.2 Relief Color Panel

The Relief Color panel allows you to define the colors used for different terrain 
heights:

Click the appropriate Scale button to change the color gradient scale to show 
heights from 0 to 8000m, 0 to 800m, or 0 to 80m.
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To adjust the terrain height corresponding to a color, drag the dividing line next 
to the color square.

To change a color, click on the corresponding color square and a color chooser 
will be displayed. To add or remove colors, click on the color gradient with the 
right mouse button (PC), or while holding down Ctrl (Mac), and click Add Point or 
Delete Point on the context menu:

You can save a gradient, or load a gradient saved on a previous occasion, using 
the Save Gradient and Load Gradient options on the color gradient context menu.

6.4.3 Natural Earth Panel
The Natural Earth panel allows you to control natural earth land coloring, which 
shows the Earth with natural coloring determined from high resolution satellite 
imagery; for example, deserts are colored yellow, forests green, and ice caps 
white:

The Database option allows you to select different types of natural earth 
databases.

The Brightness, Contrast, Gamma, and Saturation controls allow you to adjust the 
appearance of the natural earth coloring. Tint Color and Tint Opacity allow you to 
add a tint, such as to simulate sunset coloring.

A Natural Earth style sheet is provided with natural earth and natural sea styles 
already set up.

Note: Natural Earth is an optional feature that requires a separate license; ask your 
local Vizrt representative for more details.
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6.4.4 Natural Sea Panel

The Database option allows you to select different types of natural sea databases 
(e.g. Digital Globe).

The Natural Sea panel allows you to control the appearance of the sea when 
colored with the Natural Sea option, which uses satellite imagery of shallow seas 
and reefs.

6.4.5 Ocean Contours Panel

The Ocean Contours panel allows you to define the ocean depths corresponding 
to each color.

The left ramp works in exactly the same way as the Relief Color ramp. The right 
scale shows how the color ramp will be applied to the ocean depth steps.

See Also
• Setting Map Features

6.5 Markers Panel
The Text panel allows you to choose a marker to identify each point feature, and 
the Strap panel allows you to choose a marker to be drawn alongside the label.

The Markers panel allows you to display and edit the available markers, and 
specify the scale and position of each marker.
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To load an image for use as a marker
• Click the + button and select the image file you want to load.

To edit the name of a marker
1. Select the marker in the Markers list.
2. Click the Rename... button.

To delete or replace a marker
1. Select the marker in the Markers list.
2. Click the X or Replace... button.

To edit a marker
1. Select the marker in the Markers list.

• The marker is displayed in the preview window to the right of the Markers 
list.

2. Specify the scale by editing the X, Y, Width, and Height fields, as required.
3. Select Fix aspect ratio to keep the aspect ratio fixed.
4. Click the + button and click on the preview window to set the origin for the 

marker.

6.6 Textures Panel
The Color panel allows you to choose a texture to color an area feature.
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The Textures panel allows you to display and edit the available textures.

To load an image for use as a texture
• Click the + button and select the image file you want to load.

To edit the name of a texture
1. Select the texture in the Textures list.
2. Click the Rename... button.

To delete or replace a texture
1. Select the texture in the Textures list.
2. Click the X or Replace... button.

To display a texture
• Select the texture in the Textures list.

• The texture is displayed in the preview window to the right of the Textures 
list.

6.7 Lighting Panel
Every style sheet can contain one or more lights, called style lights, which are 
used in addition to any lights you have added directly to an individual map layer. 
Since the lights are in the style sheet itself they will be applied to any map layer 
using the style sheet.

The Lighting panel allows you to define style lights, and specify their 
characteristics:
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You can use the Light tool on the Lighting panel to edit style lights in exactly the 
same way as lights within the layer.

See Also
• Lighting and Effects

6.8 Map Features Panel

The Map Features panel allows you to define the map and street data to be 
included in the map layer, and the scaling of road and rail features.

You can override these for a particular map layer using the Map Features dialog 
box; see the Setting Map Features section.

Global Map Data 
Allows you to specify which lakes, rivers, roads, and rail features are displayed by 
choosing the appropriate option from the corresponding drop-down menu. 

Local Street Data 
Allows you to specify which lakes, rivers, roads, and rail features are displayed in 
street data by choosing the appropriate options from the corresponding drop-
down menu. 

The Enable option allows you to specify whether or not street data will be 
displayed in the map layer. 
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The Street Data... button displays the Street Data Directory dialog box, and is 
equivalent to choosing Street Data… from the Import menu. 

For more information about working with street data see the Working with Street 
Maps section.

Scale roads/rail with map
Determines how roads and railways are scaled as the map is scaled.

The Scale Factor setting is used to scale all line features, such as road, rail, and 
rivers. You can adjust the value to achieve particular effects; for example, reduce 
it below 1.00 to make all line features thinner.

6.9 Options Panel

The Options panel allows you to control the land drop shadow, line widths, and 
the appearance of latitude and longitude lines.

• Land Drop Shadow: Allows you to specify whether land is displayed with a 
drop shadow, and whether a drop shadow is also displayed for lakes/wide 
rivers and/or narrow rivers.  Click the Settings… button to define the shadow.

• Border Widths: Allows you to specify the line widths for country, region, sub 
region, and coast outlines.

• River Widths: Allows you to control the width of lines used to draw rivers that 
are not wide enough to be drawn as area shapes.
• Master Scale affects the width of all rivers drawn as lines.
• Smaller Rivers Scale affects the width of rivers which are classified as minor 

rivers.
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• Max Width (Pixels) determines the maximum line width at which rivers will 
be drawn. This is useful if you wish to prevent rivers being drawn as very 
thick lines as a map zooms in.

• Lat/Long Settings: Allows you to control the appearance of the latitude and 
longitude lines, drawn in the Latitude/Longitude style.
• To draw lines on both land and sea, select Draw lines on land as well as sea. 

If unchecked, the lines are drawn on the sea only. 
• To prevent longitude lines from drawing at the poles, where they are very 

close together and eventually meet, select Prune longitude lines at poles. 

• To alter the spacing of the longitude and latitude lines, choose an option 
from the appropriate line spacing pop-up menu, or choose Custom and 
click the Customize Spacings… button to specify the spacing or number of 
divisions and origin explicitly:

• The color and width of the lines can be changed by choosing the Latitude/
Longitude style on the Styles panel.

6.10 Using Imported Relief Data
Viz World Classic allows you to import additional detailed relief data. A wide range 
of data is available directly from Vizrt and from third parties. Supported file 
formats include:

• CDM (Curious DEM) from Vizrt.
• Some types of DEM and SDTS from USGS, who provide data for most of the US 

and a number of other areas of the world.
• Some BIL images from Global Terrain.
• Some types of SRTM and DTED format data.

Please contact your local Vizrt representative for a full list of supported file 
formats and data products.

This section contains information on the following procedures:

• To import CDM relief data
• To import relief data
• To obtain DEM data
• To undo DEM imports
• To use multiple DEM databases
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To import CDM relief data
1. On the Import menu, select Curious CDM DEM Data ... .
2. Choose where the data is to be installed and click the Copy New Data… 

button.

For each set of CDM data you want to use you need to add a licence in the usual 
way. To show a list of the CDM data you have installed, and its license status, click 
the Check existing data for bad files or licences button.

To import relief data
1. On the Import menu, click DEM Digital Elevation Model... .

• The Import Digital Elevation Model dialog box is displayed

This shows the contents of the relief database, and allows you to add new files to 
the database.

The Import DEM... button allows you to import DEM files from external sources. 

You can undo the most recent imports using the Undo Imports button, or fit the 
map to the selected imports using the Fit Map To Imports button.

Because imported DEM data will not always match exactly with the data provided 
as standard with Viz World Classic, seams will sometimes be visible at the edges 
of imported data. To avoid this, you can animate the amount of imported relief to 
be used, so that the imported relief is only visible when zoomed in enough that 
no such edges are visible, using the Imported Relief Blend control in the Map 
Features dialog box; for more information see the Setting Map Features section.

To obtain DEM data
Because DEM data for the whole world would occupy literally thousands of 
gigabytes, the data usually comes in tiles. You will often need to obtain several 
such tiles to cover the area you require.

For information about obtaining DEM data contact your local Vizrt representative.

To undo DEM imports
Because of the sheer amount of data involved with DEM files, and the unfortunate 
fact that DEM tiles need not actually have straight sides, providing a facility for 
undoing imports requires significant amounts of disk space.

Viz World Classic allows you to choose how much disk space to be allocated for 
undo information in the Options dialog box. You can only undo the most recent 
imports from the bottom of the import list, and it may not even be possible to 
undo these if there was insufficient disk space to hold the required undo 
information.

To use multiple DEM databases
You can change the directory that Viz World Classic uses to store DEMs in the 
Options dialog box. Using several different directories allows you to have multiple 
DEM databases, each of which holds detailed relief data for a particular area. This 
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can be useful if you need high-resolution relief data for a particular project, but 
do not want to keep using that imported data in your normal day-to-day work. 
108 Chapter 6: Working with Styles



7 Reusing Design Elements
This section explains how you can easily reuse styles, layers, and colors which you 
have created in earlier projects. It also describes recommended techniques for 
setting up and sharing style sheets, templates, and projects between users.

This section contains information on the following topics:

• Introduction
• Importing from a Project
• Reusing Style Sheets
• Using Templates
• Reusing Design Elements
• Using Color Palettes
• Sharing Databases

7.1 Introduction
From the outset Viz World Classic has been designed to allow you to separate the 
design of the appearance and house style of your map animations from the 
creation of the individual maps themselves:

• You can import styles, presets, color palettes, or layers from another project, 
to allow you to use them in a new project.

• Style sheets record all the essential information describing how a map should 
look, and can be reused in different projects.

• Templates allow you to set up blank projects containing selected styles, 
layers, and settings ready to be used for the creation of new projects.

• User map details and alternate names databases allow you to standardize 
alternative spellings for place names and user added places.

Each of these features is a powerful tool for standardizing maps developed by a 
group of users, and they can be shared between users by saving them into a 
directory accessible by all users and machines.

7.2 Importing from a Project
The Project Import dialog box allows you to import styles, presets, colors or layers 
from another project.

To import from a project
1. On the Import menu, click From Project... .

• The Open dialog box allows you to select another project to import from:
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2. Select the project you want to use and click the Open button.
• The Project Import dialog box shows the reusable features in the project, 

and allows you to select which features you want to import:

3. Click the Styles, Presets, Colors, or Layers tab as appropriate and select the 
features you want to import. 

4. Hold down Shift to select multiple contiguous items, and Ctrl (PC) or 
Command (Mac) to select multiple non-contiguous items. 

5. Click the Load button to import the specified features into the current project.
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7.3 Reusing Style Sheets
Careful design of the styles you wish to use can greatly increase the speed at 
which high-quality maps can be created by a group of users. Users just need to 
select the correct style, and they can then create maps without having to be 
concerned with the design or appearance. 

A number of sample style sheets are included with the software. You can import 
these as described below.

To share a style sheet between projects and other users
Once you have designed a style sheet that you would like to use in other projects, 
or make available to other users, you can save it to disk as follows:

• Click the Export... button in the Styles Editor dialog box to save a copy of the 
style sheet in a shared directory.

Note: Each user can then import styles from the style sheet file using Import... in the 
Styles Editor.

7.4 Using Templates
When you create a new project you can choose to base it on a project template 
which defines the default styles, style sheets, color palettes, and predefined layers 
and settings to be included. You can save any project as a template file and then 
use it as the basis for new projects.

If you create a new project without selecting a template, a default project 
template is used. A simple default project template is supplied and automatically 
used by Viz World Classic, but you can create a new default template of your own, 
containing all the settings you want to use on a regular basis. 

This section contains information on the following procedures:

• To create a project template
• To specify a template as the starting point for a project
• To set the default project template
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• To share project templates

To create a project template
1. Create a new blank project.
2. Define or import all the styles, color palettes, Navigator presets, and layers 

you would like to have in the template.
3. On the File menu, click Save As... .

4. In the Save As dialog box choose Project Template from the Save as type (PC) 
or Format (Mac) drop-down menu.

5. Enter a name for the template and click the Save button.
• Opening the template will then create a new untitled project containing the 

contents of the project you saved, and you will be prompted to give it a new 
name when you save the file.

To specify a template as the starting point for a project
• Select Use a project template in the Welcome or New Project dialog box, and 

select the particular template you want to use.
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To set the default project template

1. On the View menu, click Options... .
2. Click the Template option to display the Template panel.
3. Click the Browse... button and select the appropriate template file.

• The default project template will be used whenever you create a new project 
by selecting Create map project in the Welcome or New Project dialog box.

To share project templates
• To share project templates put them into a shared directory. All users can then 

use the same styles, colors, Navigator presets and layers by default.

7.5 Reusing Design Elements
This section contains information on the following topics:

• Reuse of style sheets
• Reuse of layers
• Reuse of Navigator presets

Reuse of style sheets
Careful design of the styles you wish to use can greatly increase the speed at 
which high-quality maps can be created by a group of users. Users just need to 
select the correct style, and they can then create maps without having to be 
concerned with the design or appearance.

Reuse of layers
You can use templates to provide users with an initial set of layers for use in the 
maps they are creating. For example, if the users are creating maps, all of which 
contain the same logo and headline text, you could create a template containing 
the appropriate image and text layers.
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Reuse of Navigator presets
Templates include the Navigator presets, which are a quick way of defining a 
map’s position and scale. If you frequently use a small number of set map 
settings you can save these as a preset in a project template and make them 
available to all users

7.6 Using Color Palettes
Templates include color palettes, which are selections of user-defined colors in 
the Color dialog box:

You can create several palettes and select the one you want to use from the pop-
up menu above the palette.

This section contains information on the following procedures:

• To edit the color palette
• To select a color
• To pick a color from the Viewer
• To add the current color to the palette
• To delete a color from the palette
• To create a new palette
• To save or load palettes
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To edit the color palette

• Click the Edit Palette button in the Color dialog box.
• The full Color editor will be displayed (see above).

Tip: To cancel the operation / close the palette editor click Palette Only.

To select a color
Either:
• Click in the color space in the top left corner of the Color chooser.

Or:
• Click the color sliders in the top right corner of the Color chooser.

Or:
• Enter the color values in the fields to the right of each color slider.

You can change the color space displayed in the Color chooser by choosing an 
option from the pop-up menu.

You can change the values shown on the color sliders, and the range of each 
value, using the two pop-up menus below the color sliders.

To pick a color from the Viewer

1. Click the Pick Color  tool.
2. Click in the Viewer to select that color.

To add the current color to the palette

• Click the Add Color  button.

To delete a color from the palette
1. Click the color to select it.

2. Click the Remove Color  button.
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To create a new palette
• Click the New Palette button below the palette.

• The new palette will become the current palette.

To save or load palettes
• Use the Save Palette and Load Palette buttons.

• This is useful for exchanging palettes between different users, archiving 
them for future reuse, or copying them from one style sheet or project to 
another.

7.7 Sharing Databases
New features, defined using the Add New Label or Add New Feature dialog boxes, 
are stored in a user map details database; for more information see how To define 
a new feature on the map or how To define a new feature from the Explorer.

Alternate names, defined using the Properties panel on the Contents panel, are 
stored in the alternate names database; for more information see the Setting the 
Properties for Details section.

The user map details, alternate place names and abbreviations databases can be 
shared between users by placing them in a shared directory. This allows users to 
benefit from any user map details and new names added to the database.

This section contains information on the following procedure and topic:

• To share user map details, alternate place names
• Editing user map details or alternate place names

To share user map details, alternate place names
User map details and alternate place names are stored in text files, and can be 
shared among users by placing them in a shared directory. To modify the location 
of these files:

1. On the View menu, click Options... .
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2. In the Options dialog box select Shared in the Map Data section
3. Click the Browse... button and specify the new location for the appropriate file.

Editing user map details or alternate place names
You can edit the user map details, alternate place name and abbreviations files 
using a simple text editing application such as Notepad, Notepad++ or 
SimpleText. This can be useful if places or names have been added incorrectly 
and need to be deleted or modified. You can find the path and filename of each 
file as described above.
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8 Working with Street Maps
Viz World Classic allows you to import street data for towns and cities, to create 
maps from the whole world down to a single street corner or building. The Street 
Data format is supplied and configured with appropriate labels for each of the 
features, and so using it is simply a matter of adding it to your map. Viz World 
Classic also supports map data in ESRI Shape File format; for more information 
see the Working with ESRI Shape Files section.

This section contains information on the following topics:

• Using Street Data
• Loading Street Data
• Tracing Street Data

8.1 Using Street Data
A wide range of street data designed especially for use with Viz World Classic is 
available for most parts of the world from Vizrt.

See Also
• For more details, and to order, please contact your local Vizrt representative.

8.2 Loading Street Data
To use street data for a particular town or city you first need to install the street 
data into an appropriate directory on your disk, and then add a license for the 
data. For more information about adding a license see the Installing Viz World 
Classic section. 

This section contains information on the following procedures:

• To specify the location of street data
• To load street data
• To use street data
• To display the street data
• To highlight individual features
• To label a feature

To specify the location of street data
When you install street data it is copied to the Street Data location specified in the 
Options dialog box. This is initially set to a default location, but you can change it 
as follows:

1. On the View menu, click Options..., then click the Locations tab to display the 
Locations panel of the Options dialog box. 
• The Street Data field shows the directory used for street data files.
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2. Click the corresponding Browse... button and select the appropriate location 
to change the directory used for street data files. 

To load street data
• On the Import menu, click Street Data... . 

• The Street Data Management dialog box shows the street data sets you have 
available:

3. Click the Install More Data... button to install additional street data sets from 
disk or CD-ROM, or by scanning the street data directory for new data.
• The following dialog box is displayed:

Either:
• Select “Copy new data from some other directory or disk”, click the Choose 

Folder button, and locate the source of the new data.

Or:
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• Select “Scan the directory where Street Data is already installed ...” to 
automatically locate new data.

• Select the data set you want to load and click the Load Now button.

Tip: You can also select Always load at start-up to load the specified street data each 
time you run Viz World Classic. 

4. Repeat for any other street data sets you want to load. 
5. Click the Close button to close the dialog box. 

To use street data
1. Click the Streets tab in the map layer Contents panel to display the street data 

sets you have loaded. 
2. Select the street data set in the left list to show the features it contains:

3. Select which features you want to display from the pop-up menu below the 
features list. 
• This includes different road categories, railways, rivers and lakes, and a 

range of other urban features. 

To display the street data

• Click the street data set name with the right mouse button (PC), or while 
holding down Ctrl (Mac), and click Fit map on the pop-up menu: 
• The street data will be drawn, scaled to fit within the image window: 
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Note: The style sheet specified for the map layer determines which lakes, rivers, 
roads, and railways are drawn on the map. You can override this for the current map 
layer by clicking the Map Features button in the top right corner of the Contents 
panel.

To highlight individual features
You can add a feature to the Details list so you can modify its appearance, to 
highlight it on the map.

Either:
• Select the feature in the features list and click the Add Feature To Details 

button.

Or:
• Click the feature with the right mouse button (PC), or while holding down Ctrl 

(Mac), and click Add to map on the context menu: 

Area features, such as lakes and parks, are initially drawn with a label. Line 
features, such as roads and rivers, are initially drawn unlabeled. You can add a 
label at a specific position as described in the next section. 
Chapter 8: Working with Street Maps 121



To label a feature

1. Select the Browse Street/Shape Data tool
• As you move this over the map a tool-tip shows you the name of each street 

data feature: 

2. Click with the right mouse button (PC), or while holding down Ctrl (Mac), and 
choose the appropriate label option from the pop-up menu: 

• Add: Adds the feature without a label, so you can highlight it by editing its 
style. 

• Label: Adds the feature with the label positioned at the point you clicked. If 
you are labelling a line feature the label will be drawn aligned with the 
direction of the feature. 
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3. Use the Text tool to move or rotate the label as desired.

8.3 Tracing Street Data
You can use the shape tools to trace street data in order to add lines and area 
shapes to your street maps. 

For example, you could trace streets to draw a line shape showing the route of a 
carnival. Alternatively, you could trace an area of a city to create an area shape 
showing a proposed traffic-free zone. 

See Also
• To draw shapes by tracing map features
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9 Working with Images and Movies
This chapter explains how to work with and incorporate bitmap images and 
movies into animations, and describes the controls available for altering the 
appearance of imported images and movies, and controlling the way they are 
animated.

This section contains information on the following topics:

• Introduction
• Importing an Image or Movie
• Moving, Resizing, or Rotating an Image
• Specifying the Contents of the Image
• Using the Keyer
• Image Rotoscoping
• Setting the Image Properties

9.1 Introduction
Viz World Classic supports a wide range of alternative image and movie formats, 
summarized in the table below.

Note: Viz World Classic 64-bit version currently do not support movies added as 
layers.

Extension Format

.avi Video for Windows movie

.bmp Windows bitmap

.cin Kodak Cineon image

.cmr Curious Multi-Resolution bitmap image

.exr OpenEXR image

.dpx DPX image

.gif Graphic Interchange Format

.iff Alias/Wavefront Paint Image

.jpg or jp2 JPEG compressed image

.mov QuickTime movie

.ntf National Imagery Transmission Format

.sid MrSID multi-resolution image (PC only)

.psd Adobe Photoshop image (supports transparency)
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Curious Multi-Resolution format 
Viz World Classic provides the proprietary CMR (Curious Multi-Resolution) image 
format, which allows very large images to be included in maps without the 
memory overhead normally associated with images in the standard file formats. 
CMR formatted images can be used in any context where an image file can be 
specified, including in image layers and as textures for maps. For example, 
satellite images and high-resolution photographs can be used to fill a region of a 
map. When you zoom in close an appropriate high-resolution tile of the image 
will be loaded, avoiding the need to have the whole high-resolution image loaded 
at all times. 

An optional Convert Large Images tool allows you to convert an image into CMR 
format from any of the common file formats including Photoshop, TIFF, and BMP. 

Cineon files

Viz World Classic includes support for Cineon files, which use a logarithmic color 
space to provide a better representation of dark colors. Because Viz World Classic 
works in a linear color space, it allows you to specify how Cineon files are handled 
on loading and saving.

• On the View menu, click Options... .
• In the Preferences dialog box select Cineon in the File Formats section.

The following options are provided:
• No conversion: The images are left in logarithmic space, so loading them and 

saving them again makes no alteration to the pixel values in the files. You can 
use the Viewer LUT Controls option tocompensate for the darker appearance 
of Cineon files when working with them in the Viewer.

• Convert to/from linear: Converts Cineon files from the logarithmic color space 
to the linear color space on load, and back again on save. An allow headroom 
option varies the conversion so that overexposed images retain more detail in 
the very bright overexposed regions.

9.2 Importing an Image or Movie
This section contains information on the following topic and procedures:

• To import an image or movie
• To convert an image to a CMR format

.pct Macintosh PICT

.png Portable Network Graphics (supports transparency, paletted, 
grayscale, and true-color images)

.sgi or .rgb Silicon Graphics Image (supports transparency)

.tga Targa bitmap

.tif or .tiff Tiff bitmap format

.qtif QuickTime image
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• To convert multiple geo-referenced images to a single CMR image
• Using geo-referenced images
• To add geo-referenced images
• To add satellite images

To import an image or movie

1. On the Layer menu, point to Add Layer, and then click Image or Movie.
• The following dialog box allows you to select an image to import, and 

optionally preview it.

Note: Viz World Classic 64-bit version currently do not support movies added as 
layers

2. Select the image or movie file and click the Open button to import it.
• A new image layer will automatically be created for the imported image or 

movie. Note that each image or movie is contained in a separate layer.
• If you open a project that uses images, or movies, that are no longer 

available they are displayed as a red cross.
• If you import a movie the Match Time Range to Movie dialog box will 

appear. This will allow you to adjust the time slider’s range and/or the 
project’s frame size, rate and duration to match the clip you are importing.

• If they have moved you can use the Change Image... button on the Contents 
panel to locate them.
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To convert an image to a CMR format

1. On the Tools menu, click Convert Large Images... .
• The following dialog box allows you to specify the image to convert, and a 

filename for the CMR (Curious Multi-Res) image:

2. Browse for and select the input image to be converted. 
3. Browse for and select the location for the output image and specify a filename 

for the CMR image, which can be the same as the input image. 
4. Click the Convert button to convert the image to the CMR format. 

• You can then select the CMR image just as you would any other image in Viz 
World Classic.

• You can also make a compressed version in the following dialog box.

Note: The Convert Large Images tool makes a copy of the original image; it therefore 
requires at least as much available disk space as the size of the original image.
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To convert multiple geo-referenced images to a single CMR image

The Convert Multiple Images tool allows you to convert a number of adjacent 
geo-referenced images into a single large image, in CMR (Curious Multi-Res) 
format.

• On the Tools menu, click Convert Multiple Images.  The Combine & Adjust 
Multiple Images dialog box allows you to specify the input and output images.
• Intermediate Images: Allows you to specify where the intermediate CMR 

files should be stored, and whether they should be kept after the conversion 
is finished.

• Adjust, Tint: Provides color correction options to allow you to make the 
resulting CMR file match other images you are already using.

• Edging: Uses a soft edge when joining the individual tiles to obscure any 
seams that may arise.

• Key: Allows you to key out, or remove from the image, areas of a particular 
color with a specified tolerance. For example, this allows you to make the 
sea transparent in the finished CMR image by specifying blue as the key 
color.

Using geo-referenced images
Much satellite and aerial photography is now available in a geo-referenced 
format, which includes the precise location of the image on the Earth’s surface. 
Viz World Classic supports the following geo-referenced formats:

• GeoTiff – where the data is embedded in a TIFF file.
• Tiff World – where the data is in an accompanying text file.
• Geo-referenced MrSID.
• Geo-referenced NITF.
• ERDAS images.
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Vizrt can supply a wide range of high-resolution geo-referenced satellite images 
for use with Viz World Classic. For details contact your local Vizrt representative.

It is recommended that you convert large geo-referenced images to a CMR format 
before importing them; see how To convert multiple geo-referenced images to a 
single CMR image.

To add geo-referenced images
Either:

1. On the Layer menu, point to Add Layer, and then click Image or Movie.
2. Select the geo-referenced image file.

Note: Viz World Classic 64-bit version currently do not support movies added as 
layers

Or:
• Add the image as a texture to an existing style in the Styles Editor

The following dialog box allows you to pin the image to the correct location on 
the map:

• Click the Yes button to pin the image using the geo-reference information.
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To add satellite images

1. Select a map layer
2. Select the Contents tab and then the Overlays tab
3. Click the Add Satellite Image button
4. In the Image Manager click the + button to browse for and add your image/

CMR
5. Click the Add to map button
6. Close the Image Manager

Note: The imagery will not be a part of the base map (see Working with Maps).

9.3 Moving, Resizing, or Rotating an Image

The Move/Pan tool  allows you to move, scale, or rotate an imported image or 
movie.

This section contains information on the following topics:

• To move an image
• To resize an image
• To rotate an image
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To move an image

• Position the mouse pointer within the image and drag the image to the 
required position.

To resize an image

1. Move the mouse pointer to one of the eight handles on the corners or 
midpoints of the edges.

2. Drag to resize the image.
3. Hold down Ctrl (PC) or Alt (Mac) to constrain the image to its original aspect 

ratio.

To rotate an image

1. Point to the rotation handle, which is a yellow square to the right of the image 
center. The cursor changes to a rotation symbol.

2. Drag the handle to rotate the image about its center.
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9.4 Specifying the Contents of the Image

The Contents panel displays information about the image or movie, and provides 
options to allow you to change the contents.

This section contains information on the following topics:

• Controlling the image transparency
• To set the start time and looping

Controlling the image transparency
Images and movies used in an image layer may contain an alpha channel (or 
matte) which defines transparent areas of the image. You can specify how the 
alpha channel is interpreted to give greater control over the appearance of matted 
images. 

• Click the Alpha... button to display the Alpha Interpretation dialog box. 

By default Guess is selected, which automatically selects the best option in most 
situations. Choosing the correct option should produce an image without 
noticeable banding, fringes, or speckling around the edges.

You can choose one of the other options if Guess does not give the results you 
expect, or Ignore alpha to treat the image as if it had no transparency. 

The following illustrations show the effect of the options:
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 Figure 9: Correct (unmatted), incorrect (premultiplied) and alpha ignored

To set the start time and looping
1. Use the Hold frame options to specify what is displayed before the start time 

and after the end time.
2. Select Loop movie to play the movie in a loop.

• Auto: Loops the entire movie, between its start and end frames.
• Every: Allows you to specify the loop frequency.

3. Edit the Start at time value to determine the start time of a movie.

9.5 Using the Keyer

The Keyer creates a matte which is used to cut out the foreground from the 
background. Mattes created with the Keyer can be saved and reused in other 
projects or applications.

To key an image or movie
1. Click the Contents tab, to display the Contents panel for the image or movie.
2. Click the Keyer tab, to display the Keyer. 
3. Select Color, Chrominance, or Luminance to determine how keying is 

performed.
4. Select the Pick Background or Pick Foreground tool, and click appropriate 

parts on the image to add the corresponding colors to the range defined as 
background or foreground.

You can drag to define a rectangle to average the colors in the rectangle.

The sliders provide an alternative way of adjusting the components you have 
selected. 

Each slider has four handles:
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The white handles specify the range of colors treated as background, and the 
black handles specify the range of colors treated as foreground. Between each 
black handle and the corresponding white handle there is a smooth transition 
between foreground and background.
• Drag the Erode slider to reduce the size of the masked area, to hide edge 

effects, and add a softness to blur the edge of the image.
• Use the Suppress Amount and Suppress To controls to reduce the amount of 

the keyed color from the image.

This is useful for hiding reflections from the blue or green screen.

To view the effect of the Keyer
The paint controls to the right of the Keyer allow you to choose whether the 
Viewer shows the keyed image, Keyer matte, or both:

To render the Keyer matte

• Click the Render Matte... button in the paint controls.
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This is equivalent to the Render Matte... command on the Layer menu, and 
displays the Render Layer Matte dialog box to allow you to render the Keyer matte 
and/or the roto matte as a separate movie.

To cut out an image from a blue screen
The following example illustrates a typical application of the Keyer, to cut out a 
subject filmed against a blue-screen or green-screen background, so it can be 
superimposed on another background.

1. Load the image or movie into a new image or movie layer.
2. Click the Keyer tab to display the Keyer.
3. Click the Contents tab, to display the Contents panel for the image or movie. 
4. Select Color to key on a specified color range.
5. Select the Pick Background tool and drag to define a rectangle enclosing the 

blue-screen background:

 

When you release the mouse button the keyed image is displayed.

You can refine the keyed area by clicking or dragging with the Pick Background 
tool to increase the areas of background removed, or by clicking or dragging with 
the Pick Foreground tool to reduce the areas of background removed.

Alternatively you can adjust the key using the color, chrominance, or luminance 
sliders.

To remove the color cast
Subjects filmed against a blue-screen or green-screen typically have a blue or 
green cast. The Suppress option enables you to remove this.
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1. Drag the Suppress Amount slider until the cast is removed.
• Too high a value will introduce a contrasting cast.

2. Optionally change the Suppress To color to suit the replacement background.

You can then superimpose the subject onto an alternative background:

9.6 Image Rotoscoping

The Roto Matte panel on the Contents panel allows you to add one or more 
shapes to an image or movie layer to mask dynamically, tracking them as they 
move in successive frames. This is often referred to as a roto matte or rotoshape.

For more information about creating and editing shapes see Working with Shapes.
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To create an animated shape
1. Move to the first frame of the movie. 
2. Create one or more shapes using the shape tools to outline the feature in the 

movie that you want to process:
3. Move to the last frame in the movie, and adjust the shape so that it matches 

the feature.
4. Check the intermediate frames, and make any necessary adjustments to keep 

the shape tracking the feature.

To view the effect of the roto matte
• Select Apply Roto Matte.

• The roto matte will dynamically cut out the image to reveal the background:

• The paint controls to the right of the Roto Matte panel allow you to choose 
whether the Viewer shows the keyed image, roto matte, or both:

To render the roto matte
1. Click the Render Matte... button in the paint controls.

This is equivalent to the Render Matte... command on the Layer menu, and 
displays the Render Layer Matte dialog box to allow you to render the Keyer matte 
and/or the roto matte as a separate movie.
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9.7 Setting the Image Properties

The options on the Properties panel allow you to specify the compositing options 
for the image or movie, transform it, and add a drop shadow, frame, edging, or 
animation trail. It also provides several animation options.

This section contains information on the following topics:

• Compositing Options
• Transform Options
• Drop Shadow Options
• Frame Options
• Edging Options
• Trail Options 
• Instant Maps Export Options
• Automation Options
• Mask Options

9.7.1 Compositing Options

Blend Mode specifies how the layer is combined with the other layers, and can be 
one of.

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, 
Screen, Lighten Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, Overlay, 
Soft Light, Hard Light, Pin Light, Exclusion, or Negation.
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The Opacity determines the layer opacity, and can be animated.

Animating the opacity from 0% to 100% can be used to cause the image to fade in 
smoothly over a specified period of the animation.

See Also
• Controlling Layer Compositing

9.7.2 Transform Options

These options allow you to specify the position, scale, rotation, and origin 
numerically.
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The Set Using GPS button is used to position the image using UTM coordinates, 
which are normally supplied with aerial photographs and satellite imagery, or 
using latitude/longitude coordinates.

Latitude and longitude coordinates can either be entered in decimal degrees, such 
as 20.175, or in degrees, minutes and seconds, such as 20d10m30s.

For images provided by Global Terrain Inc., the Use Metafile... button will read the 
UTM coordinates directly from the metafile provided with the image.

The Pinned on Map, Wrap on Map, and Scale with Map options duplicate the 
options in the Map Usage section of the Properties panel; for more information 
see how To choose how the image moves relative to the map.

To change the origin of the image
The origin determines the point about which the image is rotated or scaled, and 
defaults to the center of the image.

Either:
• Edit the Origin values to specify the position in pixels relative to the lower left 

corner (south-west) of the image.

Or:
• Choose one of the predefined options from the Origin drop-down menu.
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9.7.3 Drop Shadow Options

Select Drop Shadow to turn on a drop shadow for the layer. The following 
parameters are provided:

The following example shows a drop shadow with offset X=3, Y=3, and 
Softness=2:

9.7.4 Frame Options

Allows you to add a colored fill, and/or border to the layer. Border Width specifies 
the width of the border in pixels.

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the 
range 0–5 are recommended.

Color The color of the drop shadow.
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9.7.5 Edging Options

The Edging options allow you to add a vignette to the image or movie.

• Choose Rectangle or Circle from the Type pop-up menu to vignette the image 
with a soft border of the corresponding shape.

• Use the Size control to adjust the size of the shape.

This option is especially useful when superimposing one image on another, to 
hide the edges of the top image.

The following example shows a circular vignette with a size of 100:

9.7.6 Trail Options 

The Trail options allow you to leave a trail as the image animates. For more 
information see the Leaving an Animation Trail section.
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9.7.7 Export Producer Options

Not longer supported.

9.7.8 Instant Maps Export Options

Allows you to make maps available to the Viz Curious Instant Map tool.

9.7.9 Automation Options
The Properties panel includes an Image Placement tool, to help align images 
accurately to positions on another image.

• Click the Image Placement tool in the Automation section of the Properties 
panel.

Two arrowhead controls are displayed in the Viewer to allow you to indicate the 
transformation you want.

• Position the circles on two appropriate points on the image.
• Position the arrowheads on the background to indicate where the points 

should be mapped to.
• Click the Apply button.

The image will be transformed to align the points on the image with the points on 
the background you have specified.

To choose how the image moves relative to the map
Viz World Classic provides several options that allows you to control how the 
image moves relative to the map layer.
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 Figure 10: Default position

By default the image position is independent of the map position.

 Figure 11: Pin on map

Pin on map keeps the image at the same latitude and longitude as the map 
moves.

 Figure 12: Wrap to map

Wrap on map projects the image onto the map, according to the map projection. 
Only available if Pin on map is selected.
144 Chapter 9: Working with Images and Movies



 Figure 13: Scale with map

Alternatively, Scale with map scales the image as the map is zoomed. Only 
available if Pin on map is selected.

These options are selected in the Map Usage section of the Properties panel.

See Also
• Auto Animate and the Automatically Animating a Layer section.
• Match rotation to path and how To align the image, text item, or drawing to 

the angle of the animation path

9.7.10 Mask Options
See Controlling Layer Compositing.
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10 Painting
This section explains how to use the paint and image processing tools on the 
Paint and Graphics panels to paint directly onto image/movie layers, for 
retouching or enhancing an existing image, masking areas of an image, or 
creating original freehand artwork.

This section contains information on the following topics:

• Paint and Image Processing Tools
• Painting Onto an Image

10.1 Paint and Image Processing Tools

Viz World Classic provides a wide range of paint and image processing tools 
divided into eight categories.

The  Paint panel provides a selection of options for each category of paint and 
image processing tools. You can select a category by clicking the icon to the left 
of the Viewer, or by clicking the corresponding tab on the Paint panel. The 
following table describes the functions available within each 
category of paint and image processing tools:

•  Brushes: Provides a selection of brushes to allow you to paint directly 
onto an image or movie, or its mask.

•  Graphics: Allows you to paint geometric shapes onto an image or movie, 
or its mask.

•  Shapes: Allows you to add drawings to the project by creating editable 
vector shapes.

•  Text: Allows you to add text to an image or movie, or to the mask.

•  Cutouts: Allows you to cut out part of an image to create a floating image 
overlay called a cutout.

•  Fx: Provides a range of paint effects for color correction, filtering, keying, 
or procedural effects.

•  Image: Provides image transformations.
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•  Mask: Provides a range of options for extracting a mask from an image 
based on the parameters of the image.

•  Macros: Allows you to record a series of actions, and then replay them on 
several frames in a movie or in different projects.

This section contains information on the following topics:
• Paint Controls
• Overlays
• Undo and Restore Options for Painting

10.1.1 Paint Controls
The paint controls, displayed to the right of each of the Paint panels, allow you to 
specify how operations using the brushes, shapes, and text affect the current 
image and its mask:

The mask can be used to protect the image from changes when painting on the 
image using the brushes or graphics tools, and sticking shapes or text on the 
image.

At any pixel where the mask is at full density, the image will not be affected by 
any operation. At pixels where the mask is completely transparent, operations are 
applied in full. Intermediate values result in a blend between the original image 
color and the changes. For further details see Specifying the Brush Settings.

To protect the image with the  mask
• Select Protect with mask.

To specify what is affected by painting operations
Painting operations can be applied either to the image or to the mask or to both 
simultaneously

• Select Paint Image and/or Paint Mask to affect the image and/or mask 
respectively.
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To specify whether the image and/or mask are displayed in the Viewer
1. Select Display Image and/or Display Mask to display the image and/or mask 

respectively.
2. Use the slider below the Display Mask checkbox to change the opacity of the 

mask displayed on the screen.

Note: This only affects the screen display, not the actual density of the stored mask.

To use  onion skinning
The Onion Skinning control allows you to reduce the displayed opacity of the 
foreground image in the Viewer to allow you to see the background while working 
on the foreground. A typical use is in wire removal when merging portions of a 
background image to replace unwanted elements in the foreground.

In Composite display mode the background is the composite of the other layers.

In the Single Layer display mode you can specify which layer to use as the 
background:

• Click the eye-dropper icon in the Layers list to indicate which layer you want 
to use as a background.

Selecting Invert allows you to invert the background, which is useful for 
highlighting the differences between two very similar frames.

Note: This only affects the display, not the stored image.

To fill or clear the image or mask, or invert the mask
The Fill Image and Fill Mask buttons allow you to fill the image or mask with a 
solid color. You can set the fill color by selecting a color and then clicking in the 
square to the right of the Fill Image or Fill Mask button.

The Clear Image and Clear Mask buttons clear the image or mask to transparent, 
and the Invert Mask button inverts the mask level at each point.

10.1.2 Overlays
The Shapes, Text, and Cutouts panels on the Paint panel allow you to create 
overlays as an intermediate step in constructing artwork. They are available to any 
of the image and movie layers in your project, and at any stage you can paint 
them onto an image or its mask; this is called sticking the overlays.
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For more information about creating shape overlays see Working with Shapes.

To show or hide an overlay
• Click the eye icon to the left of the shape name in the Overlay list.

The icon changes to show whether the shape is hidden:
•  Shown
•  Hidden

To rename an overlay 
1. Click the Rename... button below the Overlay list
2. Enter a name for the overlay and click the OK button:

To change the order of shapes in the Overlay list 
Either:
1. Select the overlay you want to move
2. Click the up or down button below the Overlay list

Or:
• Click the overlay you want to move with the right mouse button (PC), or while 

holding down Ctrl (Mac), and select one of the Ordering options from the 
appearing context menu.

Or:
• Drag the shape to the new position in the Overlay list

To delete an overlay
Either:
• Select the overlay you want to delete and press the Backspace button
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Or:
• Click the overlay you want to delete with the right mouse button (PC), or while 

holding down the Ctrl (Mac) button, and click Remove from the appearing 
context menu

To copy an overlay
You can cut, copy, and paste Overlays between layers or between projects.

You can also export one or more shapes, and then import them into another layer 
or another project, using the Export... and Import... options from the Overlay 
list’s context menu.

10.1.3 Undo and Restore Options for Painting

Viz World Classic allows you to undo brush strokes while painting, and you can 
also restore the image or its mask to the last saved version or to the original 
frame. 

To restore the image or mask
• On the Layer menu, click Restore Image or Restore Mask, then click To Last 

Saved or To Original Frame on the submenu

To select the paint undo options
By default, Viz World Classic allows you to undo each brush stroke while painting, 
to a limited undo depth, to minimize the amount of work you need to redo in the 
case of a mistake. However this level of undo control is memory intensive, and 
may cause noticeable delays when painting complex images.

Viz World Classic therefore gives you the option of reducing the degree of undo 
control for greater performance.

• On the View menu, click Options...
• In the Preferences dialog box select Undo in the Paint section

The Undo drop-down menu lets you specify the degree of undo control provided. 
The options are explained as follows:

• Every Stroke: Undo affects the previous painted stroke.
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• Similar Strokes: Undo affects all strokes made with the same brush and color 
settings.

• Explicit: A Backup for Undo button appears in the paint controls, and Viz 
World Classic stores a snapshot of the painting each time you click it. 
Selecting Undo restores the previous snapshot. 

The Memory setting allows you to allocate more memory to undo, which will allow 
you to increase performance if you have sufficient memory available on your 
computer.

10.2 Painting Onto an Image

The brushes on the Brushes panel allow you to paint directly onto an image or 
movie layer. You can paint onto the image, mask, or simultaneously onto both. 
Alternatively you can protect the image with the mask while you are painting onto 
the image.

In the case of a movie, painting affects the current frame of the movie, and the 
mask associated with the current frame, only. Painting can be applied 
automatically to multiple frames of a movie by recording and playing back a 
macro; see Automating with Macros.

A brush applies color, an image, or a filter directly onto the image or movie 
through a profile, which defines its shape.

To paint the image or mask

1. Select the Paint brushes tool
• This tool is automatically selected when you display the Brushes panel.

2. Select the brush you want to use in the Brush list
3. Select a color for painting from the palette on the right of the Brushes panel

4. Click on the image and drag to paint:
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You can adjust the opacity of the paint with the Opacity slider. If you are using a 
pressure-sensitive input device, such as a tablet, the brush strokes will respond 
to the pressure of your pen.

To choose how the  mouse cursor is displayed while painting

You can choose to hide the mouse cursor while painting, or display a colored 
circle or ellipse indicating the size of the brush:

  

The images above depicts a normal cursor, hidden cursor and outlined cursor.

1. On the View menu, select Options...
2. In the Preferences dialog box select Brush Display in the Paint section:

You can set separate options for the Clone brush.

You can also turn the outline on or off, and specify its color, by clicking the 
buttons on the Brushes panel:

10.2.1 Specifying the Brush Settings
The Profile, Size, Opacity, and Settings will be set to default values specified for 
the brush, but you can adjust them in the controls to the right of the Brush list.
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To define the brush profile
The brush profile defines the shape of the brush stamp. It is either a circle or an 
ellipse, with a falloff defined by a graph, or an arbitrary shaped cutout.

There are also the special options: Texture, which creates a brush with a random 
fill pattern, and OnePixel, a one pixel solid brush.

•  Select a profile from the Profile list. 

This gives a list of profiles defined in the Brush Editor. You can define new 
profiles; for more information see Defining Brush Profiles.

To define the brush size

Either:
• Drag the Size slider.

Or:
• Enter the size in the Size box:

Or:
• Hold down Ctrl (PC) or Alt (Mac) and drag in the Viewer, or in the brush 

preview on the Brushes panel, to draw a circle defining the brush size.

To define an offset
Brushes that take paint from the image or background, such as the Clone and 
Drag brushes, allow you to define an offset.

Either:

• In the Clone Offset section enter appropriate values in the X and Y fields:

Or:
1. Hold down Shift and drag in the Viewer to draw a line from the source to the 

destination to define the offset interactively.
2. Click the Reset button to reset the offset to zero.

To define the background transformation 
Brushes that take paint from the background, such as the Merge brush, allow you 
to transform the background before using it for painting.

1. Set the Display option to Single Layer.
2. Select the image layer from the Layers list
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3. Click the image layer’s eye-dropper icon

4. Click the Background Transformation Tool button in the Background Offset 
section to display an outline of the background image in the Viewer with 
handles so you can move, scale, or rotate it:

Once you have transformed the background close the Edit Merge Transformation 
to continue painting. You can store up to four transformations by clicking one of 
the > buttons and restore the transformation by clicking the 1, 2, 3, or 4 button.

To reset the transformation click the Reset button.

To define other brush settings
• Click the Settings... button to display more advanced settings for the brush:

The brush settings are described in greater detail in the later sections of this 
chapter.

To reset the brush settings to their defaults

•  Click the Restore Defaults button.

 Built-in brushes

The following pre-defined brushes supplied with Viz World Classic: 

• Color: Paints in a selected color.
• Clone: Picks up paint from one area of the image and paints it to another 

position on the image, as defined by the offset.
• Merge: Copies paint from a background image on to the current image.
• Drag: Drags paint on the image, causing a smudge effect.
• Repair: Picks up color from the image and paints with it; useful for painting 

over scratches and blemishes in an image. 
• Eraser: Erases pixels from the image, making them transparent. Equivalent to 

painting with the non-color.
• Chalk: Paints with a textured brush.
• Blur: Blurs the image.
• Oil Effect: Creates the effect of layered color in an oil painting.
• Posterise: Similar to Oil Effect, but more severe. 
• Smooth: Similar to Blur but more dramatic.
• Marble: Mixes up the pixels giving a marbling effect.
• Black And White: Convert pixels to monochrome.
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To use the  Clone brush
1. Hold down Shift and drag in the Viewer to draw a line from the source point to 

the destination point:

• The X Offset and Y Offset fi elds will be set to the appropriate values.

2. Paint to create a clone of the image:

To use the  Merge brush
The Merge brush allows you to copy paint from a background image onto the 
current image. For example, it can be used to paint out unwanted features of a 
scene by using a photograph of the background from the same position, called a 
clean plate.

1. Load the background image onto one layer:

2. Load the foreground image onto the current layer.
3. Set the Display option to Single Layer.
4. Click the eye-dropper icon in the Layers list to indicate which layer you want 

to merge from
5. Use the Onion Skinning control in the paint controls to reduce the opacity of 

the foreground, if desired:

6. Use the Merge brush to paint the background over the unwanted feature:
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The Merge brush also allows you to scale or rotate the background image you are 
merging from.

7. Click the Background Transformation Tool button to transform the 
background.

8. Click the Reset button to reset the background to the original scale and 
position.

To protect artwork with a mask
1. You can use a mask to protect parts of an image while painting.

For example, you could use a mask to protect the butterfly in the following image 
while painting over its shadow:

2. Create the mask by using a brush tool.

Alternatively you could mask the butterfly by drawing shape overlays and then 
sticking them onto the mask; for more information about creating shape overlays 
see Working with Shapes:

3. Set the paint controls to Protect with mask, Paint Image, and Display Image:
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4. Paint the image as required; for example, use the Clone brush to paint over 
the shadow on the leaf by copying texture from the other side of the leaf:

5. Deselect Display Mask to show the final result:

10.2.2 Creating and Editing Brushes

Viz World Classic is supplied with a range of pre-defined brushes. You can edit 
some aspects of these brushes, or you can create your own completely editable 
brushes using the Brush Editor.
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A Brush Test window allows you to try out the effect of the brush you are 
designing as you edit its parameters.

How brushes work
Brushes work by performing the sequence of operations:

Pickup > Filter > Stamp

These steps can be customized to determine the precise behavior of the brush, 
and are explained in greater detail in the following sections:

Pickup
The brush picks up paint from the specified source, which can be the current 
color defined in the Color Chooser, the image or background, or an image cutout.

When picking up paint from the image or background, an offset can be added to 
the current brush position to clone one part of the image to another part.

The paint is picked up through the selected profile, which determines the size of 
the brush, and the softness of its edges.

Filter
The paint is optionally filtered by a specified filter, such as to add noise or soften 
the image.

Stamp
The paint is stamped onto the image according to the decay and spacing 
parameters. If Protect with mask is selected, painting takes into account the 
density of the mask.

To display the Brush Editor

Either:
• On the Tools menu, click Brush Editor.

Or:
• Click the Editor... button on the Brushes panel.

The Brushes list shows a list of the currently loaded brushes. Selecting any brush 
in the list shows its definition on the Source, Profiles, and Filters panels and 
allows you to edit it.

To create a new brush
1. Select the brush in the Brushes list that you want to basethe new brush on.
2. Click the + button.

The new brush appears under the User heading and by default has Copy 
appended to its name, but you can rename it using the Rename... button below 
the Brushes list.
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To assign keyboard shortcut to a brush
You can assign up to 10 keyboard shortcuts to the brushes you use most 
frequently so that you can select them with a single keypress.

1. On the View menu, click Options... .
2. In the Options dialog box select Shortcuts in the Keyboard section.
3. In the Paint section of the Keyboard Shortcuts list select one of the entries 

labelled Brush Named, enter the name of the brush in the Brush field, and 
enter the keyboard shortcut you want to use or click the Type Key... button 
and press the key combination on the keyboard:

If you assigned a keyboard shortcut to a brush it is displayed on the bottom line 
of the Brush Editor window.

To test a brush
• While you are editing a brush in the Brush Editor you can test it in the Viewer, 

or in the Brush Test window.

To display the Brush Test window:
• Click the Brush Test button in the bottom right corner of the Brush Editor.

The Brush Test window will be displayed. This includes a palette editor, to allow 
you to change the color of the brush, and controls to clear or change the image 
displayed in the brush test window:
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To hide the brush test window:
• Click the Brush Test button again.

To save a brush
1. Click the Export... button below the Brushes list.

• The following dialog box allows you to browse a place to export the brush 
file to and name the brush file:
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2. Enter a suitable name for it and click the Save button.

To load a brush
1. Click the Import... button below the Brushes list.

• The following dialog box allows you to select the brush file to import:

2. Select the brush file and click the Open button.
• The brush will be added to the list of brushes in the Brushes list.
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10.2.3 Defining the Brush Source

The options on the Source panel in the Brush Editor allow you to define the source 
of color for the brush, and associated options.

To define the paint source
• Specify the source for the paint by choosing an option from the Source pop-up 

menu.

The options are explained in the following table:

• Color: The brush paints in the currently selected color.
• Clone: The brush takes the color from the image being painted. Useful in 

conjunction with an offset for cloning one part of the image to another part.
• Background: The brush takes color from the composite background 

(Composite mode), or specified background layer (Single layer mode). Useful 
for copying from one image onto another image.

• Image File: The brush paints with an image loaded from disk. Useful for 
painting with copies of a small image; eg leaves.

• Image Center: Colors the whole brush with the color at the center of the stamp
• Eraser: Makes pixels transparent by painting on the alpha channel.
• Image: Takes color from the image 

The Image and Background Source options allow you to define an offset in the X 
Offset and Y Offset fields. This allows you to pick paint up from one position on 
the image or background and paint it in another position.

To define the brush profile
• Choose an option from the Profile pop-up menu.

The profile determines how the paint fades away from the center of the brush to 
the edge of the brush, as defined by the Size parameter.

You can define new profiles using the Profiles tab of the Brush Editor.

To specify the image pickup
You can specify how the image is picked up by the brush
using the Pickup options:

• Normal: The image is picked up before each stamp.
• Once: The brush is loaded once on the first stamp.
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• After Stamp: The image is picked up after the previous stamp.

To define the opacity and decay
The Opacity and Decay define the density of the paint stamped by the brush, and 
the rate at which it decays as you drag. A Decay of 0 gives a brush that never dries 
out; larger values dry out faster.

To define the mode
The Mode pop-up menu allows you to specify how the paint is combined with the 
image; it provides the same options as the Blend Mode compositing option for 
layers.

To define the spacing
The Spacing determines the spacing between brush stamps as a percentage of 
stamp size. A large Spacing will give visible gaps between stamps. A small 
Spacing will give a smooth stroke.

Choose Fixed from the pop-up menu to make the spacing independent of your 
stroke speed, Constant Density to increase the spacing as you drag faster, and 
Maximum Detail to ignore the spacing and paint with full detail.

To paint with an image
Any image file, preferably with an alpha channel, can be used as a brush; for 
example:

1. Choose Image File from the Source context menu.
2. Click the Browse... button and select the image file you want to use.
3. Select Match Path to automatically rotate the image to match the angle of your 

stroke.
4. Set the Spacing to an appropriate value to determine the distance between 

stamps. Choose Fixed for a fixed spacing irrespective of your speed of stroke:

5. Drag the brush to paint with the image you have loaded:
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Use the Jitter filter to add variations to each stamp.

To load a cutout for use as a brush or profile
You can use a cutout as a brush; this works in exactly the same way as painting 
with an image.

Alternatively you can use a cutout as the profile for painting; the cutout defines 
the outline of the brush.

1. On the Cutouts panel click the Layout tab to display the Layout panel.
2. Select the cutout you want to use in the Overlay list. 

• For more information about creating a cutout see Working with Cutouts.

3. Click the Use for Brush or Use for Profile button:

Use for Brush saves the cutout as a TIFF image which you can load in using the 
Image File option in the Brush Editor.

Use for Profile saves the alpha channel of the cutout as an image file which you 
can load in using the Create from Image button in the Profiles panel of the Brush 
Editor.
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10.2.4 Defining Brush Filter Effects
The options on the Filters panel allow you to create brushes that selectively color 
correct, filter, or add an effect to the image as you paint:

The filters are divided into the following categories:

• Blurs: Soften or blur the image. 
• Color Correctors: Allow you to do local color correction to parts of an image.
• Distort: Apply marble, jitter, or turbulence effects to the image.
• Effects: Provide image effects, including noise and emboss.
• Filters: Process the image according to the values of the pixels.
• Multiple: effects are applied in the order they are specified in the list. To 

change the order:

• Select an effect, and click the Up or Down arrow buttons to change its position 
in the list.

To create a brush that applies a filter
1. On the Source panel, set the Source to Image, the X Offset and Y Offset to 0 

and the Pickup to Normal.
2. On the Filters panel, add the effects you want to include in the brush, and for 

each effect set the parameters.

10.2.5 Defining Brush Profiles
The Brush Editor Profiles panel allows you to define a number of preset profiles, 
and then select these when you are using or defining a brush:

The profile determines how the paint dies away from the center of the brush to 
the edge of the brush, as defined by the brush size parameter.

The horizontal axis defines the radius of the brush (center on the right), and the 
vertical axis is the opacity of the brush stamp.
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The following table shows some sample profiles together with the corresponding 
spread of paint they create:

Description Profile Effect

Linear

Soft

Solid
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The Create from Image... button allows you to load in an image and use its alpha 
channel as the profile.

You can also create a profile from a cutout; for more information see Moving and 
Transforming Cutouts.

To create a new profile
1. Click the + button below the Profiles list.
2. Edit the profile curve as required.

The profile you have defined will be displayed in the Profile list on the Brushes 
panel, and the Profile pop-up menu on the Brush Editor Source panel. 

To adjust the profile graph
1. Drag the point from the profile curve.
2. Click on the curve to add a new point to the curve.
3. Hold down Ctrl (PC) or Alt (Mac) and drag to extend tangent handles from a 

point on the curve.
4. Hold down Ctrl (PC) or Alt (Mac) to adjust one tangent handle independently of 

the other one. 

To rename a profile
1. Select the profile in the Profiles list.
2. Click the Rename... button.

10.2.6 Managing Painted Materials
Working on a project often involves importing a number of images or movies and 
then making changes to the images, or to one or more frames in the movies, 
before rendering out a composite of the resulting project.

Changes you make to images or movies never affect the original source materials. 
Instead, a copy of every image is saved, and every modified movie frame, in a 

Neon

Description Profile Effect
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painted materials folder on your hard disk. Actions that cause painted materials 
to be saved include: painting on an image or its mask using the tools on the 
Brushes panel, drawing shapes using the tools on the Graphics panel, sticking 
shapes, text, or cutouts from the Overlay list, and applying image effects
from the Image panel.

You can conform an image or movie layer, or its mask, to incorporate all the 
changes painted onto that layer and create a new image or movie that reflects 
those changes. You can then incorporate the conformed image or movie, or the 
mask, into another project without requiring the saved painted materials.

You can also export, as an image sequence, just those frames of a layer that have 
been painted on. By default painted materials are stored in a PaintedMaterial 
folder, but you can change this to any desired location.

To conform an image or movie layer
Viz World Classic never changes original files on disk as they are painted. You can 
conform a layer to produce a new complete movie or sequence incorporating all 
the painted frames. The layer is then updated to use the conformed material.

1. Select the layer you want to conform.
2. On the Layer menu, click Conform Layer... .

• A warning confirms the Conform Layer... action.

3. Click the OK button to continue.
• The Conform Layer dialog box then allows you to give a name to the movie 

and specify the format:

4. Check Render RGBA (Millions of Colors+) if supported by format to include the 
alpha channel in the conformed layer.

5. Click the Render button to render the layer.
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The movie layer will be updated to use the new conformed movie, eliminating the 
need for the painted materials.

To conform a mask
You can also conform the paint mask of an image or movie layer to create a movie 
or sequence on disk containing the paint masks for the layer. The mask is output 
at the size of the original material for the layer, without transformations or filters 
applied to the layer.

1. Select the layer whose paint mask you want to conform.
2. On the Layer menu, click Conform Mask... .

A warning confirms the Conform Mask... action.

3. Click the OK button to continue.
4. Proceed as described for conforming a layer.

To export the painted frames from a layer or its mask
1. On the Layer menu, click Export Painted Frames... or Export Painted Masks... .

The Export Painted Frames dialog box then allows you to specify the filename for 
the image sequence, and the file format:

2. In the Render Range section specify the range of the project that you want to 
render.

3. Click the Render button to continue.

An image will be created for each of the painted frames, numbered with the frame 
number.
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To specify the location of the painted material
1. On the View menu, click Options... .
2. In the Preferences dialog box select Material in the Paint section.

This allows you to change the location of the PaintedMaterial folder, and allows 
you to display the Painted Material Manager by clicking the Manage painted 
Material... button:

To display the painted materials
The Painted Material Manager displays all the material saved for the different 
projects you have worked on, and allows you to delete material you no longer 
need. It also allows you to rescue material, in the event that the original project 
has been accidently deleted.

• On the View menu, click Paint Material Management... :

The Projects list displays a list of the projects with saved painted material.

To display the materials for a project
• Select the project name in the Projects list. 

The Painted Material Manager will show the full pathname of the project file, 
together with a list of the painted materials used by the project. Material that is no 
longer referenced by a layer in the project is drawn in red to indicate that it is in 
the trash.

To delete specific material
• Select the material in the Painted material list and click the Delete Selected 

button.

To rescue material from a lost project
If a project file is lost the material it referenced will not be available until it has 
been copied into a new project.
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• Select the material in the Painted material list and click the Rescue Selected 
button.

The original source material and any painted frames will be copied into the 
current project. 

To remove material from a project that is no longer referenced by a layer
• Click the Empty Trash button.

To delete all the material in a project
• Click the Delete All button.

You will not be allowed to delete material in use by the current project.

WARNING! Do not delete materials in any project you still need, or you will 
not be able to load the project in its last saved version.

10.3 Adding Graphics to Images

The Graphics panel allows you to draw simple geometric shapes directly onto an 
image, or a frame of a movie. These tools provide a convenient way of creating a 
solid area of color in an image or a simple mask, where you do not need the 
flexibility and editability provided by the options on the Shapes panel.

Like the tools on the Brushes panel, the tools on the Graphics panel affect the 
image immediately, without needing to be stuck to the image. If you want to 
create editable shape overlays use the options on the Shapes panel instead.

To draw a quick shape
1. Use the paint controls to specify whether the shape is drawn into the image 

and/or mask, and whether it is protected by the mask.
2. Use the Color Chooser to specify the shape color. 
3. Select the Circle, Ellipse, or Rectangle tool in the Quick Shapes section:
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4. Drag to draw the shape.
• You can hold down Ctrl (PC) or Alt (Mac) to constrain the shape to a circle or 

square respectively.

5. Release the mouse button to draw the shape.

To define the drop shadow
1. Click the ellipse (...) button to the right of the Drop Shadow checkbox.

• The following dialog box allows you to define the drop shadow:

Note: This only affects shapes you subsequently draw.

To flood fill areas of the image or mask
The Flood Fill tools allow you to fill a contiguous area of pixels with the current 
color:
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1. Use the Color Chooser to specify the color to fill with.

The tools are described as follows:
• Flood Fill: Flood fills areas of uniform color in the image.
• Fill to Color: Flood fills the image up to the color specified by the Fill to Color 

box.
• Magic Wand: Flood fills the paint mask based on areas of uniform color in the 

image.

After selecting the appropriate tool:
2. Click on a color to start filling from that color.
3. Move the Tolerance slider to the right to flood a larger range of colors around 

the color you first clicked on.
4. Select Antialias to blur the edges of the filled area.

With the Magic Wand tool you can click additional areas to add to the mask, or 
click with Shift to remove areas from the mask.

The Magic Wand tool is particularly useful for making cutouts; see Creating 
Cutouts.

10.3.1 Transforming Images

The options on the Image panel on the Paint panel allow you to transform an 
image or movie. The Roll operation is designed to assist in creating textures that 
tile seamlessly.

To flip the image about a vertical or horizontal axis
• Click the Flip Vertical or Flip Horizontal button.
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To create a seamlessly tiling image
The following example shows how to create a seamlessly tiling texture from an 
image.
1. Load the image into a new layer:

2. Click the Roll button.
• This exchanges opposite quadrants of the image:

3. Use the painting tools, such as Blur and Clone, to make the joins look invisi-
ble:

4. Click the Roll button again to create the image:
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• This image can then be used to tile seamlessly, without any visible joins:
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11 Adding Image Effects
Viz World Classic provides a wide range of image effects, including color 
correctors, filters, and procedural effects. You can apply effects to any layer using 
the options on the Layer Fx panel, and these effects can be animated. 
Alternatively, the Fx options on the Paint panel allow you to apply fixed paint 
effects to an image or movie layer.

This section contains information on the following topics:

• Adding Image Effects to a Layer
• Adding Paint Effects
• Image Effects

11.1 Adding Image Effects to a Layer

To apply one or more image effects to a layer
1. Select the layer.
2. Click the Layer Fx tab to display the Layer Fx panel for the layer.

Every parameter of an effect can be animated. For more information see Using the 
Keybars Panel.

To add an effect to a layer
1. Click the arrow symbol to the left of a heading in the effects list to expand the 

list, and show the effects under that heading.
2. Select the filter and click the > button to add it to the right-hand list of effects 

to be applied to the layer.

Each effect displays a set of controls to allow you to adjust its parameters.

To determine the order in which the effects are applied
The order of effects in the list determines the order in which they are applied.

• Select an effect in the right-hand list and click the up or down arrow buttons 
to move it up or down in the list.
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11.2 Adding Paint Effects

To preview a paint effect
1. Click the Fx tab on the Paint panel to display the paint effects. 
2. Select the effect in the list.

Each paint effect displays a set of controls to allow you to adjust its parameters, 
and these are displayed to the right of the effects list.

The effect is previewed in the Viewer as you change the parameters.

To apply the paint effect permanently to the image layer
• Click the Apply button.

To apply one or more paint effects to every frame of a movie you can record a 
macro; see Automating with Macros.

To restore the image to its previous state
• Click the Cancel button.

To reset the paint effect parameters to their default settings
• Click the Reset button.

11.3 Image Effects
The image effects are divided into the following sections:

Backgrounds
Provides options for creating textured and patterned background images such as 
gradients or clouds.

Blurs
Allows you to blur or soften an image.

Color Correctors
Provides controls for adjusting the color balance of the image, adding/subtracting 
colors, or correcting the image in any of the alternative color models.
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Distort
Provides options for transforming or distorting an image.

Effects
Provides artistic effects including emboss, crystallize, motion blur, ripple, 
solarize, and stained glass.

Filters
Provides image effects such as edge detection, erode, and threshold.

Grain
Provides filters for removing or simulating film grain.

Sharpen
Provides options for sharpening images.

Transition
Provides wipes which can be animated to give a transition between two images or 
movies.

Video
Provides filters for broadcast video use.

Adobe After Effects plug-ins
If you have Adobe After Effects-compatible plug-ins installed on your system, 
some of these can be used and will be listed in the effects list.

For details on which plug-ins can be used with Viz World Classic please contact 
your local Vizrt representative.
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12 Extracting Masks
This chapter describes the options in Viz World Classic for extracting a mask 
automatically from an image based on its colors. With certain images, where the 
foreground is very distinct from the background, this can provide an extremely 
quick way of creating a finished mask. With more difficult material it can often 
provide a useful starting point for painting a mask manually.

This section contains information on the following topics:

• Introduction
• Mask Extract Tools

12.1 Introduction

The mask extract tools are provided on the Mask panel on the Paint panel. Each 
tool includes its own set of controls to allow you to adjust its parameters, and 
these are displayed to the right of the mask extract tools list.

To extract a mask
The following image contains yellow poppies against a predominately blue 
background, and so is an ideal candidate for extracting a mask:

1. Select Component Extract, and choose Yellow from the Component drop-
down menu to mask yellow areas of the image

2. Adjust the LUT graph to achieve an optimum mask:
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The masked areas will be displayed in the mask color:

• Click the Apply button to apply the mask permanently.

See Also
• Painting

12.2 Mask Extract Tools

Component Extract
Extracts a mask based on the level of a specified component: Red, Green, Blue, 
Cyan, Magenta, Yellow, Alpha, or Max:

Luma Extract
Extracts a mask based on the luminance value of each pixel. The graph allows you 
to define the mapping between the luminance value and the output mask value.

Chroma Extract
Extracts a mask based on the minimum and maximum chroma levels.
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Foreground Extract
Extracts a mask based on the predominance of the chosen component, red, 
green, or blue, in the foreground. The graph allows you to define the mapping 
between the raw values extracted and the output mask value.

Background Extract
Extracts a mask based on the predominance of the chosen component, red, 
green, or blue, in the background. The graph allows you to define the mapping 
between the raw values extracted and the output mask value.

Color Extract
Extracts a mask based on a specified color level.

Hue Extract
Extracts a mask based on the proximity of the color at each pixel to a specified 
source color:
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13 Automating with Macros
Macros provide a convenient way of recording actions, such as painting or image 
processing, and then applying them to several frames of a movie. They also allow 
you to repeat the same sequence of actions in a series of different projects.

This section contains information on the following topics:

• Using Macros

13.1 Using Macros

Macros allow you to record any of the painting or image manipulation actions, 
including painting with brushes, and then replay them on another image or each 
frame of a movie.

Features of the movie that should not be affected can first be masked using 
rotosplines. 

To record a macro
The following example illustrates recording a macro, applying an image 
processing operation to one frame of the movie, and then replaying it on all 
frames.

1. Select Protect with mask in the paint controls, to use the mask to protect the 
image.

2. On the Macros panel click the Start Recording button.
• The panel displays RECORDING.

3. On the Image panel select the image processing function, such as Black and 
White, and click the Apply button.
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• The current frame will be converted to black and white outside the masked 
area:

4. On the Macros panel click the Stop Recording button.

To replay a macro
1. Click the Play On Range... button.

• The following dialog box allows you to specify which frames are affected:

2. Select Part of Project, enter the range omitting the first frame, and click the OK 
button.

You can now preview the movie to confirm that the operation has succeeded. 

Any number of different paint and image processing operations can be recorded 
into a single macro.

To save a macro
After creating a macro you can save it, and then reload it for use in another 
project.

1. Click the Save Macro... button.
2. Enter an appropriate name and click the Save button.

To load a macro
1. Click the Load Macro... button.
2. Select the macro you want to load and click the Open button.
3. Click the Play Macro or Play on Range... button to replay the macro.
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14 Working with Shapes
This section explains how to add drawings to your map by creating vector shapes, 
either using separate shape layers or by adding shape overlays to map layers. It 
explains how you can create and edit shapes, and change their appearance to 
achieve exactly the effect you want.

This section contains information on the following topics:

• Introduction
• Creating Shapes on a Shape Layer
• Creating Shape Overlays
• Shape tools
• Cutting/Pasting and Exporting/Importing Shapes
• Editing Shapes
• Editing Points
• Defining the Appearance of Shapes
• Animating Shapes
• Specifying How Shapes are Displayed
• Setting the Shape Layer Properties
• Animating Shape Layers
• Adding Shape Overlays to a Map Layer

14.1 Introduction
Each shape consists of a number of points joined by straight lines or smooth 
curves. A range of shape tools is provided to enable you to draw shapes point by 
point, by drawing a freehand curve, or by drawing a precise rectangle or ellipse.

Each shape has a start point and an end point, displayed as circles; the 
intermediate points are displayed as squares. In a closed shape the start and end 
points are joined:

 Figure 14: Open and closed shapes

You can control the appearance of shapes by changing the border and fill colors, 
border thickness, opacity, and blur. Shapes can be edited or transformed after 
you have created them, and a series of tools are provided to allow you to move, 
edit, divide, or join shapes. You can also use a shape to cut a hole in the currently 
selected layer.
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You can animate the entire drawing on the shape layer, the individual shapes in 
the drawing, and the individual points of each shape. So for example, a shape 
could be used to show the path of a hurricane, with the shape changing in size as 
it moves across the land.

Shape Layers
You can create shapes in one or more shape layers. Each shape layer can be 
animated as a single unit, pinned to a map layer, wrapped to the map, and scaled 
to the map. Typically you would create a new shape layer for each drawing 
consisting of several shapes. This makes it easy to transform the complete 
drawing as a unit, such as animating its position or fading it in by changing the 
opacity. Shapes can also be used to create holes in other shapes.

Shape Overlays in Map Layers
You can also add shape overlays to a map layer. Shape overlays are always 
wrapped to the map, and can be displayed in the same style as other map details. 
Shape overlays in map layers can be constructed by automatically tracing an 
existing map detail.

See Also
• Creating Shapes on a Shape Layer
• Creating Shape Overlays

14.2 Creating Shapes on a Shape Layer

This section contains information on the following products:

• To create shapes on a shape layer
• To show or hide a shape on a shape layer
• To edit a shape on a shape layer
• To rename a shape on a shape layer

To create shapes on a shape layer
1. On the Layer menu, point to Add Layer, and then click Shape.

• A new empty shape layer will be created at the top of the Layers list:
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2. Click the Contents tab to display the shape tools.
• The New Polygon tool is selected to allow you to create a shape.

3. As you add shapes to the shape layer they will be shown in the Shapes list on 
the Contents panel for the layer.

To show or hide a shape on a shape layer

• Click the eye icon to the left of the shape name in the Shapes list.

To edit a shape on a shape layer
1. Select the shape you want to edit in the Shapes list.
2. Use the options on the Shape, Points, Properties, Animation, and Display 

panels to edit the characteristics of the shape as required.

To rename a shape on a shape layer
1. Select the shape layer in the Layers list
2. Click the Rename… button below the Shapes list.
3. Enter a name for the shape and click the OK button:

See Also
• Creating Shape Overlays

14.3 Creating Shape Overlays

This section contains information on the following products:
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• To create shape overlays
• To rename a shape
• To change the order of shapes
• To delete a shape
• To copy a shape
• To edit a shape overlay

To create shape overlays
1. Select a map layer in the Layers list.
2. Click the Overlays tab on the Contents panel to display the shape tools.

• As you add shape overlays they are shown in the Details list on the Contents 
panel.

To rename a shape
1. Select a layer (not a shape layer) in the Layers list
2. Select a shape from the Details list
3. Click the Properties tab and edit the Label field

To change the order of shapes 
Either:
1. Select the shape you want to move from the Details list
2. Click the up or down arrow button below the Shapes list or Details list

Or:
• Right-click (PC) the shape you want to move, or click while holding down Ctrl 

(Mac), and click one of the Ordering options on the pop-up menu:

Or:
• Drag the shape to the new position in the Details list
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To delete a shape
Either:
• Select the shape you want to delete and press the Backspace key

Or:
• Right-click (PC) the shape you want to delete, or click while holding down Ctrl 

(Mac), and click Remove from the appearing context menu

To copy a shape

You can cut, copy, and paste shapes between layers or between projects using the 
Cut, Copy, and Paste options on the Edit menu or the Shapes list or Details list 
context menu.

You can also export one or more shapes, and then import them into another layer 
or another project, using the Export... and Import... options on the Shapes list or 
Details list context menu.

To edit a shape overlay
• Select the shape you want to edit in the Details list and then use the options 

on the Shape panel to edit the characteristics of the shape as required.

See Also
• Creating Shapes on a Shape Layer

14.4 Shape tools
The following shape tools are provided for drawing shapes on shape layers, and 
overlays on map layers:

•  New Polygon: Straight lines and polygons.

•  New Bezier: Smooth Bezier.

•  New B-Spline: Smooth B-Spline.

•  New Freehand: Freehand shapes.

•  New Circle: Circles.

•  New Ellipse: Ellipses and circles.

•  New Rectangle: Rectangles and squares.

Note: All shape tools are available to map layers; however, not all features of all tools 
are (e.g. Points editor)

As you are drawing a shape a floating palette gives you options for completing the 
shape:
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•Alternatively, to cancel drawing a shape press the Esc key.

For more information about using each of these shape tools see the following 
procedures:

• To draw a polygon, Bezier, or B-Spline shape
• To complete the shape to make an area shape
• To complete the shape to make a line shape
• To draw a freehand shape
• To draw a geometric shape

To draw a polygon, Bezier, or B-Spline shape
1. Select the New Polygon, New Bezier, or New B-Spline tool:

2. Click at the appropriate position to draw each point.
• As you draw the points, the shape will be shown as straight line segments 

(New Polygon tool), smooth Bezier curves (New Bezier tool), or B-Spline 
curves (New B-Spline tool) determined by the point positions:

• The points are drawn in red with the two endpoints highlighted in yellow by 
default.

To complete the shape to make an area shape
Either:
• Click the Area button in the floating Shape palette.
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Or:
• Right-click (PC) the point, or click while holding down Ctrl (Mac), and click 

Make Area Shape from the appearing context menu:

• The shape will be closed and displayed, drawn with the current area style:

To complete the shape to make a line shape
Either:
• Click again on the last point you drew.

Or:
• Click the Closed Line or Open Line button in the floating Shape palette.

Or:
• Right-click (PC) the shape, or click while holding down Ctrl (Mac), and click 

Make Open Line Shape or Make Closed Line Shape from the appearing context 
menu.
• The shape will be drawn with the current line style:
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To draw a freehand shape

1. Select the New Freehand tool
2. Hold down the mouse button and drag to create the shape you want to draw:

3. Click Points tab and select Move Points. As you drag, points will be added as 
necessary to create the shape you are drawing.

4. Complete the shape as for drawing a point shape.
• The freehand shape will be converted to an equivalent Bezier curve that 

uses as few points as possible.

Note: The Points tab is not available when drawing shapes on map layers.

To draw a geometric shape

1. Select the New Circle, New Ellipse, or New Rectangle tool
2. When using the New Ellipse or New Rectangle tool, hold down Ctrl (PC) or Alt 

(Mac) to constrain the shape to a circle or square:
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• When you release the mouse button the shape will be filled with the current 
area style.

14.5 Cutting/Pasting and Exporting/Importing Shapes
Several options are available to help you reuse shapes within a project, or 
between projects. You can cut, copy and paste shapes within a shape layer, 
between shape layers, or between shape layers and shape overlays, to make 
multiple copies of a shape or use one shape as the starting point for another 
shape.

You can also export shapes to a file and then import them into a different project, 
to reuse artwork you have created on a previous occasion.

To cut or copy a shape
Either:
• Click the shape in the Shapes list or Details list with the right mouse button 

(PC), or while holding down Ctrl (Mac), and select Cut or Copy from the 
appearing context menu.

Or:
1. Select the shape in the Shapes list or Details list.
2. On the Edit menu, click Cut or Copy.

• Cut deletes the original and puts it onto the clipboard.
• Copy makes a copy of the original on the clipboard leaving the original 

unaffected.

To paste a shape
1. Select the shape layer or image/movie layer on which you want to paste the 

copy.
2. On the Edit menu, click Paste.

• If you pasted onto a shape layer the shape will be added at the top of the 
Shapes list for the layer.

• If you pasted onto an image or movie layer the shape will be added to the 
top of the Shapes list or Details list for the layer.
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To export a shape
1. Right-click (PC) to select the shape in the Shapes list or Details list, or click 

while holding down Ctrl (Mac), and click Export... from the appearing context 
menu.
• The following dialog box allows you to give a name to the shape file:

2. Enter an appropriate name and click the Save button to save the shape.

To import a shape
1. Right-click (PC) in the Shapes list or Details list, or click while holding down 

Ctrl (Mac), and click Import... from the appearing context menu.
• The following dialog box allows you to select the shape you want to import:
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2. Select the shape file and click the Open button to import it.

14.6 Editing Shapes
The options on the Shape panel allow you to edit the entire shape:

It provides the following options:

• Move Shape: Allows you to move, stretch, or rotate a shape.
• Open Shape: Opens a shape at a selected segment or point.
• Divide Shape: Divides a shape into two shapes.
• Join Shapes: Joins two shapes.
• Smooth: Converts all the points on a shape from corner points to curve points.
• Sharpen: Converts all the points on a shape from curve points to corner 

points.
• Filled/Outline: Specifies whether the shape will be filled.
• Open/Closed: Specifies whether the segment between the endpoints should 

be drawn.
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• Use To Cut Hole: Makes the shape cut a hole in shapes below it in the Shapes 
list.

• Fix Shape: Adds a keyframe (e.g. to an animated path).
• Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump 

between the keyframes.

These options are described in greater detail in the following procedures:

• To move a shape
• To resize a shape
• To rotate a shape
• To move the pin position
• To open a shape
• To divide a shape
• To join two shapes into one shape

To move a shape

1. Select a shape from the Layers list
2. Select the Contents tab, and then the Shape tab
3. Select the Move Shape tool.

• The shape is shown with a dotted bounding rectangle.

Either:
• Drag the shape by a point within the rectangle to move it to a new position

Or:
• Right-click (PC) at the destination, or click while holding down Ctrl (Mac), and 

click Move here from the appearing context menu:

To resize a shape

1. Select a shape from the Layers list
2. Select the Contents tab, and then the Shape tab
3. Select the Move Shape tool.
4. Move the mouse pointer to one of the eight handles on the corners or 

midpoints of the bounding rectangle.
5. Drag to resize the shape:
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6. Hold down Ctrl (PC) or Alt (Mac) to constrain the shape to its original aspect 
ratio.

To rotate a shape

1. Select a shape from the Layers list
2. Select the Contents tab, and then the Shape tab
3. Select the Move Shape tool.

4. Point to the rotation handle, which is a yellow circle to the right of the pin 
position.
• The cursor changes to a rotation symbol.

5. Drag the handle to rotate the shape about its pin position:

To move the pin position

1. Select a shape from the Layers list
2. Select the Contents tab, and then the Shape tab
3. Select the Move Shape tool.
4. Point to the pin position, which is initially at the center of the shape.

• The cursor changes to a pin symbol.

5. Drag the pin position to move it.
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To open a shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Shape tab
3. Select the Open Shape tool:

Either:
• Click the border of the shape to open the shape with the start and end points 

either side of the corresponding segment:

Or:
1. Click a point to open the shape using that point as the start point.
2. Click the point a second time to use that point as the end point.

To divide a shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Shape tab
3. Select the Divide Shape tool:
4. Drag between two non-adjacent points on the border of the shape.
• The shape will be split into two shapes along the line joining the points.

To join two shapes into one shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Shape tab
3. Select the Join Shapes tool:

• The start and end points of each shape will be displayed.

4. Click the start or end point on the first shape.
• A line will extend to the cursor.

5. Click the start or end point on the second shape.
• The selected endpoints will be joined to combine the two shapes into a 

single shape.
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14.7 Editing Points

The options on the Points panel allow you to adjust individual points on a shape, 
and provides the following options:

• Move Points: Allows you to move points, or adjust their tangent handles.
• Transform Points: Lets you rotate one or more selected points as a unit.
• Add Points: Allows you to add points to a shape outline.
• Delete Points: Click a point to delete it from the shape outline.
• Sharpen Points: Click a point to convert a curve point to an angle point.
• Smooth Points: Click a point to convert an angle point to a smooth curve 

point.
• Align Between Points: Click two points to align intermediate points into a 

straight line.
• Shape Edge: Allows you to soften the edge of a shape.
• Adjust Pulls: Allows you to adjust each point by pulling each point’s handle.
• Fix Shape: Adds a keyframe (e.g. to an animated path).
• Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump 

between the keyframes.

When any of the tools on the Points panel are selected you can also right-click 
(PC), or click while holding down Ctrl (Mac), and select an option from the 
appearing context menu:
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To deactivate or activate a point

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Move Points tool
4. Right-click (PC), or click while holding down Ctrl (Mac), and from the 

appearing context menu click Deactivate or Activate on the pop-up menu
• A deactivated point is stored with the shape, but does not affect the shape.

To move one or more points on the shape outline

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Move Points tool
4. Click the point you want to move

• The point turns yellow to show it is selected.

5. Drag the point to the new position:
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To move several points at once, first select them by holding down Shift and 
clicking them, or drag to enclose them.

You can also move points with the Add Points tool selected by holding down Alt 
(PC) or Ctrl (Mac).

To adjust the curvature at a point on a Bezier curve
Every point on a Bezier curve has a pair of tangent handles. The angle of the 
tangent handles determines the angle of the curve through the point, and the 
length of the tangent handles determines the curvature.

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Move Points tool
4. Hold down Ctrl (PC) or Alt (Mac), and drag a point up/down/left/right to adjust 

the smoothness at that point:

5. Drag one of the tangent handles to adjust the curvature at the point.
6. Hold down Ctrl (PC) or Alt (Mac) while dragging a tangent handle to make it 

independent of the other one.
7. Hold down Shift+Ctrl (PC) or Shift+Alt (Mac) to align both tangent handles.

To adjust the curvature at a point on a B-Spline curve
Every point has a pull factor which determines how close the curve gets to the 
point.
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1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Move Points tool.
4. Hold down Ctrl (PC) or Alt (Mac), and drag a point up/down/left/right to adjust 

the pull factor at that point.

To add points

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Add Points tool
4. Click on the shape outline to add a point
5. Hold down Ctrl (PC) or Alt (Mac) to insert the new point equidistant from its 

neighbors.
• After clicking you can drag the new point to position it.
• You can also add points with the Move Points tool selected by holding down 

Alt (PC) or Ctrl (Mac).

To delete points

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Delete Points tool
4. Click a point to delete it

To soften the edge of a shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Points tab
3. Select the Shape Edge tool
4. Drag to extend a second outline around the section of the shape you want to 

soften.
• The edge of the shape will fade smoothly between the two boundaries:

14.8 Defining the Appearance of Shapes
The options on the Properties panel allow you to adjust the fill and outline styles 
of the shape, apply a texture to a shape, change its opacity and softness, 
transform it numerically, or add a drop shadow:
Chapter 14: Working with Shapes 201



This section contains information on the following topics:

• Appearance options
• Transform options
• Drop shadow options (not rotoshapes)
• Motion blur options
• Producer Export options

Appearance options

The Style pop-up menu lets you select a style for the shape.

Use the Opacity and Softness controls to adjust the opacity of the shape and the 
softness of its edge.

The Write On Amount allows you to animate the appearance of a line shape, such 
as to indicate the route of a journey. The line is animated from the starting point 
to the ending point with precise interpolation between points.

To define a shape style
• Click the Settings button.

• The Settings dialog box is displayed.

To draw a shape with a brushed outline
1. Choose Brushed from the Style pop-up menu.
2. Click the Settings button to select the brush to use.
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To fill a shape with the background image
• Choose Merge from the Style context menu.

To add a texture to a shape
1. Click the + button in the Settings dialog box to display an Open dialog box, 

and select a texture.
2. Select the texture from the Texture context menu.
3. Use the buttons to the right of the Texture context menu on the Settings 

dialog box to move or scale the texture.
• The texture will be used as a fill for the shape.

Transform options

Allows you to transform the shape numerically.

Drop shadow options (not rotoshapes)

Select Drop Shadow to turn on a drop shadow for the shape.

The following parameters are provided:

• Offset: The offset of the drop shadow, in pixels.
• Opacity: The opacity of the drop shadow. 0% gives no drop shadow.
• Softness: Blurs the drop shadow to smooth the edges. Values in the range 0–5 

are recommended.
• Color: The color of the drop shadow.
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Motion blur options 

Adds motion blur before and/or after a shape.

Producer Export options 

Not longer supported.

14.9 Animating Shapes

The options on the Animation panel allow you to animate individual shapes on a 
shape layer. This panel is not available for shape overlays.
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• Edit Shape Path: Enables you to edit the shape’s path by adjusting the points 
on the path (e.g. the start and end points).

• Edit Points Path: Enables you to edit the shape’s points (e.g. giving the shape 
another shape during the animation).

• Next Shape Key: Jumps to the shape’s next keyframe.
• Prev Shape Key: Jumos to the shape’s previous keyframe.
• Apply Track Data: Applies a tracking path to a layer in your project
• Auto Animate: Enables you to set animation properties like slide in/out and 

fade on/off.
• Match rotation to path: Enables the object’s rotation to follow the direction of 

the path.
• Smooth New Points on Shape Path: Converts an angle point to a smooth curve 

point on a shape path.
• Automatically Fix Shapes: Automatically makes the current frame a key frame 

for every point on the shape.
• Fix Shape: Adds a keyframe (e.g. to an animated path).
• Remove Keys: Removes a keyframe. Use Next and Prev Shape Key to jump 

between the keyframes.
• Show Keybars: Opens the Shape Keybars editor. This will allow you to edit the 

shape’s animation properties (e.g. transformation) on its timeline.

This section contains information on the following procedures:

• To fix a shape
• To remove the keys
• To animate an individual shape
• To animate individual points on a shape
• To show the keybars for a shape

To fix a shape
1. Select a shape from the Layers list
2. Select the Contents tab and then the Animation tab
3. Click the Fix Shape button

• This makes the current frame a key frame for every point on the shape.

To remove the keys
1. Select a shape from the Layers list
2. Select the Contents tab and then the Animation tab
3. Click the Remove Keys button

• This removes all keys for the current frame.

To animate an individual shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Animation tab
3. Select the shape in the Shapes list
4. Select the Edit Shape Path tool
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5. Open the Animation Controls and set the marker where the animation should 
end (e.g. 50 fps)

6. Drag the center of the shape to define its path throughout the animation
7. Hold down Ctrl (PC) or Alt (Mac) and drag from a point on the animation path 

to extend tangent handles from that point and create a curved animation path.

To animate individual points on a shape

1. Select a shape from the Layers list
2. Select the Contents tab and then the Animation tab
3. Select a shape in the Shapes list
4. Select the Edit Points Path tool
5. Drag the points to the positions you want them to have at each frame of the 

animation.

6. Hold down Ctrl (PC) or Alt (Mac) and drag from a point on the animation path 
to extend tangent handles from that point and create a curved animation path:
• The keys for individual points are not displayed in the Keybars panel.

To show the keybars for a shape
1. Select the shape in the Shapes list.
2. Click the Show Keybars... button on the Animation panel.

• The Shape Keybars window shows a keybar for each shape in the Shapes 
list. You can click the arrow to the right of each shape to show a Transform 
bar showing the transformations applied to the entire shape, followed by a 
keybar for each point on the shape:

3. Select All Points to include a keybar for every point in the Shapes list, or 
Selected Points to show only selected points on those shapes.
• The Shape Keybars window works in the same way as the Keybars panel; for 

more information see the Using the Keybars Panel section.
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14.10 Specifying How Shapes are Displayed
The options on the Display panel allow you to specify how shapes are displayed 
while they are edited:

Use the Editor Display options to specify which features of a shape are displayed 
during editing.

The Fill Points & Handles at Key Frames option displays each point filled if the 
frame is a key frame for that point, and is only available for shape layers.

Use the Shape Display options to specify how shapes are normally displayed.

Click the Tool Colors... button to define the colors for the editing features:

14.11 Setting the Shape Layer Properties 

The options on the Properties panel allow you to specify the compositing options 
for the shape layer, transform it, and add a drop shadow, or animation trail. It also 
provides several animation options.
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This section contains information on the following topics:

• Compositing options
• Transform options
• Drop Shadow options
• Trail options

Compositing options

Blend Mode specifies how the layer is combined with the other layers, and can be 
one of:

Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, 
Screen, Lighten Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, 
Overlay, Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

The Obey Composite Mask specifies whether the current layer should obey the 
composite mask.

For more information see Controlling Layer Compositing.

Transform options

These allow you to specify the position, rotation, scale, and origin of the entire 
shape layer numerically.

These options behave in exactly the same way as for image layers.
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Drop Shadow options

• Select Drop Shadow to turn on a drop shadow for the layer.

The following parameters are provided:

• Offset: The offset of the drop shadow, in pixels.
• Opacity: The opacity of the drop shadow. 0% gives no drop shadow.
• Softness: Blurs the drop shadow to smooth the edges. Values in the range 0–5 

are recommended.
• Color: The color of the drop shadow.

Trail options 

The Trail options allow you to leave a trail as the shape layer animates. For more 
information see Leaving an Animation Trail.

14.12 Animating Shape Layers
In addition to being able to animate individual shapes, you can animate the 
complete set of shapes on the shape layer as a single entity.

This is useful if you have constructed a complex illustration from a number of 
separate shapes and want to animate it as if it were a single object.

Each shape can be given its own animation path with control over the following 
features:

Opacity, drop shadow opacity, offset color and softness, position, rotation, 
scale, write on amount, and softness.

To auto-animate the entire shape layer
Either:
• Click the Auto Animate button on the Properties panel for the shape layer.

Or:
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• Select the shape layer in the Layers list and click Auto-Animate... on the Layer 
menu.

The Automatic Animation dialog box allows you to automatically slide in, slide 
out, fade on, and/or fade off the shape layer with specified timings.

For more information about using the automatic animation dialog box see section 
Automatically Animating a Layer.

To animate the entire shape layer

1. Select the Path tool:
2. Drag the shape layer to the position you want it to have at each frame of the 

animation.

3. Hold down Ctrl (PC) or Alt (Mac) and drag from a point on the animation path 
to extend tangent handles from that point and create a curved animation path:

Tip: If you are creating a small graphic draw it in the center of the shape layer, as 
this will make its position correspond to the points on the animation path.

14.13 Adding Shape Overlays to a Map Layer
As well as constructing drawings out of shapes in separate shape layers, you can 
also add shape overlays to map layers. Shapes drawn on a map layer appear in the 
Details list on the layer’s Contents panel and are referred to as shape overlays. 
They include all the same features as shapes drawn in shape layers with some 
extra features that make them particularly useful for highlighting areas on maps:

• You can draw shape overlays by automatically tracing borders, coastlines, 
built-in roads and railways, or imported lines on the map.

• You can clip shape overlays to the land, so that any areas overlapping the sea 
are effectively transparent.

• You can choose to draw shape overlays as land, water, relief, road, rail, or 
imported data to give the shape exactly the same scale and appearance as the 
corresponding features. 

This section contains information on the following procedures:
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• To define the properties of shape overlays
• To draw shape overlays as land, water, etc
• To clip a shape overlay to land
• To draw shapes by tracing map features
• To zoom or pan while you trace

To define the properties of shape overlays
1. Select the shape in the Details list.
2. Click the Shape tab to display the properties for the selected shape:

The options are the same as for shapes in shape layers, with the addition of Draw 
using style, Clip to land, and the edit tools of Shape, Points and Animation. All are 
described in the following sections.

To draw shape overlays as land, water, etc
• Choose the appropriate option from the drop-down menu:

• Treat as Land: Colors the land and relief.
• Treat as Water: Colors the sea and depth contours.
• Draw with Border line width: Scales with region borders.
• Draw with Road/ Rail line width: Scales with built-in roads/railways.
• Draw with Imported Data line width: Scales with imported data.

For example you can use a shape set to Treat as Land to mark out an area of a 
particular terrain type, such as desert:
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To clip a shape overlay to land

• Select the shape detail in the Details list and select Clip to land in the Shape 
panel.

To draw shapes by tracing map features

Note: You can only trace features on the map once the high quality rendering of the 
map layer has completed.

1. Select the map layer on which you want to create the shape.
2. Select the Add Point Shape tool and click the arrow to the right of the tool to 

display a submenu of options for the tool:

• Press Esc (PC) or the Cancel button on the submenu (Mac) if you want to 
cancel the submenu without making a selection.
212 Chapter 14: Working with Shapes



3. Select Trace borders & coastline, Trace global roads & rail, Trace river lines, or 
Trace streets/imported data according to which features on the map you want 
to trace.

Note: River tracing cannot be used on rivers that are wide enough to be drawn as 
area shapes rather than simple lines.

4. Move the mouse pointer near the feature you are tracing; for example, the 
coastline or border between regions.
• The mouse pointer changes shape (cuts the tail) to show that the border has 

been detected:

5. Click to create a point, and then move to the next point along the border you 
are tracing.
• A line indicates the outline of the shape being traced. If the line being traced 

follows the wrong path, take smaller steps between points.
• As you are drawing the shape you can use the Add Point Shape tool to turn 

tracing on or off, or change the feature being traced, to achieve exactly the 
effect you want.

6. Finally complete the shape in the usual way, by clicking on the starting point 
to create an area shape, or clicking (e.g. double-click) again on the previous 
point to create an open shape:

• Once you have traced the shape you can edit it or transform it in exactly the 
same way as for other shapes you draw.
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To zoom or pan while you trace
You can only trace areas of the map that are actually visible on the screen, but if 
necessary you can zoom or pan the map while you are tracing to change the part 
of the map that is in view

1. Type Z to temporarily select the Zoom tool or P to temporarily select the Pan 
tool while you are tracing.

2. Press either key again to switch back to the Add Point Shape tool.
214 Chapter 14: Working with Shapes



15 Working with ESRI Shape Files
This section explains how to import map data in ESRI Shape File format and 
configure it for use with your maps.

This section contains information on the following topics:

• Introduction
• Setting up ESRI Shape File data
• Using ESRI Shape File data

15.1 Introduction
Although the Street Data format provides a more convenient way of creating 
street maps, a wide range of published data is available in ESRI Shape File format, 
and Viz World Classic allows you to import this data and configure it for use with 
your maps.

Viz World Classic supports ESRI Shape File format data in which the text and field 
data are encoded in an extended range of formats, including UTF-16 and various 
language-specific encodings including some Japanese, Hebrew, and Arabic 
encodings.

You can specify the encoding for each field of imported shape file data, allowing 
maps to be created in many different languages.

See Also
• Working with Street Maps

15.2 Setting up ESRI Shape File data
Data in ESRI Shape File format may contain a large number of different attributes 
and values which describe the data contained in the file. In order for Viz World 
Classic to understand how to draw the data, you first need to create a data set 
definition that describes which features are to be drawn and in which style.

This section contains information on the following procedures:

• To create a data set definition
• To edit the data set
• To add subsets to a data layer
• To define the style for data layers or subsets

To create a data set definition
1. On the Import menu, click Map Data (Shape Files)... to display the Imported 

Data Sets dialog box.
2. Click the Create a Data Set Definition button:
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The following dialog box allows you to select an existing data set definition as the 
basis for the new one:

• Click the Browse... button to specify the filename for the new data set 
definition.

If you want to base the data set definition on an existing one:
1. Click Base on the following data set definition and select a definition in the 

list.
2. Click the OK button to create the new data set definition.

• It will be displayed in the Imported Data Sets dialog box.
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To edit the data set

1. Select the data set definition in the Data Sets list.
2. Click the Edit Data Set Definition button.

• The Edit Data Set dialog box allows you to edit the data set definition.
3. Click the Add Data Layer button.

4. Select the data file you want to add.
• Supported file formats are .shp (Shape File) and .csf (Curious Shape File).
• The Data File Properties dialog box then allows you to specify how the 

features in the data file you have loaded will be labeled on the map.
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5. Choose up to three fields from the Fields used to label features drop-down 
menus.
• Each street will be labeled with the specified field values.

6. Click the Field Settings... button to display the following dialog box, which 
allows you to specify the encodings for each field in the file:

7. Select one or more fields in the Fields list, then choose the relevant encodings 
from the Name Encoding and Data Encoding pop-up menus.
• You can preview the effect of the encodings by clicking the View field… 

button.

8. Click the Close button to save the data layer in the data set definition. 

To add subsets to a data layer
You can create subsets of a database file based on the contents of a specified 
field. This allows you to filter the database, and display each subset in a different 
style.

1. Open the Data File Properties dialog box and choose the field you want to use 
to divide the database into subsets from the Field used to split features into 
subsets drop-down menu. For example, to divide states accoriding to east and 
west coast states.

2. Click the Close button to close the Data File Properties dialog box.
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3. Select the appropriate data layer in the Edit Data Set dialog box.
4. Click the Add Subset button.

• The following dialog box displays a list of the available values for the 
specified field in the data file and allows you to select values to create the 
subset.

5. Select the values you want to use in the upper list and click the + button to 
add them to the lower list.

6. Hold down Shift to select multiple contiguous items, and Ctrl (PC) or 
Command (Mac) to select multiple non-contiguous items.
• For example to create a subset containing only the East Coast states you 

could select and add those.

7. Enter a name for the subset in the Subset Name field.
8. Click the OK button to save the subset definition.

To define the style for data layers or subsets
You can define a separate style for each data layer or subset you have created, to 
distinguish them on the final map.
1. Select the data layer or subset in the Edit Data Set dialog box.
2. Select Draw layer with selected style from the How to draw selected layer or 

subset drop-down menu.
3. Select the styles for drawing the selected layer or subset, and the style for 

drawing individual features, in the lists on the right side of the Edit Data Set 
dialog box:
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• Appropriate styles are listed in the Style lists depending on whether the type 
of the layer is Area, Line, or Point.

• Alternatively, select Draw polygons/areas as Land, Draw polygons/area/
lines as Rivers, Draw polygons/areas as Lakes or Draw polygons/areas as 
Sea from the How to draw selected layer or subset drop-down menu to treat 
the selected layer in the same way as the built-in land, rivers, lakes or sea 
respectively.

• The Scale by box allows you to scale the line thickness defined by the style. 
For example, you can identify different types of roads by using the same 
Primary Roads style but different Scale by settings for the line thickness.

4. Enter a value to scale the line thickness and press the Return key.
5. Repeat for any other data layer or subsets.

See Also
• How to edit any of the styles using the Styles Editor in the Working with Styles 

section

15.3 Using ESRI Shape File data
Once you have created a data set definition, you can use this to load the ESRI 
Shape File data with the attributes you have specified.

This section contains information on the following procedures:

• To load a data set definition
• To load the data
• To use imported map data
• To add labels to imported data features
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To load a data set definition

1. On the Import menu, click Map Data (Shape files)... and click the Add a Data 
Set button.

2. Select the data set definition file and click the Open button to load it.
• The data set will be displayed in the Data Sets list.

3. Click the Close button to close the dialog box.

Once you have added a data set it will be remembered for future uses of Viz World 
Classic, so there is no need to add the data set to the list every time you start the 
software. 

If you want the data for the data set to be loaded automatically on start-up you 
can select the Always load the data for this set on startup box.

To load the data
Adding a data set to Viz World Classic does not load the map data by default. This 
prevents very large data sets being loaded before you are ready to use them. You 
can instruct Viz World Classic to automatically load the data for a set, in the 
Import Data Sets dialog box (see how To load a data set definition), or you can 
load the data manually when you need it as follows:

1. Click the Imported Data tab in the map layer’s Contents panel to display the 
data sets you have imported.
• The data set definitions are shown in the left list.
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2. Click the data set you want to import with the right mouse button (PC), or 
while holding down Ctrl (Mac), and select Load Data from the appearing 
context menu.

You can unload a data set (for example to free up some memory to load a 
different set) at any time by clicking the set with the right mouse button (PC), or 
while holding down Ctrl (Mac), and choosing UnLoad Data from the appearing 
context menu.

To use imported map data
You can expand the tree to show the data layers and subsets for each data set.
1. Select the data layer or subset in the Imported Data list to show the features it 

contains.
2. Click each data layer, subset, or feature with the right mouse button (PC), or 

while holding down Ctrl (Mac), and select Add to map from the appearing 
context menu, or click the Add To Map button to add it to the map layer.

You can also search for imported features in the Search panel, in exactly the same 
way as for built-in map data.

To add labels to imported data features
Initially the features in imported data are drawn unlabeled, but you can add labels 
to selected features to label them on the map just as you would with other map 
details.

1. Select the Browse Imported Data tool.
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As you move this over the map the tool tip shows you the name of each imported 
data feature.

2. Right-click (PC), or hold down Ctrl (Mac), and from the appearing context 
menu click the appropriate label option.

If you are labeling a street the label will be drawn aligned with the direction of the 
street. You can then use the Text tool to move or rotate the label as desired.
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16 Adding Text to a Project
This section explains how to incorporate text into projects, and describes how to 
control the appearance of the text and the way it is animated.

This section contains information on the following topics:

• Introduction
• Creating Text on a Text Layer
• Manipulating Text Items
• Editing Text
• Defining the Text Layout
• Defining the Appearance of Text Items
• Animating Text Items
• Defining the Properties of the Entire Text Layer

16.1 Introduction
Each map detail you select in your project is automatically provided with a text 
label, pinned to the map. Viz World Classic also allows you to add independent 
text layers to the project, each containing one or more separate text items, with 
precise control over the appearance of each item and the way in which they are 
animated.

For example, you could use a text object to add a title to the animation, add 
legends to graphics incorporated in the animation, or label map features not 
provided in the map database.

You could also use a text label to label a map detail instead of the default label 
provided with the detail, for greater control over its appearance and the way it is 
animated.

Viz World Classic allows you to use any of the TrueType fonts installed on your 
computer and supports text in many international character sets.

You can change the font used in the Viz World Classic user interface to ensure 
that the international character set you are using is displayed correctly. 

See Also
• Quick Tour on how to get started
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16.2 Creating Text on a Text Layer

This section contains information on the following procedures:

• To create text on a text layer
• To create additional text items
• To define the default text properties

To create text on a text layer
1. On the Layer menu, point to Add Layer, and then click Text.
2. Click in the Viewer to define the position of the text item.

• Alternatively you can drag to define the width of the text item.

3. Type the text you want to add:

To create additional text items
1. Select the New Text Item tool on the Contents panel
2. Click or drag in the Viewer and type the text
Chapter 16: Adding Text to a Project 225



• The text items will be displayed in the text items list.

To enter international characters not shown on the keyboard, such as accented 
characters, use the standard procedure for your computer system.

Once you have created one or more text items on a text layer you can edit them or 
change their appearance using the panels on the Contents panel.

To define the default text properties

• On the Styles menu, click Default Text Properties.
• The above dialog box allows you to specify the default font, size, style, 

spacing and color for new text layers.

16.3 Manipulating Text Items
This section contains information on the following items.

To move text

1. Select the Text tool in the toolbar
• This tool is automatically selected when you create a new text item.

2. Drag the text by the position handle:

To resize a text item
• Drag one of the handles on each side of the text item.

• The text will be wrapped to fit in the text item.
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16.4 Editing Text

The options on the Edit panel (depicted above) allow you to edit the font, size, 
style, and color of selected characters, change the alignment of the text, and edit 
the stroke and keyline widths.

This section contains information on the following procedures:

• To edit the text
• To specify the text alignment
• To create outlined characters
• To add a keyline around the characters

To edit the text
Either:
• Select by marking the characters you want to edit in the Viewer

Or:
• Select the characters in the Edit panel

Or:
• Select the entire text by clicking the Select All  button in the Edit panel

• Select the font, size, style, fill color, and outline color using the controls at the 
top of the Edit panel

To specify the text alignment
• Click the appropriate button to the top right of the Edit panel.

To create outlined characters
1. Select the Outline option
2. Choose the stroke width from the Stroke Width pop-up menu

The character outlines will be drawn with the specified stroke width in the fill/
outline color.
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You can specify the fill and keyline colors individually for each character in a text 
item. Alternatively selecting Uniform Color makes all the letters have the same 
color. When Uniform Color is selected the text color can be animated.

To add a keyline around the characters
1. Choose the keyline width from the Keyline Width pop-up menu.
2. Select the characters you want to edit in the Viewer, or on the Edit panel, and 

click the keyline color box to specify the keyline color for the selected 
characters.

With filled characters the keyline is drawn as an outline around the characters:

With outlined characters the keyline is drawn as a double line around the outlines.

16.5 Defining the Text Layout

The options on the Layout panel (depicted above) allow you to move, scale, or 
rotate a text item, adjust the kerning, or align or space evenly multiple text items.

This section contains information on the following procedures:

• To move a text item
• To scale text
• To rotate text
• To adjust the letter spacing
• To align several text items
• To space several text items evenly

To move a text item

1. Select the Move Text tool 
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2. Position the mouse pointer within the text item.
3. Drag the text item to the new position:

• This allows you to move a text item even if the position handle is out of 
view.

To scale text

1. Select the Move Text tool 
2. Drag one of the handles on the border of the text item:

3. Drag while holding down Ctrl (PC) or Alt (Mac) to scale the text proportionally.

To rotate text

1. Select the Move Text tool 
2. Point to the rotation handle, the yellow circle to the right of the centre of the 

text item.
3. Drag the handle to rotate the text item about its center:
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To adjust the letter spacing
1. Select the Text Kerning tool.

• The Viewer indicates the position of each character by a marker on the 
baseline:

2. Drag a marker to the left or right to adjust the spacing between the corre-
sponding characters.

3. When you have finished kerning the text, click the Text Kerning tool again.

Tip: You can reset the default kerning of the text by clicking the Reset button.

To align several text items

1. Select at least two text items in the list, using Shift to select multiple items.
2. Choose the appropriate alignment option from the Align context menu (see 

above).
230 Chapter 16: Adding Text to a Project



To space several text items evenly

1. Select at least three text items in the list, using Shift to select multiple items.
2. Choose the appropriate alignment option from the Space Evenly context 

menu.

16.6 Defining the Appearance of Text Items
The options on the Properties panel allow you to specify, the appearance of 
individual text items, including the compositing options, spacing, transformation, 
drop shadow, frame, or animation trail:

This section contains information on the following topics:

• Appearance Options
• Spacing Options
• Transform Options
• Drop Shadow Options
• Frame Options
• Trail Options
• Producer Export
• Instant Maps Export
• Compositing Options
• Animation Options
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16.6.1 Appearance Options

The Appearance options allow you to specify the rendering style of the text, apply 
a texture to the text, and animate its writing.

To fill the text with a texture choose Solid from the Style pop-up menu, and click 
the + button to select an image file for use as the texture:

Use the Opacity and Softness controls to adjust the opacity of the text, and blur 
the edges of the text.

The Write On options (text layers only) allow you to animate the way in which the 
text appears, to cause it to appear to be typed on as the animation progresses.

• Choose Characters from the Write On Style pop-up menu to make the text 
appear character by character, or Words to make it appear word by word.

• Set the Write On Amount to 0 at the frame where you want the animation to 
begin, and to 100 at the frame where you want the animation to end.

See Also
• Defining the Appearance of Text Items
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16.6.2 Spacing Options

The Spacing options allow you to adjust the character and line spacing for the text 
item.

See Also
• Defining the Appearance of Text Items

16.6.3 Transform Options

The transform options allow you to specify the position, scale, rotation, and origin 
numerically.

The Origin determines the point about which the text item is rotated or scaled, 
and defaults to North, or the top center of the text item.

Either:
• Choose one of the predefined options from the Origin pop-up menu.

Or:
• Edit the X and Y origin values to specify the origin in pixels relative to the 

lower left corner of the text item.

See Also
• Defining the Appearance of Text Items

16.6.4 Drop Shadow Options
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Select Drop Shadow to turn on a drop shadow for the text item. The following 
parameters are provided:

See Also
• Defining the Appearance of Text Items

16.6.5 Frame Options

Allows you to add a colored fill, and/or border to the text item.

Border Width specifies the width of the border in pixels.

See Also
• Defining the Appearance of Text Items

16.6.6 Trail Options

The Trail options allow you to leave a trail as the text item animates.

See Also
• Leaving an Animation Trail
• Defining the Appearance of Text Items

Parameter Description

Offset The offset of the drop shadow, in pixels.

Opacity The opacity of the drop shadow. 0% gives no drop shadow.

Softness Blurs the drop shadow to smooth the edges. Values in the range 
0–5 are recommended.

Color The color of the drop shadow.
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16.6.7 Producer Export

Not longer supported.

16.6.8 Instant Maps Export

Allows you to make maps available to the Viz Curious Instant Map tool.

16.7 Animating Text Items

The options on the Animation panel allow you to animate text items on text 
layers.

See Also
• Match rotation to path and how To align the image, text item, or drawing to 

the angle of the animation path
• Auto Animate and Automatically Animating a Layer
• Edit Text Path and Animating an Image, Movie, Text Item, or Drawing Along a 

Path
• Creating Tracking Paths
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16.8 Defining the Properties of the Entire Text Layer

In addition to being able to define the properties of individual text items, the 
Properties panel allows you to edit properties for an entire text layer.

This section contains information on the following topics:

• Compositing Options
• Animation Options

16.8.1 Compositing Options

Blend Mode specifies how the layer is combined with the other layers, and can be 
one of:
• Normal, Add, Subtract, Difference, Multiply, Darken Only, Burn, Color Burn, 

Screen, Lighten Only, Dodge, Color Dodge, Hue, Saturation, Value, Color, 
Overlay, Soft Light, Hard Light, Pin Light, Exclusion, or Negation.

The Opacity determines the layer opacity, and can be animated.

See Also
• Animating Text Items

16.8.2 Animation Options
Allows you to animate the entire text layer. The options are the same as for 
individual text items.

See Also
• Animating Text Items
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17 Working with Cutouts
Viz World Classic allows you to cut out a selected area from the Viewer to create 
an image overlay called a cutout. You can use a cutout to paint onto an image or 
its mask, or you can convert one or more cutouts to a new image/movie layer.

This chapter contains information on the following topic(s):

• Creating Cutouts

17.1 Creating Cutouts

To cut out a section of an image

1. Select Cut: Image
2. Select the New Cutout tool (button)
3. Select From: Layer to create a cutout from just the current layer, or From: 

Composite to create a cutout from the composited layers.
4. Drag to draw a rectangle defining the size of the cutout you want to create:

The cutout will be displayed in the Overlay list on the Cutouts panel:
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You can then drag the cutout to displace it from the original image, or display it 
on another layer:

To cut out an object defined by a mask
1. Draw a mask over the part of the image you want to cut out:

For more information see Specifying the Brush Settings.

2. Select Cut: Image and Cut: Mask
3. Select the New Cutout tool

Selecting Cut: Mask uses the image’s mask to cut out the image from its 
background.

4. Drag to draw a rectangle defining the size of the cutout you want to create, 
enclosing the image:
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The Move Cutout tool is automatically selected so you can drag the cutout to see 
it independently of the original image:

The cutout will be available to any other layers in the project:

When using Cut: Mask, the Background removal options can be used to remove 
edge effects around the mask.

Assume Color allows you to specify a color to be removed from the edge of the 
mask, and Automatic uses the average color within the cutout rectangle, but 
outside the mask.

To create a cutout using the Magic Wand tool

If the feature you want to cut out is clearly distinguished from its background, you 
can use the Magic Wand tool to mask the feature, and then create a cutout using 
the mask. 

1. On the Graphics panel click the Magic Wand tool:
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Display Mask will automatically be selected in the paint controls to show the mask 
when you create it.

2. Click the feature you want to mask.

If necessary, adjust the Tolerance control and click again with the Magic Wand 
tool until the feature is completely masked:

3. On the Cutouts panel select Cut: Image and Cut: Mask.
4. Select the New Cutout tool.
5. Drag to draw a rectangle enclosing the feature:

Drag the cutout to see it independently of the original image:
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To stick a cutout to an image/movie layer
1. Select the cutout in the Overlay list.
2. Click the Stick button.

This section also contains information on the following topic(s):

• Moving and Transforming Cutouts
• Defining the Appearance of Cutouts

17.1.1 Moving and Transforming Cutouts
The options on the Layout panel allow you to move, scale, or rotate cutouts, or 
use them in other ways:

To move a cutout
• Select the Move Cutout tool.

You can then move, scale, or rotate the cutout in exactly the same way as for 
images; see Moving, Resizing, or Rotating an Image.

To flip a cutout about the vertical or horizontal axis
• Click the Flip Vertical or Flip Horizontal button.

To convert a cutout to a layer
1. Select the cutout in the Overlay list.
2. Click the Convert to Layer button.

• A new image/movie layer will be created, above the current layer, 
containing the cutout.
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To use a cutout for a brush or profile
• Click the Use for Brush or Use for Profile button.

• The cutout will appear in the Brushes or Profile list on the Brushes panel.

To save a cutout as an image
• Click the Save Image... button.

You can save it in any of the standard image formats.

See Also
• Moving, Resizing, or Rotating an Image
• To load a cutout for use as a brush or profile

17.1.2 Defining the Appearance of Cutouts
The options on the Properties panel allow you to define the style, opacity, and 
softness of cutouts, add a drop shadow, and specify a transformation numerically:

Appearance options

The Appearance options allow you to specify the style of the cutout, and change 
its opacity or softness. 

Set the Style to Color to convert the cutout to a solid color, and use Fill Color to 
define the color. This is useful for creating shadows.
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Transform options

These allow you to specify the position, scale, rotation, and origin numerically. 
The Origin determines the point about which the cutout is rotated or scaled, and 
defaults to Center.

Either:
• Choose one of the predefined options from the Origin context menu.

Or:
• Edit the X and Y origin values to specify the origin in pixels relative to the 

lower left corner of the cutout.

Drop Shadow options

Select Drop Shadow to turn on a drop shadow for the cutout.

The following parameters are provided:
• Offset: The offset of the drop shadow, in pixels.
• Opacity: The opacity of the drop shadow. 0% gives no drop shadow.
• Softness: Blurs the drop shadow to smooth the edges. Values in the range 0–5 

are recommended.
• Color: The color of the drop shadow.
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18 Lighting and Effects
Viz World Classic includes sophisticated lighting features and effects, to enable 
you to add shading and depth to your map animations, and give them a unique 
and distinctive appearance.

This section contains information on the following topics:

• Using Lighting
• Setting the Lighting Options
• Changing the Position, Size, or Angle of the Light
• Animating a Light
• Using Style Lights
• Adding Image Effects to a Layer

18.1 Using Lighting
Each of the map, image, text or shape layers in your project can include one or 
more lights which you can use to focus the viewer’s attention, or add depth and 
perspective to the animation. Three different types of light are provided, and you 
can use these either individually or in combination to achieve a wide range of 
different effects.

 Figure 15: Hightlight, spotlight, diffuse light and combined light

• Highlight: Gives the appearance of a light reflecting from a shiny surface.
• Spotlight: Casts a concentrated disc of light, with areas outside the beam 

remaining dark.
• Diffuse light: Casts a diffuse disc of light, falling away gradually to the edges. 

For each type of light you can adjust the size and shape of the beam, the 
position, brightness, and color of the light.

• Combining lights: Impressive effects can be achieved by combining two or 
more lights on a single layer. For example, the following image uses a 
highlight combined with a diffuse light.
244 Chapter 18: Lighting and Effects



18.2 Setting the Lighting Options

The Lighting panel allows you to create and edit the lights on each layer.

To add a light to a layer
1. Select the layer and click the Lighting tab to display the lighting options for 

the layer.
• Initially lighting is turned off, and no lights are defined.

2. Select Lighting on to turn lighting on for the layer.
3. Click the Add button to add a light to the layer.

• A new light will be created with a default name, such as Light1.

4. Choose Highlight, Spotlight, or Diffuse from the Type drop-down menu to 
specify the type of light.

5. Use the Brightness control to adjust the brightness of the light.
6. Use the Ambient Level control to adjust the background light level.

• This determines the brightness of parts of the layer that are not directly 
illuminated by one of the lights.

For map layers:
• Click the Pin on map or Scale with map buttons to move and/or scale the light 

as the map layer is moved or zoomed.

18.3 Changing the Position, Size, or Angle of the Light
When you add a light the Light tool is selected in the Lighting panel to allow you 
to move, scale, or rotate the light:

The extent of the light will be shown as a circle:
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To move the light
• Position the mouse pointer anywhere within the circle and drag the light to the 

required position.

To change the size of the beam
• Drag the outline of the surrounding circle.

To stretch the beam in one direction
• Drag the light by one of the four handles on the surrounding circle:

To change the angle of the light
• Drag the handle extending from the center of the circle:

To specify the parameters of a light numerically
• Edit the X, Y, Width, Height, and Angle values in the Lighting panel.

18.4 Animating a Light
The Light Path tool allows you to manipulate the animation path along which a 
light will be animated:

See Also
• Animating an Image, Movie, Text Item, or Drawing Along a Path
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18.5 Using Style Lights
You can make a particular combination of lights part of your house style by 
defining the lights in the Lighting panel of the Styles Editor. Any lights you define 
there will then automatically be applied to each map layer, with the names Style 
light 1, Style light 2, etc.

You can modify the characteristics of each style light within a particular layer to 
override the settings defined in the style sheet.

To revert one or all style lights to the settings defined in the style sheet
• Click the Revert to Style or Revert All to Style buttons in the Lighting panel for 

the layer.

18.6 Adding Image Effects to a Layer

To apply one or more image effects to a layer
1. Select the layer.
2. Click the Layer Fx tab to display the Layer Fx panel for the layer.
• Every parameter of an effect can be animated. For more information see the 

Using the Keybars Panel section.

To add an effect to a layer
1. Click the arrow symbol to the left of a heading in the effects list to expand the 

list, and show the effects under that heading. 
2. Select the filter and click the right arrow button to add it to the right-hand list 

of effects to be applied to the layer.

Each effect displays a set of controls to allow you to adjust its parameters.

To determine the order in which the effects are applied
The order of effects in the list determines the order in which they are applied.
• Select an effect in the right-hand list and click the up arrow or down arrow 

buttons to move it up or down in the list.

Layer Fx
The following layer effects are available:
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Blur
• Softness softens the layer, giving it an out-of-focus appearance.

Brightness/Contrast
• Brightness adjusts the brightness, where 0.00 corresponds to normal 

brightness. 
• Contrast adjusts the contrast of the layer with 0.00 corresponding to normal 

contrast. 
• Gamma adjusts the gamma of the layer with 0.00 corresponding to normal 

gamma. 
• Saturation adjusts the color saturation of the layer where 0.00 corresponds to 

normal saturation.

Tint
Applies a tint color to the layer. The Tint Amount control allows you to adjust the 
degree of the tint.
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19 Controlling Animation
This section explains how to use the time slider to control the progress of an 
animation. It also describes how to use the Automatic Animation tool to set up 
impressive animations with a few simple clicks, and the Keybars panel to provide 
individual control over each component of a project. 

This section contains information on the following topics:

• Using the Animation Controls
• Automatically Animating a Layer
• Using the Keybars Panel
• Getting Natural Motion
• Displaying Detailed Information About a Feature
• Animating an Image, Movie, Text Item, or Drawing Along a Path
• Leaving an Animation Trail

19.1 Using the Animation Controls

The Animation controls allow you to choose which frame of the animation you are 
editing, and let you preview the finished project.

This section contains informtion on the following procedures:

•  To specify the time display format
•  To move to a specific frame
•  To move back or forward frame by frame
•  To move to the start or end of the animation
•  To move to the next or previous key
•  To expand the slider scale
•  To show the whole project
•  To select continuous playback

To specify the time display format
• Choose the format as follows:

• Format: Description
• Timecode: Hour:Minute:Second:Frame.
• Frames: Frame number.

To move to a specific frame
Either:

• Edit the Current frame field.
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Or:

• Drag the time slider until the appropriate frame is displayed in the Current 
frame field.

To move back or forward frame by frame

• Click the Step back or Step forward buttons.

To move to the start or end of the animation

• Click the Start or End buttons.

To move to the next or previous key

• Click the Next Key or Previous Key button in the Animation controls. 

Tip: A key is a frame in which one or more properties have been edited.

To expand the slider scale
1. Click the Range... button.
2. Select Part of project, and specify the Start time, and the End time or Duration, 

of the section of the project you want to work on:

3. Click the OK button.

To show the whole project
•Click the Slider Range button.
•Select Whole project and click the OK button.
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To select continuous playback

• Click the Loop Play button to play repeatedly, restarting at frame 0 after the 
last frame.

• Click the Bounce Play button to play continuously, alternately forward and 
backwards.

19.2 Automatically Animating a Layer
Viz World Classic includes an automatic animation tool, to make it easy for you to 
add animation to any layer of your project. 

It provides the following animations:

• Slide: Allows you to slide the layer on and/or off in any direction horizontally, 
vertically, or diagonally.

• Fade: Allows you to fade the layer on and/or off.
• Write on: In addition, for text layers, you can animate the text so that it writes 

on, in characters or words.

This section contains informtion on the following procedures:

•  To auto animate a layer
•  To animate the position of the layer
•  To animate the opacity of the layer
•  To animate the writing on of text

To auto animate a layer

• Select the layer you want to animate.

Either:
• On the Layer menu, click Auto Animate.

Or:
1. Click the Properties tab to display the Properties panel for the layer.
2. In the Automation section click the Auto Animate button:
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The Automatic Animation dialog box will be displayed to allow you to specify how 
you want the layer to be animated:

To animate the position of the layer

1. Select Layer from the main menu and then Add Layer > Map
2. Select the Properties tab and click the Auto Animate button
3. In the Slide frame select Slide to current position and/or Slide from current 

position and choose the direction of the slide from the From and/or To drop-
down menus.

4. Drag the keys on the time scale to adjust the extent of the slide.
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• In the central white section, the layer will be static at its current position, 
and in the black sections to the left of the first key or to right of the last key 
the entire contents of the layer will be outside the image layer.

5. Select Cushion movement to include a smooth run-in and run-out.

To animate the opacity of the layer

1. Select Layer from the main menu and then Add Layer > Map
2. Select the Properties tab and click the Auto Animate button
3. Select Fade on and/or Fade off
4. Drag the keys on the time scale to change the rate the fade occurs.

• The white central area corresponds to 100% opacity and the black regions to 
the left of the first key and to the right of the last key correspond to 0% 
opacity.

5. Select Cushion fade to include a smooth run-in and run-out.

To animate the writing on of text

1. Select Layer from the main menu and then Add Layer > Text
2. Select the Contents tab and enable the New Text Item button and add a text to 

the layer
3. Click the Animation tab and click the Auto Animate button
4. Select Write on, and choose Characters or Words from the drop-down menu to 

specify how the text should be written.
5. Drag the keys on the time scale to determine the rate at which the text is 

written on:

The white section to the right of the rightmost key corresponds to all the text 
written on, and the black section to the left of the left most key corresponds to 
0%.

6. Click the OK button to set up the animations you have specified for the layer.

Auto animate automatically sets up the Opacity, Position, and Write on amount 
(text layers only).
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19.3 Using the Keybars Panel

For each layer in a project, the Keybars panel shows a keybar for each of the 
features that can be animated, grouped into categories such as Compositing 
Options, Transform, Drop Shadow, and Trail. You can click the arrow to the right 
of each layer or category heading to collapse it into a single bar, or expand it to 
show the keybar for each feature.

The animations in each layer are summarized in an overview bar, and this allows 
you to move or scale the whole layer’s animation in a single operation.

Each category also provides an overview bar, and you can use this to scale or 
move all the animations in that category.

In image layers containing a movie the overview bar also shows the extent of the 
movie, and you can drag this to change the start time of the movie.

This section contains information on the following procedures:

• To display the keybars list
• To collapse or expand the keybars list
• To move the animation for a layer or category
• To scale the animation for a layer or category
• To add a key
• To change the position of a key
• To cut, copy, paste, or delete a key
• To delete all the keys on a keybar
• To delete all the keys for a layer

To display the keybars list
• Click the Keybars tab.

To collapse or expand the keybars list
• Click the triangle to the right of the layer name or category name.

Selecting a layer automatically collapses the keybars for the other layers.

To move the animation for a layer or category
• Drag the layer or category overview bar.
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To scale the animation for a layer or category
• Drag the yellow triangle at either end of the layer or category overview bar.

To add a key
Either:
• Click the keybar with the right mouse button (PC), or while holding down Ctrl 

(Mac), and click Add Key on the pop-up menu:

Or:
1. Click to position the marker where you want to add the key.
2. Click the Add Key button:

A key is also added automatically at the current frame position, when you change 
the setting of any feature that can be animated.

To change the position of a key

• Drag it along the keybar with the mouse pointer.

The cushion bars on either side of the key will be scaled in proportion to the 
distance to the key and the keys on either side.

To cut, copy, paste, or delete a key
Either:
Chapter 19: Controlling Animation 255



• Click on the key with the right mouse button (PC), or while holding down Ctrl 
(Mac), and click the appropriate command on the pop-up menu:

Or:
1. Click the key to select it. The key will turn red.
2. Click the appropriate button:

The cushion bars for the keys on either side will be reset to their default 
positions.

To delete all the keys on a keybar
Either:
• Click the keybar with the right mouse button (PC), or while holding down Ctrl 

(Mac), and click Clear Bar on the pop-up menu.

Or:

1. Click to position the marker in the keybar you want to clear.
2. Click the Clear Bar button.

To delete all the keys for a layer
• Click any keybar with the right mouse button (PC), or while holding down Ctrl 

(Mac), and click Clear Layer on the pop-up menu.
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19.4 Getting Natural Motion
By default, Viz World Classic causes objects to move with a smoothly varying 
speed between keyframes. You can apply Smooth In/Out or Ease In/Out 
animation options to any key to achieve a more gradual acceleration or 
deceleration.

The following table summarizes the differences between the options:

 Figure 16: Cushion bars (smooth/ease)

 
• Smooth In/Out : The rate of change of the property is constant through the 

key.
• Ease In/Out: The rate of change of the property is stationary through the key.

For example, if the property being animated is an object’s position, with Ease In/
Out the object will slow down to a halt at the key but with Smooth In/Out the 
object will be moving with constant velocity through the key.

You can extend the cushion bars to increase the time either side of the key during 
which the object moves with constant velocity (Smooth In/Out) or decelerates and 
accelerates (Ease In/Out).

To cushion animation
Either:
• Click in the Keybars panel with the right mouse button (PC), or while holding 

down Ctrl (Mac), and click the appropriate Smooth or Ease option on the pop-
up menu:

Or:
1. Click the key to select it. The key will turn red.
2. Click the appropriate button in the toolbar:
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If you click on a key you can smooth or ease either or both handles for the key.

If you click between two keys you can smooth or ease the appropriate handles for 
both keys.

To adjust the cushion bars
1. Point at the cushion bar with the mouse pointer, until the mouse pointer turns 

to a single-headed arrow.
2. Drag the cushion bar to the appropriate position between the two keys:

Each cushion bar can be dragged as far as the adjacent key.

19.5 Displaying Detailed Information About a Feature

You can display a graph showing the change in the value of any feature 
throughout the animation. You can manipulate the graph to change keys, cushion 
the animation, or add keys, as an alternative to working in the keybar.

To display the detail graph

• Click the detail icon to the right of the feature name.
• The keybar will expand to show the detail graph.

To return to keybar view

• Click the keybar icon to the right of the feature name.

19.6 Animating an Image, Movie, Text Item, or Drawing Along a 
Path
Viz World Classic allows you to draw a smooth path, using Bezier curves, and 
animate an imported image, movie, text item, or drawing on a shape layer along 
the path.

This section contains information on the following topics:
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• To create an animation path
• To convert the path to a curve
• To adjust the path
• To align the image, text item, or drawing to the angle of the animation path

To create an animation path
1. Move to the first frame of the animation.
2. Select the Path tool and drag the image, text item, or drawing to the initial 

location:

3. Move to the last frame of the animation.
4. Drag the image, text item, or drawing to the ending position.
• A line will be drawn to show the animation path, with dots indicating the 

position in each frame:
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To convert the path to a curve

1. Move to an intermediate frame of the animation.
2. Drag the image, text item, or drawing. 

• The path will curve through the new position.
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To adjust the path

1. Drag one end of the tangent handles extending from a point on the curve:
2. Hold down Ctrl (PC) or Alt (Mac) to drag a tangent handle independently of the 

other one.

To align the image, text item, or drawing to the angle of the animation path
1. Click the Match rotation to path button on the Properties panel for the image, 

text, or shape layer:

19.7 Leaving an Animation Trail
You can cause the map layer, text item on a text layer, image on an image/movie 
layer, or drawing on a shape layer to leave a trail as it animates by choosing the 
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appropriate option from the Trail drop-down menu in the Trail section of the 
Properties panel for the layer. 

For example, you could leave a trail behind an image of a plane to show the route 
of a journey:

To leave an animation trail
• Choose Behind, Ahead or Full from the Trail pop-up menu to leave a trail 

behind, ahead of, or on both sides of the path.
• Use the Trail Width and Trail Color options to define the width and color of the 

trail, and select Trail Above to display the trail above the layer.
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20 Creating Tracking Paths
Viz World Classic includes a powerful tracking tool, which allows you to track 
features in a movie to create one or more tracking paths. These can then be used 
to automatically stabilize the tracked feature, or to match the tracking of another 
movie or image to that feature in creating a composite.

This section contains information on the following topics:

• Introduction
• Creating a Track
• Applying Tracking

20.1 Introduction
The tracking tool lets you identify a distinctive feature in one frame of a movie, 
and then automatically track the feature throughout the movie to create a tracking 
path.

Creating tracking paths
You can create any number of tracking paths in a single movie, or across multiple 
movies. One track is needed to adjust for position. With two independent tracks 
the tracking tool can also adjust for scaling and rotation.

Additional tracks can be used to track independently moving objects. For 
example, if your video sequence shows two cars driving towards each other you 
can create a separate tracking path for each car, and then use these to 
superimpose a logo onto the side of each car.

You can also change the feature you are tracking mid-way through the movie. For 
example, if the feature goes out of view or behind an obstacle you can select an 
alternative feature, and then continue tracking from that point. 

Applying tracking paths
Having created a tracking path you can apply it in several ways:

• To the original movie to stabilize the image, keeping the tracked feature with 
the same position, scale, and rotation on the frame. For example this can be 
used to stabilize an interview filmed with a hand-held camera. 

• To a different image or movie to animate it, matching the movement, scaling, 
and rotation of the selected feature so that when the two sequences are 
composited they appear as a single, natural image.

• To the points and shapes in a rotomatte, to match their movement, scaling, 
and rotation to the original movie.

• To the position parameters of filters and effects; for example, to make a wipe 
follow a feature in a movie.
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20.2 Creating a Track

On the Tools menu, click Tracker or click the Tracking button in the toolbar. The 
Tracker dialog box is displayed to allow you to create one or more tracks.

To create a track
1. Click the + button to create a new track, and select it in the Tracks list.
2. Click the Edit Tracks button to indicate which feature of the image you want to 

track:

Two concentric squares are drawn in the Viewer with a + at their center.

3. Move the mouse pointer over the center square until it changes to a move 
symbol and drag the squares over the feature you want to track.

4. The center square acts as a magnifying glass to help you locate the feature 
accurately:

5. If necessary move the central + to the precise position you want to track.

This is the pin position that determines the precise offset generated by the track. 
Usually you will leave this at the center of the inner square.

The outer square determines the search area that the tracking tool will scan at 
each frame when looking for the feature you have specified. Its size should be 
sufficient to cover the maximum movement in any direction from any frame in the 
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sequence to the next frame. It does not need to cover the area occupied by the 
feature of interest throughout the whole sequence.

6. Adjust the Presoften value to blur the image before matching the target; this 
helps tracking if the image is noisy, or includes a random feature such the 
rain.

To start tracking

1. Click the Track Next Frame  button to step forward a frame at a time, 
tracking the feature.

2. Click the Track Forward  button to start automatically tracking the feature 
from the current frame.

As tracking proceeds the Tracker dialog box plots a graph showing the quality of 
the track:

Higher values indicate a good match.

The tracking paths will be shown in the Viewer as a white line with red dots at 
each track position:

To correct a tracking path
The automatic tracking procedure may occasionally lose the feature being 
tracked. To correct for this:

1. Go to the last frame where the track was correct (or another earlier frame).
2. Hold down Shift and drag the tracking box. 

This leaves the tracking point itself unchanged, so that the points added to the 
motion path continue on the same track, but it uses a different area for 
subsequent detection. It is important to choose a different area which is moving 
in the same way. 
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3. Click the Track Forward  button to continue tracking from that point.

For example, if the feature being tracked goes out of sight or behind another 
object, you will need to select another feature to track. When tracking an actor’s 
eye it may be necessary to manually position the tracking tool if the actor blinks.

You can also track backwards or track the previous frame using the appropriate 
controls.

To lock a track

• Click the lock icon to the left of the track name in the Tracks list:

This is useful once you are satisfied with a track, to protect it from changes 
during subsequent tracking actions.

20.3 Applying Tracking
After creating one or more tracking paths you can apply these to any layer in your 
project. In addition, in a shape layer you can apply a tracking path to individual 
shapes in the layer.

To stabilize a movie
One application of tracking is to stabilize the movie that was used to generate the 
tracking path.

1. Select the movie layer in the Layers list, and click the Properties tab to display 
the Properties panel for the movie.

2. In the Automation section click the Apply Track Data button:
• The Apply Track Data Wizard is displayed to lead you through the steps 

needed to apply the track data to the image layer.
• The first panel lets you specify the transformations you want to track:
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3. Select Position, Rotation, and/or Scaling as required, and click the Next button 
to continue.
• If you have only recorded one track Rotation and Scaling will not be 

available. 
• The next panels let you select the tracks to use.

4. Select the first track and click the Next button to continue.
• If you are adjusting rotation and/or scaling you will be prompted to select a 

second track.

5. Select the track and click the Next button to continue.
• The next panel lets you choose how the transformations are applied.
• Absolute aligns the pin position of the object with the current track 

position.
• Relative displaces the object by the track position.
• Stabilize applies the recorded tracks to the layer to stabilize it:

6. Finally click the OK button to apply the track information to the current image 
layer.
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21 Rendering a Project
This section explains how to render your project as a preview image or movie, or 
as a finished image or movie. It also describes the options for exporting an image 
or a 3D model from a project.

This section contains information on the following topics:

• Rendering the project
• Displaying a live video output
• Exporting 3D models
• Creating GIF images

21.1 Rendering the project
Viz World Classic allows you to render your project as a movie or as a sequence of 
still images, one per frame, as separate sequentially numbered files.

Alternatively you can render a single layer, or its layer mask.

The following output formats are available:
• Movie formats
• Image sequence formats

This section also contains information on the following procedures:

• To render the animation
• To specify the output format

Movie formats
The movie formats provide all the frames of the animation in a single file, 
optionally using compression to make the file smaller and improve playback 
rates. A number of different movie formats are supported, some of which are 
designed for playback on specific video output boards. The range of output 
formats available on your system will depend on the operating system, the 
version of Viz World Classic you are using, and the presence of any optional video 
hardware.

Viz World Classic requires a QuickTime player for playing QuickTime movies on 
your computer monitor, and a Video Output player which can play QuickTime 
movies on the video output of compatible QuickTime video boards. Other video 
devices may be supplied with their own playback applications for movies rendered 
in their own native formats.

Image sequence formats
The image sequence formats provide a sequence of numbered files, one frame 
per file - e.g. myanim0001.bmp, myanim0002.bmp etc. The files can be in any of 
the formats supported by Viz World Classic. This can be a very useful format for 
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exchanging images with other applications, many of which will support single 
frame per file sequences.

When you first choose a file to render you are presented with a name 
untitled0000. This will render a sequence with four digits for the frame number 
as above. If you want to change the number of digits simply edit the name – e.g. 
untitled000 would use three digits for the frame number.

You can change the default filename format using the Numbering option in the 
File Formats section of the Options dialog box:

To render the animation
• On the File menu, click Render Project... or Render Project Preview... .

• Render Project Preview: Renders a low-quality version without anti-aliasing, 
and with no lighting effects. 

• Render Project: Produces a finished, high-quality version of the animation.

The Render dialog box is displayed to allow you to specify the output format and 
filename for the rendered movie, and specify the output settings:
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To specify the output format
1. Choose the appropriate format from the Output dropdown menu.
2. Select Whole Project to render the whole project, or Part of the Project to 

render the range of frames specified in the Start, End and Dur fields.
3. Click the Frame Size..., Timing..., Format Options..., or Field Render... buttons 

to set up the corresponding options.

These options are described in the following sections.

• To render with an alpha (mask) channel select Render RGBA Movie (Millions of 
Colors+) and specify how the alpha channel should be treated by selecting 
one of the options from the drop-down menu.

Premultiplied alpha effectively superimposes the image on a black background; 
transparent areas of the image appear black, and semi-transparent areas of the 
image are mixed with black in proportion with their transparency.

Straight Alpha leaves the image unchanged.

• Click the Render button to render the animation with the settings you have 
specified. While the animation is being rendered the progress bar in Viz World 
Classic’s status bar shows the progress of each frame, and the viewer shows 
the frame currently being rendered.

See Also
• Frame Size
• Timing
• Format Options
• Field Render
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21.1.1 Frame Size
Allows you to set the frame size for the rendered movie:

The default project sizes in Viz World Classic are square pixel versions of the 
popular PAL and NTSC video formats, suitable for displaying on a computer 
screen. When rendering final output Viz World Classic will automatically scale the 
output images to the corresponding video formats (PAL video, NTSC video) to 
ensure that the images continue to look correct (video pixels are a different shape 
to computer pixels) on a video monitor. If you are outputting for further 
manipulation or use on a computer (eg in another software package) you should 
deselect Scale correctly for PAL (Video) output.

See Also
• Rendering the project
• Timing
• Format Options
• Field Render

21.1.2 Timing
Allows you to set the frame rate for the rendered movie:

Note that changing the frame rate does not change the total time of the 
animation. For example, rendering a 25fps animation at 30fps simply generates 
more intermediate frames to ensure the animation plays out at the same speed.

See Also
• Rendering the project
• Frame Size
• Format Options
• Field Render
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21.1.3 Format Options
Allows you to change the compression and quality settings for the movie. The 
options available depend on the output format you have selected.

See Also
• Rendering the project
• Frame Size
• Timing
• Field Render

21.1.4 Field Render
Field rendering is a technique used to create smoother looking animations when 
creating output for video or broadcast. It takes advantage of the fact that most 
video is interlaced – each frame consisting of two fields displayed in turn:

Enabling field rendering can produce a considerable improvement for certain 
types of animations, when played back on suitable video equipment such as a 
video output board or video tape. Rendering times are significantly increased 
however, as every frame requires two separate fields to be rendered and then 
combined. Animations for playback on a computer are generally rendered without 
field rendering.

The Upper field first and Lower field first options determine the field ordering for 
the rendered output.

Animations rendered with incorrect field ordering can appear jumpy and 
distorted. The correct setting can vary with your desired output type (PAL or 
NTSC) and the video equipment you are using.

The Flicker Filter option applies a small amount of softness to the rendered 
output. This can help to prevent slight flickering which can sometimes be a side-
effect of field rendering.

To render a single layer
Rendering a layer outputs the layer as it appears in the project at project size, 
including the layer’s transformation and any filters.

1. Select the layer you want to render.
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2. On the Layer menu, click Render Layer... or Render Layer Preview... .
3. Proceed as described in To render the animation.

See Also
• Rendering the project
• Frame Size
• Timing
• Format Options

21.2 Displaying a live video output
The image displayed in the Viewer can be transferred directly to the video outputs 
of supported video cards, for previewing images on a broadcast monitor, or 
transferring single frame images directly to video.

To select live video output
1. On the Video menu, click Video Device setup... .

• The Video Board option in the Video section of the Options dialog box is 
displayed:

2. Choose the video board from the drop-down menu.
3. Select Show live video output.

The Apply flicker filter option adds a slight vertical blur to the image, to prevent 
flickering of very fine horizontal images such as roads and rivers.

21.3 Exporting 3D models
An option is available to allow you to output a 3D model of the land relief in a 
specified 3D object file format to allow you to import it into a suitable 3D package 
such as Maya, Softimage XSI, 3D Studio Max, ORAD CyberGraphics, or Discreet 
Frost. Alternatively you can export the 3D model to Viz Artist.

The texture can be output at the same time, to color the relief, and this can 
optionally be scaled up to provide more detail on the resulting 3D model:
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This section contains information on the following procedures:

• To export the currently selected map layer as a 3D model
• To preview the 3D model

To export the currently selected map layer as a 3D model
1. On the File menu, click Export 3D Model.

• The 3D Export dialog box allows you to specify the filenames for the model 
and texture, and optionally preview the result in the 3D Viewer:

2. Select the 3D object file format from the Export 3D Model to drop-down 
menu. 

3. In the 3D Model Export section, click the Browse... button, and specify a name 
for the 3D model.

4. If required, edit the Grid Resolution and Smoothing, to determine the mesh 
used for the 3D model.

5. In the Texture Export section leave Export Texture for Model selected if you 
want to export a texture bitmap, and select Export Material File if you also 
want to export the texture as a material file.
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6. Choose the format from the Format drop-down menu.
7. Click the Browse... button, and specify a name for the texture file.

• The Frame Size... button gives you the option of scaling the image to a 
different frame size; for example to provide greater detail on the resulting 
model. Note that this produces a true optical scaling of the image, whereas 
changing the project size leaves features, such as road and river line 
thicknesses, unchanged.

• For certain formats the Format Options... button gives you control over of 
the parameters of the format.

8. Select Preview Result in 3D Viewer to preview the exported files in a 3D viewer.
9. Click the Export button to export the model.

To preview the 3D model
If you checked Preview Result in 3D Viewer in the 3D Export dialog box, the 3D 
model will be displayed in the Curious 3D Viewer to allow you to preview it.

1. Drag the model to change the viewpoint.
2. Hold down Ctrl (PC) or Alt (Mac) and drag up and down to zoom in and out 

respectively.
3. Hold down Shift and drag up and down to increase or decrease the scale of the 

relief.
4. Hold down Alt (PC) or Command (Mac) and drag left and right to rotate the 

model about the viewpoint.
5. Click the Play button in the toolbar, or choose Play from the File menu, to 

rotate the model continuously.

21.4 Creating GIF images
Viz World Classic cannot create or render GIF format images by default. It will, 
however, work with some commercially available third-party GIF creation 
applications to allow creation of GIF images.

Supported applications are as follows:
• Platform Application
• PC FCoder 2GIF
• Mac Lemke Software Graphic Converter

To set up Viz World Classic for GIF image creation
1. Purchase and install one of the supported GIF creation applications.

• If you are running Viz World Classic on Windows, then you must specify the 
location of the 2GIF application.

2. On the View menu, click Options... .
3. In the File formats section click Gif.
4. Click the Browse... button and select the path of the 2GIF application:
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The GIF file format and associated options will then be available in image save, 
export, and render windows.
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